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Upgrade/Downgrade Guidelines

Section-1
Mandatory image extension verification to follow while upgrading/downgrading from 4.x to 4.x, 3.11.x to
4.x and vice versa. This procedure is applicable on cnMaestro (On-Premise recommended version is 2.2.1-
r36 and above) and standalone AP UI/CLI. This procedure will not be applicable on cnMaestro-Cloud,
since image upgrade/downgrade is automatic for APs.

Note

This recommendation is applicable for all models of cnPilot APs.

Refer the below table and validate the image extension w.r.t the version before proceeding to
upgrade/downgrade.

Version Image extension

From To

4.x 4.x CIMG

4.x 3.11.x IMG

3.11.x 4.x **IMG

**Note

For cnPilot e410/e430/e510/e600 and e700 APs, refer additional instructions mentioned in
Section-2 before proceeding to upgrade/downgrade the AP.

Section-2
Attention

To upgrade/downgrade from 3.11.x (3.11.4-r9 /3.11.3.1-r4/3.11.3-r7 etc.) to 4.x (4.0/4.1/4.2 and
later subsequent images) and vice versa, mandatorily use 3.11.4.1-r3 and 4.1-r3 and above
image versions. Ignoring this suggestion can lead to failure in loading the image and resulting
in flashed partition (backup partition) getting corrupted. To recover the corrupted partition,
user may have to contact Cambium Support team.

Perform the below steps to upgrade the image from 3.11.4-r9 to 4.2.3-r2 and above:

1. First, upgrade the AP from 3.11.4-r9 to 3.11.4.1-r3

2. Then upgrade the AP from 3.11.4.1-r3 to 4.2.3-r2 and above

Perform the below steps to downgrade the image from 4.2.3-r2 and above to 3.11.4-r9:

1. First, downgrade the AP from 4.2.3-r2 and above to 3.11.4.1-r3

2. Then downgrade the AP from 3.11.4.1-r3 to 3.11.4-r9

Note

This recommendation is only applicable for cnPilot e410/e430/e510/e600 and e700 APs.

#Section-
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Chapter 1: About This User Guide
This chapter describes the following topics:

l Overview of cnPilot products

l Intended audience

l Purpose

l Related documents

l Features and Enhancements

l Supported hardware platforms

Overview of cnPilot products
Thank you for choosing Cambium cnPilot Access Point (AP)!

This User Guide describes the features supported by cnPilot Enterprise AP and provides detailed
instructions for setting Up and configuring cnPilot Enterprise AP.

cnPilot’s are the industry's upcoming feature-rich Wi-Fi APs designed for Indoor/Outdoor which are easy
to deploy and configure.

Intended audience
This guide is intended for use by the system designer, system installer and system administrator.

Purpose
Cambium Network’s cnPilot Enterprise AP documents are intended to instruct and assist personnel in the
operation, installation and maintenance of the Cambium’s equipment and ancillary devices. It is
recommended that all personnel engaged in such activities be properly trained.

Cambium disclaims all liability whatsoever, implied or expressed, for any risk of damage, loss or reduction
in system performance arising directly or indirectly out of the failure of the customer, or anyone acting on
the customer's behalf, to abide by the instructions, system parameters, or recommendations made in this
document.

Related documents
Table 1 provides details on cnPilot's support information.

Table 1: Related documents

cnPilot Enterprise product
details

https://www.cambiumnetworks.com/products/wifi-cnpilot/

cnPilot Enterprise AP User Guide
(This document)

https://support.cambiumnetworks.com/files

https://nam05.safelinks.protection.outlook.com/?url=https%3A%2F%2Fwww.cambiumnetworks.com%2Fproducts%2Fwifi-cnpilot%2F&data=02%7C01%7Cjayesh.b%40cambiumnetworks.com%7Ced2a1897f1f14a2ad6dd08d7388d003d%7C0e263e36340946228ac818d993e76eb6%7C0%7C0%7C637040050554932024&sdata=tmMdXEPMIlt81HM9wdr7Ivjl3bTq9PTngIivFFffNO0%3D&reserved=0
https://support.cambiumnetworks.com/files
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cnPilot Enterprise AP Release
Notes

https://support.cambiumnetworks.com/files

Software Resources https://support.cambiumnetworks.com/files

Knowledge Base (KB) Articles http://community.cambiumnetworks.com/t5/cnPilot-E-Series-
Enterprise-APs/bd-p/cnPilot_E_Series/

Community http://community.cambiumnetworks.com/

Support https://www.cambiumnetworks.com/support/contact-support/

Warranty https://www.cambiumnetworks.com/support/warranty/

Feedback For feedback, e-mail to support@cambiumnetworks.com/

Features and Enhancements

System Release 4.2.2
The System Release 4.2.2 includes the following new features:

Table 2: New features

Features Platform
Support

Summary

Radius
based ePSK

All ePSK feature is an extension of WPA2 PSK where multiple passphrases
can assign to a single SSID.

Auto Cell All Auto Cell size is an automatic, self-tuning mechanism that balances cell
size between APs to guarantee coverage while limiting the RF energy
that could extend beyond the organizational boundary.

Features and Enhancements

System Release 4.2.3
The System Release 4.2.3 includes the following new feature:

Table 3: New features

Features Platform
Support

Summary

Cambium Traffic Class Premium

feature
All Cambium Traffic Class attributes are supported for

wireless guest clients. The device allows guest clients
to communicate destinations (defined using
IP/Network address) defined under traffic class
names without completing the guest authentication.

https://support.cambiumnetworks.com/files
https://support.cambiumnetworks.com/files
http://community.cambiumnetworks.com/t5/cnPilot-E-Series-Enterprise-APs/bd-p/cnPilot_E_Series/
http://community.cambiumnetworks.com/t5/cnPilot-E-Series-Enterprise-APs/bd-p/cnPilot_E_Series/
http://community.cambiumnetworks.com/
https://www.cambiumnetworks.com/support/contact-support/
https://www.cambiumnetworks.com/support/warranty/
mailto:support@cambiumnetworks.com/
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Supported hardware platforms
Table 4: Supported platforms

Hardware Description

e400 2x2:2, 802.11a/b/g/n/ac wave 1 indoor Access Point

e500 2x2:2, 802.11a/b/g/n/ac wave 1 outdoor Access Point

e501S 2x2:2, 802.11a/b/g/n/ac wave 1 90°/120° outdoor Access Point

e502S 2x2:2, 802.11a/b/g/n/ac wave 1 30° outdoor Access Point

e410 2x2:2, 802.11a/b/g/n/ac wave 2 indoor Access Point

e410b 2x2:2, 802.11a/b/g/n/ac wave 2 Indoor Access Point.

e510 2x2:2, 802.11a/b/g/n/ac wave 2 outdoor Access Point

e600 2x2:2 for 2.4 GHz and 4x4:4 for 5 GHz, 802.11a/b/g/n/ac wave 2 indoor Access Point

e430 2x2:2, 802.11a/b/g/n/ac wave 2 indoor Access Point

e700 2x2:2 for 2.4 GHz and 4x4:4 for 5 GHz, 802.11a/b/g/n/ac wave 2 indoor Access Point

Premium feature list
System Release 4.2.2 and later releases of cnPilot Enterprise Wi-Fi AP firmware support certain advanced
features which are available only through a paid subscription to cnMaestro X or XMS-Cloud management.
These features will be identified with the label Premium feature in the applicable documentation. With
the current System Release 4.2.3 end users can access these features without a management
subscription; however, access to these features is currently on a free trial basis, and only for a limited
time. As Cambium Networks releases new versions, we will begin enforcing restrictions on the use of
these premium features only in conjunction with a current cnMaestro X or XMS-Cloud subscription, and at
that time, the APs will stop enabling configurations, including these premium features if the user does not
have a current subscription.

Table 5: Premium feature list

Feature Name Release Details

RADIUS-based ePSK System Release 4.2.2

ePSK scale (more than 300 keys) System Release 4.1.1

Cambium Traffic Class System Release 4.2.3
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Chapter 2: Quick Start – Device Access
This chapter describes the following topics:

l Powering up the device

l Accessing the device

l LED status

Powering up the device
This section includes the following topics:

l Quick Start – Device Access

l Quick Start – Device Access

cnPilot product family can be powered either using PoE adapter provided in the package or it can be
powered using 802.3af or 802.3at capable switches.

For cnPilot e600 and e430, there is additional provision to power ON device using DC power adapter.

Accessing the device
This section includes the following topics:

l Device access using default/fallback IP

l Device access using zeroconf IP

l Device access using DHCP IP address

Once the device is powered up ensure the device is up and running before you try to access it based on
LED status. Power LED on the cnPilot device should turn Green which indicates that the device is ready
for access.

Device access using default/fallback IP
1. Select Properties for the Ethernet port:

a. For Windows 7: Control Panel > Network and Internet > Network Connections > Local Area
Connection

b. For Windows 10:Control Panel > Network and Internet > Network and Sharing Center >
Local Area Connection.

2. IPAddress Configuration:

The cnPilot AP obtains its IP address from a DHCP server. A default IP address of 192.168.0.1/24
will be used if an IP address is not obtained from the DHCP server.



Chapter 2: Quick Start – Device Access 15

Open any browser on the PC and browse http://192.168.0.1 with default credentials as below:

l Username: admin

l Password: admin

Device access using zeroconf IP
To access the device using zeroconf IP, follow the below steps:

For example:

1. Convert the last two bytes of ESN of the device to decimal. If ESN is 58:C1:CC:DD:AA:BB, last two
bytes of this ESN is AA:BB. Decimal equivalent of AA:BB is 170:187.

2. Zeroconf IP of device with ESN 58:C1:CC:DD:AA:BB is 169.254.170.187

3. Configure Management PC with 169.254.100.100/16 as below:

http://192.168.0.1/
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4. Access the device UI using http://169.254.170.187 with default credentials as below:

l Username: admin

l Password: admin

Device access using DHCP IP address
1. Plug in the device to the network.

2. Get the IP address of the device from the System administrator.

3. Access device UI using http://<IP address> with default credentials as below:

l Username: admin
l Password: admin

LED status
The e410/e410b/e430/e425H/e600/e505 AP has single color LED. The power LED will glow Amber as
the AP boots up and turn Green once it has booted up successfully. The network/status LED will glow
Amber if the connection to cnMaestro controller/manager is down and turns Blue once the AP is
connected successfully to cnMaestro.

http://169.254.170.187/
file:///C:/Users/jab100/Desktop/backup/4.1/User Guide/Flare/pmp-2835_004v000.docx
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Table 6: e410/e410b/e430/e425H/e600/e505 LED status

LED Color Status Indication

l Device is booting up.

Note

If these LEDs remain ‘Amber’ for more than 5 minutes,
indicates that the device failed to boot.

l Device is successfully up and accessible.

l Wi-Fi services are up if configured.

l cnMaestro connection is successful.

The e700/e510 AP has two multi-colored LEDs. The power LED will glow Amber as the AP boots up and
turns Green once it has booted up successfully. The network/status LED will glow Amber if the
connection to cnMaestro controller/manager is down and turns Blue once the AP is connected
successfully to cnMaestro.

Table 7: e700/e510 LED status

LED Color Status Indication

l Device is booting up.

Note

If these LEDs remain ‘Amber’ for more than 5 minutes, indicates
that the device failed to boot.

l Device is successfully up and accessible.

l Wi-Fi services are up if configured.

l Device is successfully up and accessible.

l Wi-Fi services are up if configured.

l cnMaestro connection is successful.

The e400/e500/e501S/e502S AP has two multi-colored LEDs. The power LED will glow Amber as the AP
boots up and turns Green once it has booted up successfully. The network/status LED will glow Amber if
the connection to cnMaestro controller/manager is down and turns Green once the AP is connected
successfully to cnMaestro.
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Table 8: e400/e500/e501S/e502S LED status

LED Color Status Indication

l Device is booting up.

Note

If these LEDs remain ‘Amber’ for more than 5 minutes, indicates
that the device failed to boot.

l Device is successfully up and accessible.

l Wi-Fi services are up if configured.

l Device is successfully up and accessible.

l Wi-Fi services are up if configured.

l cnMaestro connection is successful.
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Chapter 3: Device Modes
cnPilot product family supports three modes of operation based on deployment size. Details of mode of
operation supported by cnMaestro are given below:

l Device Modes

l Device Modes

l Device Modes

cnMaestro managed mode
This mode is also known as controller mode, in which all management traffic is tunneled to cnMaestro and
data traffic is offloaded from AP to the network. There are provisions to tunnel data traffic to cnMaestro
but has its own limitations w.r.t size of deployment. Device onboarding methods and procedures are
explained in further chapters. By default, devices onboard to cnMaestro cloud ( 
https://cloud.cambiumnetworks.com), however we can also onboard the devices to cnMaestro On-
Premises by mapping the cnMaestro IP address on the device.

Note

cnMaestro managed mode is the recommended mode for any cnPilot devices.

Autopilot mode
This is a proprietary mode supported by cnPilot devices. This mode allows one of the cnPilot devices to
act as controller, which allows to configure other devices in the network. This mode has its own
limitations, which will be explained in detail in the following chapters.

Standalone mode
This is the default mode a cnPilot device operates. In this mode, it is expected that each device has to be
configured and managed independently, which is cumbersome if deployment size exceeds 10 devices.

https://cloud.cambiumnetworks.com/
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Chapter 4: cnMaestro Onboarding
This chapter describes the following topics:

l Overview

l Device Onboarding and Provisioning

l Directing devices to the cnMaestro On-Premises server using DHCP

l Claim using Cambium ID

Overview
cnMaestro is Cambium's next generation network management platform based on cloud technologies. In
addition to the cloud-based cnMaestro solution, it can also be installed as a standalone On-Premises
server. By default, all devices contact https://cloud.cambiumnetworks.com, no user action is required to
direct devices to contact cnMaestro cloud. You can onboard and provision devices without any
additional setup.

If you are using cnMaestro On-Premises you must direct devices to correct cnMaestro server using DHCP
or static URL configuration.

Device Onboarding and Provisioning
This section includes the following topics:

l Onboarding to cnMaestro cloud using MSN

l Onboarding to cnMaestro On-Premises

l Auto-Provisioning

l Other options

Onboarding to cnMaestro cloud using MSN
This mode is preferable for cnMaestro cloud. Inorder to claim through MSN Address, follow the below
steps:

1. Login to On-Premises server using default username and password (admin/admin) or the
username and password set by the Administrator.

2. Navigate to Home > Onboard Devices > Claim from cnMaestro.

3. Select the Device type that needs to be onboarded and provide the MSN in the combo box and
click the Claim Devices button. Multiple MSN Addresses of same device type can be claimed using
( , ) separator between MSN or by entering them in the new line.

https://cloud.cambiumnetworks.com/


Chapter 4: cnMaestro Onboarding 21

Figure 1: Onboarding to cnMaestro cloud using MSN

Onboarding to cnMaestro On-Premises
This mode is preferable for cnMaestro On-Premises. Inorder to claim through MAC Address (ESN), please
follow the below steps:

1. Login to On-Premises server using default username and password (admin/admin) or the
username and password set by the Administrator at the time of On-Premises server installation.

2. Navigate to Home > Onboard Devices > Claim from cnMaestro.

3. Select the Device type for which onboarding is to be done and provide the MAC Address in the
combo box and click the Claim Devices button. Multiple MAC Addresses of same device type can
be claimed using ( , ) separator between MAC Addresses or by entering them in the new line.

Figure 2: Onboarding to cnMaestro On-Premises

Auto-Provisioning
cnMaestro On-Premises supports Auto-Provisioning for cnPilot devices. This feature not only enables
auto onboarding but also configures synchronization and positioning of device in the network
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architecture. It is triggered only at first instance of device onboarding. It can be configured on cnMaestro
as below:

Configuration

It is enabled at Shared Settings > Auto-Provisioning, and it allows one to automatically configure and
approve devices based upon IP address. To create rules for cnPilot devices:

1. Navigate to Shared Settings > Auto-Provisioning page.

2. To create a new rule, click Add. The following window appears:

Figure 3: Auto-Provisioning

3. Enter the following details given in Auto-Provisioning parameter details:

Table 9: Auto-Provisioning parameter details

Parameter Description

Subnet
(CIDR)

The subnet with CIDR of the devices to which the rule has to be applied. For example,
Subnet/CIDR (192.168.100.100/25) maps the devices with the IP addresses ranging from
192.168.100.1 to 192.168.100.126.

Device
Type

Select the type of the device from the drop-down list.

Network Select the network to which the device should be onboarded, once the device contacts
the server.
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Parameter Description

Site Select the site under which the device should be onboarded, once the device contacts
the server.

AP Group Select the AP Group which needs to be applied on the device, once the device contacts
the server while onboarding.

Approve Enables this option to auto-approve onboarding.

4. Click Add.

Note

Auto-Provisioning is supported only for cnMaestro On-Premises and not for
cnMaestro cloud.

Other options
This section includes the following topics:

l AP Group

l cnMaestro Onboarding

The device onboarding screen can also be accessed from other locations in the UI. Below options can be
used in both cloud cnMaestro and cnMaestro On-Premises. For cnMaestro On-Premises, ESN/MAC
Address is required for onboarding/claiming device in an account whereas for cloud cnMaestro MSN is
required to claim/onboard device in an account.

AP Group

Inorder to claim multiple devices from the AP Group in cloud, navigate to the Wi-Fi AP Groups tree view
and click the drop-down menu for the selected AP Group.

1. Click the Claim Devices option.

2. In the pop-up dialog, select the Network and Site under which these devices needs to be placed
and by default the devices claimed under this group will have the configuration settings from this
AP Group.

3. Specify the MSNs/ESNs (Manufacturing Serial Number) of the devices line-by-line or comma-
separated or click Import .csv option to import the MSNs/ESNs of the devices from a file.

4. Click Claim Devices to add to the selected AP Group with the configuration applied.

Note

In cnMaestro On-Premises the procedure to claim the device using Serial
Number is same as cloud, but instead of MSN, the user should use the device
MAC Addresses.
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Figure 4: Claiming the device using MAC address (ESN)

Figure 5: Claiming the device using Serial Number (MSN)

Site dashboard

Inorder to claim multiple devices from the Site dashboard in cloud, navigate to the Manage section and
select a site under a network and click the drop-down menu for the selected site:

1. Click the Claim Devices option.

2. In the pop-up dialog, select the Network and Site under which these devices needs to be placed
and by default the devices claimed under this group will have the configuration settings from this
AP Group.

3. Specify the MSNs (Manufacturing Serial Number) /ESNs (Equipment Serial Number) of the devices
line-by-line or comma-separated or click Import .csv option to import the MSNs/ESNs of the
devices from a file.

4. Click Claim Devices to add to the selected AP Group with the configuration applied.

Note

Claim using MAC address is supported by cnMaestro On-Premises only.
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Figure 6: Claim the device using MAC address

Figure 7: Claim the device using MSN

Directing devices to the cnMaestro On-Premises server
using DHCP
From cnPilot System Release 4.0, cnPilot device can be onboarded either using IPv4/IPv6 DHCP options.
Following are the options that are used in IPv4 and IPv6 respectively:

l IPv4

o DHCP Option 43/52
o DHCP Option 15/24

l IPv6

o DHCP Option 43/52
o DHCP Option 15/24

DHCP Option 43/52

This mode of onboarding is preferred to use when cnMaestro On-Premises is deployed at customer end.
cnPilot reads Option 43/52 during DHCP transaction and then it connects to respective cnMaestro. This
option is given high priority during cnMaestro discovery process. All these devices which have read the
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Option 43/52 from DHCP transaction are available in Queue on cnMaestro, which needs to be further
approved by end user.

Figure 8: DHCP option 43/52

DHCP Option 15/24

This mode of onboarding is preferred to use when cnMaestro On-Premises is deployed at customer end.
cnPilot reads Option 15/24 during DHCP transaction and then it connects to respective cnMaestro. All
these devices which have read the Option 15/24 from DHCP transaction are available in Queue on
cnMaestro, which needs to be further approved by end user.

Figure 9: DHCP option 15/24
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DHCP server configuration

More details on various DHCP server configuration for Option 43/52 is available in Cambium Knowledge
Base (KB) section.

Windows server configuration

For Windows server configuration for onboarding devices to cnMaestro On-Premises server, please click
the below URL.

http://community.cambiumnetworks.com/t5/cnMaestro/Device-Onboarding-and-Windows-DHCP-
Options-for-cnMaestro-On/m-p/55199

Linux server configuration

A DHCP Server can be used to configure the IP Address, Gateway, and DNS servers for Cambium devices.
If you administer the DHCP Server, you can also configure DHCP Options that will tell the devices how to
access the cnMaestro (so the URL doesn’t need to be set on each device).

http://community.cambiumnetworks.com/t5/cnMaestro/Device-Onboarding-and-Linux-DHCP-Options-
for-cnMaestro-On/m-p/55187

Microtik server configuration

For Microtik Routerboard DHCP configuration for onboarding devices to cnMaestro On-Premises server,
please click the below link.

http://community.cambiumnetworks.com/t5/cnMaestro/Microtik-Routerboard-DHCP-configuration-for-
Onboarding-devices/m-p/56012

Claim using Cambium ID
This section includes the following topics:

l Claim through static URL without Cambium ID and onboarding key

l Claim through static URL with Cambium ID and onboarding key

Claim through static URL without Cambium ID and onboarding
key
Inorder to claim the devices using the static URL without Cambium ID and onboarding key please follow
the below steps:

1. Login to device UI and navigate to Configure > System > Management > cnMaestro.

2. Provide static URL of On-Premises https://ON-PREMISESIPADDRESSORHOSTNAME and click
Save.

3. Device will come to the onboarding queue in the cnMaestro Home > Onboard Devices > Onboard
page and the user can approve the device.

https://na01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fcommunity.cambiumnetworks.com%2Ft5%2FcnMaestro%2FDevice-Onboarding-and-Windows-DHCP-Options-for-cnMaestro-On%2Fm-p%2F55199&data=02%7C01%7Cjayesh.b%40cambiumnetworks.com%7C756ea2bb05684d88a9fb08d68cc1b9d5%7C0e263e36340946228ac818d993e76eb6%7C0%7C0%7C636851161037494843&sdata=9GXmvgGwgp6RbZ6CjN19SclGsFWGiy3DRe72aGoCLVI%3D&reserved=0
https://na01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fcommunity.cambiumnetworks.com%2Ft5%2FcnMaestro%2FDevice-Onboarding-and-Windows-DHCP-Options-for-cnMaestro-On%2Fm-p%2F55199&data=02%7C01%7Cjayesh.b%40cambiumnetworks.com%7C756ea2bb05684d88a9fb08d68cc1b9d5%7C0e263e36340946228ac818d993e76eb6%7C0%7C0%7C636851161037494843&sdata=9GXmvgGwgp6RbZ6CjN19SclGsFWGiy3DRe72aGoCLVI%3D&reserved=0
https://na01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fcommunity.cambiumnetworks.com%2Ft5%2FcnMaestro%2FDevice-Onboarding-and-Linux-DHCP-Options-for-cnMaestro-On%2Fm-p%2F55187&data=02%7C01%7Cjayesh.b%40cambiumnetworks.com%7C756ea2bb05684d88a9fb08d68cc1b9d5%7C0e263e36340946228ac818d993e76eb6%7C0%7C0%7C636851161037484838&sdata=GFvKVow4b02bcu8wGUhmJO0k2L0OBNntvQfLdwo4CzE%3D&reserved=0
https://na01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fcommunity.cambiumnetworks.com%2Ft5%2FcnMaestro%2FDevice-Onboarding-and-Linux-DHCP-Options-for-cnMaestro-On%2Fm-p%2F55187&data=02%7C01%7Cjayesh.b%40cambiumnetworks.com%7C756ea2bb05684d88a9fb08d68cc1b9d5%7C0e263e36340946228ac818d993e76eb6%7C0%7C0%7C636851161037484838&sdata=GFvKVow4b02bcu8wGUhmJO0k2L0OBNntvQfLdwo4CzE%3D&reserved=0
https://na01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fcommunity.cambiumnetworks.com%2Ft5%2FcnMaestro%2FMicrotik-Routerboard-DHCP-configuration-for-onboarding-devices%2Fm-p%2F56012&data=02%7C01%7Cjayesh.b%40cambiumnetworks.com%7C756ea2bb05684d88a9fb08d68cc1b9d5%7C0e263e36340946228ac818d993e76eb6%7C0%7C0%7C636851161037494843&sdata=KLr3ROtb%2BK%2BdBq%2BmJRbIcEkNihtKnarKB0uBsc2Ct4M%3D&reserved=0
https://na01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fcommunity.cambiumnetworks.com%2Ft5%2FcnMaestro%2FMicrotik-Routerboard-DHCP-configuration-for-onboarding-devices%2Fm-p%2F56012&data=02%7C01%7Cjayesh.b%40cambiumnetworks.com%7C756ea2bb05684d88a9fb08d68cc1b9d5%7C0e263e36340946228ac818d993e76eb6%7C0%7C0%7C636851161037494843&sdata=KLr3ROtb%2BK%2BdBq%2BmJRbIcEkNihtKnarKB0uBsc2Ct4M%3D&reserved=0
https://on-premisesipaddressorhostname/
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Figure 10: Claim through static URL without Cambium ID and onboarding key

Claim through static URL with Cambium ID and onboarding key
Inorder to claim the devices using the static URL with Cambium ID and onboarding key, please follow the
below steps:

1. Login to On-Premises server using default username and password (admin/admin) or the
username and password set by the Administrator at the time of installation.

2. Navigate to Home > Onboard Devices > Claim from Device page.

3. Select the checkbox for “Enable Cambium ID based authentication to onboard devices”.

4. Click on Add new and select the username from the drop-down list and specify the onboarding
key and click Save.

5. Login to device UI and navigate to Configure > System > Management > cnMaestro.

6. Provide static URL of On-Premises https://ON-PREMISESIPADDRESSORHOSTNAME and
Cambium ID (cnMaestro_On-Premises) and onboarding key for that user and click Save.

7. Device will come to the onboarding queue in the cnMaestro Home > Onboard Devices > Onboard
page and the user can approve the device.

https://on-premisesipaddressorhostname/
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Figure 11: Claim through static URL with Cambium ID and onboarding key
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Chapter 5: UI Navigation
You can manage cnPilot device using User Interface (UI) which is accessible from any network devices
such as computer, mobile, tabs, etc. cnPilot device accessibility is explained in Chapter 3.

This chapter describes the following topics:

l Login screen

l Home page (Dashboard)

Login screen
To log to the UI, enter the following credentials:

l Username: admin

l Password: admin

Figure 12: UI Login page

Home page (Dashboard)
On logging into cnPilot AP login page, the UI Home page is displayed. Following figure displays the
parameters that are displayed in cnPilot AP Home page.

Quick Start Device Access.htm#_Quick_Start_�
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Figure 13: cnPilot AP UI Home page
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Table 10: cnPilot AP web interface elements

Number Element Description

Menu This section contains multiple tabs that helps user to configure,
monitor and troubleshoot cnPilot device. Menu consists of the
following:

n Dashboard

n Monitor

n Configure

n Operations

n Troubleshoot

Reboot
Global button to reboot cnPilot device (    ).

Logout
Global button to logout user from cnPilot device (   ).

Content Information in the area of web interface varies based on the tab
selected in Menu section. Usually, this area contains details of
configuration or statistics or provision to configure cnPilot device.

UI path Provides UI navigation path information to user.

UI refresh interval Provision to reload updated statistics at regular intervals.

Model number Provides information related to cnPilot model number and
configured hostname.

Monitor
The Monitor section provides information such as current configuration, traffic statistics across all
interfaces configured on device and device details. Based on information provided in this section, it is
categorized and displayed under following categories:

l System: Provides information related to cnPilot device such as Software Image, host name,
Country code etc.

l Radio: Provides information such as RF Statistics, Neighbour list and current radio configuration of
device.

l WLAN: Provides information on WLANs and Mesh configurations.
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l Network: Provides information related to interfaces such as, default route, interface statistics, etc.

l Services: Provides information related to entities that support Bonjour.

Configure
This section allows user to configure cnPilot device based on deployment requirement. This tab has
multiple sections as follows:

l System: Provision to configure System UI parameter.

l Radio: Provision to configure Radio settings (2.4GHz/5GHz).

l WLAN: Provision to configure WLAN parameters as per the end user requirement and type of
wireless station.

l Network: Provides information related to VLAN, Routes, Ethernet ports etc.

l Services: Provides information related to Network and Bonjour Gateway.

Operations
This section allows user to perform maintenance of device such as:

l Firmware update: Provision to upgrade cnPilot devices.

l System: Provides different methods of debugging field issues and recovering device.

l Configuration: Provision to modify configuration of device.

Troubleshoot
The section provides users to debug and troubleshoot remotely. This tab has multiple sections and are as
follows:

l WiFi Analyzer: When this is initialized, device provides information related to air quality.

l Spectrum Analyzer: Provides real-time cumulative distribution format view of RF environment and
it is generated by the AP across 2.4 and 5GHz frequency bands.

l WiFi Perf Speed Test: Provision for the user to check the speed of link connectivity, either wireless
or wired.

l Connectivity: Provides different modes network reachability of cnPilot device.

l Packet Capture: Provides feasibility for the user to capture packets on operational interfaces.

l Logs: Feasibility to check logs of different modules of cnPilot devices which will help support and
the customer to debug an issue.

l Unconnected Clients: This section displays clients that are not connected/denied connection.
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Chapter 6: Configuration - System
This chapter describes the following topics:

l System

l Management

l Time settings

l Event Logging

System
Table 11 lists configurable parameters that are available under Configuration > System UI tab:

Table 11: Configuration: System parameters

Parameter Description Range Default

Name Hostname of the device. Configurable maximum length of
hostname is 64 characters.

─ cnPilot
Model
Number-
Last 3
Bytes of
ESN

Location The location where the device is placed. The maximum length of
location is 64 characters.

─ ─

Contact Contact information for the device. ─ ─

Country-
Code

To be set by the administrator to the country-of-operation of the
device. The allowed operating channels and the transmit power
levels on those channels depends on the country of operation.
Radios remain disabled unless this is set. The list of countries
supported depends on the SKU of the device (FCC, ROW etc.).

─ ─

Placement cnPilot device supports both Indoor and Outdoor deployments.
Based on deployment user can configure it as follows:

n Indoor

When selected, only Indoor channels for country code
configured will be available and operational.

n Outdoor

When selected, only outdoor channels for country code
configured will be available and operational.

─ Indoor

PoE Output Provision to power on standard 802.3af devices or Cambium
devices.

n Cambium-PoE

- Disabled
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Parameter Description Range Default

n 802.3af

LED Select the LED checkbox for the device LEDs to be ON during
operation.

─ Enabled

LLDP Provision to advertise device capabilities and information in the L2
network.

─ Enabled

To configure the above parameters, navigate to the Configuration > System tab and provide the details
as given below:

1. Enter the hostname of the device in the Name textbox.

2. Enter the location where this device is placed in the Location textbox.

3. Enter the contact details of the device is placed in the Contact textbox.

4. Select the appropriate country code for the regulatory configuration from the Country-Code

drop-down list.

5. Select Placement checkbox parameter Indoor or Outdoor to configure the AP placement details.

6. Select PoE Output from the drop-down list.

7. Enable LED checkbox.

8. Enable LLDP checkbox.

9. Click Save.

Figure 14: Configuration: System page

Management
Chapter 6 lists configurable fields that are displayed in the Configuration > System > Management tab:
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Table 12: Configuration: System > Management parameters

Parameter Description Range Default

Admin Password Password for authentication of UI and CLI sessions. ─ Admin

Autopilot Provision to configure mode of cnPilot device when
Autopilot is enabled in network:

n Default

Every cnPilot device by default operates as Auto-
Pilot slave.

n Master

When selected, cnPilot device will take the role of
controller.

n Disabled

When selected, auto-pilot mode is disabled on the
device.

─ Default

Telnet Enables Telnet access to the device CLI. ─ Disabled

SSH Enables SSH access to the device CLI. ─ Enabled

SSH Key Provision to login to device using SSH Keys. User needs to
add Public Key in this section. If configured, user has to
login to AP using Private Keys. This is applicable for both
CLI and GUI.

─ Disabled

HTTP Enables HTTP access to the device UI. ─ Enabled

HTTP Port Provision to configure HTTP port number to access device
UI.

1-65535 80

HTTPS Enables HTTPS access to the device UI. ─ Enabled

HTTPS Port Provision to configure HTTPS port number to access
device UI.

1-65535 443

RADIUS Mgmt
Auth

User has provision to control login to AP using RADIUS
authentication. If enabled, every credential that are
provided by user undergo RADIUS authentication. If
success, allowed to login to UI of AP. This is applicable for
both CLI and GUI.

─ Disabled

RADIUS Server Provision to configure RADIUS IPv4 server for
Management Authentication.

─ ─

RADIUS Secret Provision to configure RADIUS shared secret for
Management authentication.

─ ─

cnMaestro

Cambium Remote
Mgmt.

Enables support for Cambium Remote Management of this
device.

─ Enabled
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Parameter Description Range Default

Validate Server
Certificate

This allows HTTPs connection between cnMaestro and
cnPilot device.

─ Enabled

cnMaestro URL Static provision to onboard devices either using
IPv4/IPv6/URL.

─ ─

Cambium ID Cambium ID used for provisioning cnMaestro (Cambium
Remote Management) of this device.

─ ─

Onboarding Key Password used for onboarding the device to cnMaestro. ─ ─

SNMP

Enabled Provision to enable SNMPv2 or SNMPv3 support on device ─ ─

SNMPv2c RO
community

SNMP v2c read-only community string. ─ ─

SNMPv2c RW
community

SNMP v2c read-write community string. ─ ─

Trap Receiver IP Provision to configure SNMP trap receiver IPv4 server. ─ ─

SNMPv3
Username

Enter username for SNMPv3. ─ ─

SNMPv3
Password

Enter password for SNMPv3. ─ ─

Authentication choose Authentication type as MD5 or SHA. ─ MD5

Access Choose Access type as RO or RW. ─ RO

Encryption Choose ON or OFF. ─ ON

To configure the above parameters, navigate to the Configuration > System tab and provide the details
as given below:

1. Enter the admin password of the device in the Admin Password textbox.

2. Select Default, Master or Disabled to enable/disable the Autopilot management of APs from the
drop-down list.

3. Enable the Telnet checkbox to enable telnet access to the device CLI.

4. Enable the SSH checkbox to enable SSH access to the device CLI.

a. If certificate-based login is required, enter SSH Key in the textbox else disabled

5. Enable the HTTP checkbox to enable HTTP access to the device UI.

6. If custom port other than default is required, enter HTTP port number value for HTTP access in the
textbox.

7. Enable the HTTPS checkbox to enable HTTPS access to the device UI.
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8. If custom port other than default is required, enter HTTP port number value for HTTP access in the
textbox.

9. If RADIUS based login is required, enable RADIUS Mgmt Auth checkbox and enter the details of
RADIUS server as follows:

a. Enter RADIUS Server parameter in the textbox.

b. Enter RADIUS Secret parameter in the textbox.

To configure cnMaestro:

1. Enable Remote Management checkbox to support for Cambium Remote Management of this
device.

2. Enable Validate Server Certificate checkbox to support HTTPS connection between cnMaestro
and cnPilot.

3. Enter the URL for cnMaestro in the cnMaestro URL textbox.

4. Enter the Cambium ID of the user in the Cambium ID textbox.

5. Enter the onboarding Key in the Onboarding Key textbox.

To configure SNMP:

1. Select Enable checkbox to enable SNMP functionality.

2. Enter the SNMP v2c read-only community string in the SNMPv2c RO community textbox.

3. Enter the SNMP v2c read-write community string in the SNMPv2c RW community textbox.

4. Enter the Trap Receiver IPv4 (Currently Cambium support SNMP only v1 and v2c Traps) in the
textbox.

5. Enter the SNMP V3 username in the SNMPv3 Username textbox.

6. Enter the SNMP V3 password in the SNMPv3 Password textbox.

7. Select MD5 or SHA from the Authentication drop-down list.

8. Select RO or RW from the Access drop-down list.

9. Select ON or OFF from the Encryption drop-down list.

10. Click Save.
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Figure 15: Configuration: Management page

Time settings
User can configure up to two NTP servers. These are used by the AP to set its internal clock to respective
time zones configured on the device. While powering ON the AP, the clock will reset to default and
resyncs the time as the cnPilot AP does not have battery backup. The servers can be specified as an IPv4
addresses or as a hostname (Eg: pool.ntp.org). If NTP is not configured on device, device synchronizes
time with cnMaestro if onboarded.

Table 13 lists the fields that are displayed in the Configuration > System > Time Settings section:

Table 13: Configuration: System > Time Settings parameters

Parameter Description Range Default

NTP Server 1 Name or IPv4 address of a Network Time Protocol server 1. ─ ─

NTP Server 2 Name or IPv4 address of a Network Time Protocol server 2. ─ ─
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Parameter Description Range Default

Time zone Time zone can be set according to the location where the
AP is installed. By selecting the appropriate time zone from
the drop-down list, ensures that the device clock is synced
with the wall clock time.

Note

Accurate time on the AP is critical for features
such as WLAN Scheduled Access, Syslogs etc.

─ ─

To configure the above parameters, navigate to the Configuration > System tab and provide the details
as given below:

1. Enter the name or IPv4 address of the NTP server 1 in the NTP Server 1 textbox.

2. Enter the name or IPv4 address of the NTP server 2 in the NTP Server 2 textbox.

3. Select the time zone settings for the AP from the Time Zone drop-down list.

4. Click Save.

Figure 16: Configuration: Time settings page

Event Logging
cnPilot devices supports multiple troubleshooting methods. Event Logging or Syslog is one of the
standard troubleshooting processes. If you have Syslog server in your network, you can enable it on
cnPilot device.Table 14 lists the fields that are displayed in the Configuration > System > Event Logging
section.

Table 14 lists the fields that are displayed in the Configuration > System > Event Logging section.

Table 14: Configuration: System > Event Logging parameters

Parameter Description Range Default

Syslog
Server 1

Hostname or IPv4/IPv6 address of the Syslog server and respective
port number.

─ 514
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Parameter Description Range Default

Syslog
Server 2

Hostname or IPv4/IPv6 address of the Syslog server and respective
port number.

─ 514

Syslog
Severity

Provision to configure severity of Logs that must be forwarded to
the server. The Log levels supported are as per RFC.

─ Debug

To configure the above parameters, navigate to the Configuration > System tab and provide the details
as given below:

1. Enter the FQDN or IPv4/IPv6 address of the Syslog Server 1 along with customized port number in
the textbox. If the port number is not entered, AP will take default value as 514.

2. Enter the FQDN or IPv4/IPv6 address of the Syslog Server 2 along with customized port number
in the textbox. If the port number is not entered, AP will take default value as 514.

3. Select the Syslog Severity from the drop-down list.

4. Click Save.

Figure 17: Configuration: Event Logging page

Maximum of two Syslog servers can be configured on cnPilot device. Events are sent to both configured
Syslog servers if they are up and running.
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Chapter 7: Configuration – Radio
This chapter describes the following topics:

l Overview

l Configuring Radio parameters

Overview
cnPilot devices support numerous configurable radio parameters to enhance the quality of service as per
the deployment.

Configuring Radio parameters
All cnPilot devices support dual concurrent radio operations, i.e. both 2.4GHz and 5GHz can be turned on
in parallel and hence each radio can be configured independently. Radio 1 represents configuration of 2.4
GHz Wi-Fi radio and Radio 2 represents configuration of 5 GHz Wi-Fi radio of cnPilot device. Information
of each band radio configurable parameters are listed in Configure: Radio parameters. 

Table 15: Configure: Radio parameters

Parameter Description Range Default

Radio

Enable Enables operation of radio. - Enabled

Channel User can select the channel from the drop-down list.
Channels in drop-down list is populated based on
Country selected in Configuration > System UI.

2.4GHz: 1 - 14

5GHz: 36 - 173

Auto

Channel
Width

User can select operating width of the channel.

l For 2.4GHz:

Only 20MHz channel width is supported.

l For 5GHz:

20MHz, 40MHz and 80MHz channel width is
supported.

-

l 20MHz
for
2.4GHz

l 80MHz
for 5GHz
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Parameter Description Range Default

Transmit
Power

User can configure transmit power of each radio
based on coverage and SLA. Unit of transmit power
is in dBm and its range is from 4 to 30. Maximum
transmit power of cnPilot devices varies based on
model number. More details of transmit power
supported by each cnPilot device is available at
https://www.cambiumnetworks.com/products/wifi/
. Transmit power drop-down box varies as per the
country selected in Configuration > System UI.
Default value is AUTO, which means radio transmit
power is configured to maximum as per the county
configured selected in Configuration > System UI.

2.4GHz: 4 - 30

5GHz: 4 - 30

Auto

Beacon
Interval

User can configure time durations between two
consecutive Beacon’s. It is termed as Beacon
interval.

50ms - 3400ms. 100

Minimum
Unicast
rate

Provision to adjust the coverage area of cnPilot
device. Higher the rate selected, lesser the range.
User can configure this value based on SLA in
deployment. Drop-down list contains all values that
are advertised by cnPilot device which includes
legacy, HT and VHT rates. 

Standard 802.11b
and 802.11g data
rates

1Mbps

Multicast
data rate

Provision to configure multicast traffic rate. This is
modified based on type of wireless station that will
be connected to cnPilot device. Drop-down list
contains highest-basic, lowest-basic and highest-
supported.

─ l Highest
Basic for
2.4GHz

l Lowest
Basic for
5GHz

Airtime
Fairness

Airtime Fairness is a solution on APs to increase the
performance of 11n and 11ac clients (HT clients) in the
presence of legacy 11abg clients. Legacy clients need
more airtime to transmit/receive the data compared
to HT clients (11n and 11ac clients). Because of this
the overall throughput of the HT clients falls down.
Enabling this feature improves the performance of
HT clients by throttling the legacy clients.

Compared to faster clients (802.11n/802.11ac), the
slower clients (802.11a/802.11bg) consumes more
airtime to transmit the same size data, in turn the
throughput of faster clients fall as they get lesser
chance to transmit (lesser airtime). Enabling this
feature improves the performance of faster clients in
a wireless network which is dominated by slower
clients. This is achieved by controlling the airtime of
slower clients.

─ Disabled

https://www.cambiumnetworks.com/products/wifi/
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Parameter Description Range Default

Candidate
Channels

cnPilot provides user to configure selective channels
based on their requirement. Options vary based on
band of operation and is as follows:

l For 2.4GHz:

l All

l Specific

l For 5GHz:

l All

l Specific

l Prefer Non-DFS

l Prefer DFS

2.4GHz: 1 - 14

5GHz: 36-173

All

Mode All cnPilot devices are either 802.11ac Wave 1 or
802.11ac Wave 2 supported. There are few legacy
clients which might not work as expected, hence this
parameter can be tuned to backward compatibility
based on wireless clients.

l 2.4GHz:b,
bg, n, gn

l 5GHz: a,
ac, an, n,
n-ac.

l 11n
mixed
mode
for
2.4GHz

l 11ac for
5GHz

Short
Guard
Interval

Standard 802.11 parameter to increase the
throughput of cnPilot device.

─ Enabled

Off Channel Scan (OCS)

Enable Provision to enable OCS on device to capture
neighbour clients and APs.

─ ─

Dwell-time Configure the time period to spend scanning of Wi-
Fi devices on a channel.

50-300 50ms

Auto-RF (Dynamic Channel Change Options)

Note

1. System release 4.0

2. Pre-releases of 4.0

Enable Provision to enable Auto-RF on device. ─ Disabled

Channel
Selection
Mode

Auto-RF supports two modes of channel selection:

l Interference based

─ Interference
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Parameter Description Range Default

l Channel Utilization based

Channel
Hold Time

Configure time period for the device to be on same
channel selected by Auto-RF algorithm, irrespective
of quality of channel after selection.

5-1800 120 Min

Channel
Utilization
Threshold

Configure the utilization thresholds to trigger
channel selection by Auto-RF.

20-40 25%

Auto-RF (Dynamic Channel Change Options)

Note

1. System release 3.11.4

2. Post releases of 3.11.4

Enable Provision to enable Auto-RF on device. ─ Disabled

Packet
Error Rate

Parameter to measure the unsuccessful packet
transmissions by AP.

0-100 % -

Channel
Utilization

Parameter to measure the Channel efficiency. 0-100 % -

Noise Parameter to measure Noise Level on current
operating channel of AP.

0 to -106 dBm -

Auto-Cell

Dynamic
Power

Provision to enable dynamic power management. - -

Mode Select the required dynamic power modes. Two
modes are supported:

1. By-channel

2. By-band

- By-channel

Minimum
Transmit
Power

The minimum transmit power that the AP can assign
to a radio when adjusting automatic cell sizes

1-20 dBm 8 dBm

Minimum
Neighbour
Threshold

The minimum number of neighbors to consider for
power reduction by autocell logic.

1-10 2

Cellsize
Overlap
Threshold

Cell overlap that will be allowed when the AP is
determining automatic cell sizes.

0-100% 50%

Enhanced Roaming
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Parameter Description Range Default

Enable Provision to enable enhanced roaming on device. ─ Disabled

Roam SNR
threshold

cnPilot device triggers de-authentication of wireless
station, when the wireless station is seen at
configured SNR or below.

1-100 15dB

To configure the above parameters, navigate to the Configure > Radio tab and select Radio 1 (2.4GHz) or
Radio 2 (5GHz) tab and provide the details as given below:

1. Select the Enable checkbox to enable the operations of this radio.

2. Select the primary operating channel from the Channel drop-down list.

3. Select the operating width (20 MHz, 40 MHz, or 80 MHz) of the channel from the Channel Width
drop-down list for 5 GHz only. cnPilot do not support 40 MHz and 80 MHz in 2.4 GHz.

4. Select radio transmit power from the Transmit Power drop-down list.

5. Enter the beacon interval in the Beacon Interval textbox.

6. Select Minimum Unicast Rate from the drop-down list

7. Select Highest Basic, Lowest Basic or Highest Supported from the Multicast data rate drop-down
list.

8. Enable Airtime Fairness checkbox.

9. Select the preferred Candidate Channels from the drop-down list.

10. Select Mode details from the drop-down list.

11. Enable Short Guard Interval checkbox.

12. Click Save.

To configure Off Channel Scan:

1. Select Enable checkbox to enable the operations of this radio.

2. Enter Dwell-Time in milliseconds in the textbox.

3. Click Save.

To configure Auto-RF:

1. Select Enable checkbox to enable the operations of this radio.

2. Select Channel Selection Mode from the drop-down list.

3. Enter Channel Hold Time in minutes in the textbox.

4. Enter Channel Utilization Threshold parameter in the textbox.

5. Click Save.

To configure Auto-Cell:

1. Select Dynamic Power checkbox to enable the operations of this radio.

2. Select the required dynamic power Mode as By-channel or By-hand.
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3. Enter the Minimum Transmit Power in the textbox.

4. Enter Minimum Neighbour Threshold parameter in the textbox.

5. Click Save.1.
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Figure 18: Configure: Radio parameters
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Auto-RF: System release 3.11.4

To configure Enhanced Roaming:

1. Select the Enable checkbox to enable the operations of this radio.

2. Enter Roam SNR threshold parameter in the textbox.

3. Click Save.

Figure 19: Configure: Enhanced Roaming parameters
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Chapter 8: Configuration - Wireless
LAN
This chapter describes the following topics:

l Overview

l Configuring WLAN parameters

Overview
cnPilot devices support up-to 32 unique WLANs. Each of these WLANs can be configured as per the
customer requirement and type of wireless station.

Configuring WLAN parameters
Configurable parameters under WLAN profile are categorized into two sections:

1. Basic

2. Advanced

Table 16 lists the configurable parameters for a WLAN profile which is common across bands.

Table 16: Configure: WLAN > Basic parameters

Parameters Description Range Default

WLAN > Basic

Enable Option to enable a WLAN profile. Once enabled, a Beacon is
broadcasted with SSID and respective configured parameters
in a WLAN profile.

─ ─

Mesh This parameter is required when a WDS connection is
established with cnPilot devices. Four options are available
under this parameter:

1. Base

A WLAN profile configured with mesh-base will operate
like a normal AP. Its radio will beacon on startup so its
SSID can be seen by radios configured as mesh-clients. 

2. Client

A WLAN profile configured with mesh-client will scan all
available channels on startup, looking for a mesh-based
AP to connect.

3. Recovery

─ OFF
(Access
Profile
Mode)
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Parameters Description Range Default

A WLAN profile configured as mesh-recovery will
broadcast pre-configured SSID upon detection of mesh
link failure after a successful connection. This needs to
be exclusively configured on mesh-base device. Mesh-
client will auto scan for mesh-recovery SSID upon failure
of mesh link. 

4. Off

Mesh support disable on WLAN profile.

SSID SSID is the unique network name that wireless stations scans
and associates. 

─ ─

VLAN VLAN is configured to segregate wireless station traffic from
AP traffic in the network. Wireless stations obtain IP address
from the subnet configured in VLAN field of WLAN profile.

1-4094 1

S-VLAN Tag Provision to enable Q-in-Q tagging. - Disbale

S-VLAN
Type

Provision to select the outer S-VLAN type. (802.1q or 802.1 ad) - -

S-VLAN Provision to configure the S-VLAN id. 2-4094 -

Security This parameter determines key values that is encrypted based
on selected algorithm. Following security methods are
supported by cnPilot devices:

1. Open

This method is preferred when Layer 2 authentication is
built in the network. With this configured on cnPilot
device, any wireless station will be able to connect. 

2. Osen

This method is extensively used when Passpoint 2.0 is
enabled on cnPilot devices. If Passpoint 2.0 is disabled,
this security plays no role in wireless station association.

3. WPA2-Pre-Shared Keys

This mode is supported with AES and TKIP encryption.
WPA-TKIP and WPA-AES can be enabled from the CLI
with the “allow-tkip” CLI option.

4. WPA2 Enterprise

This security type uses s 802.1x authentication to
associate wireless stations. Thiis a centralized system of
authentication method. WPA-TKIP and WPA-AES can
be enabled from the CLI with the “allow-tkip” CLI option.

─ Open

Passphrase String that is a key value to generate keys based on security
method configured.

─ 12345678
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Parameters Description Range Default

Radios Each SSID can be configured to be transmitted as per the
deployment requirement. For a regular access profile, options
available to configure transmit mode of SSID:

n 2.4GHz and 5GHz

n 2.4GHz

n 5GHz

For mesh profile, options available are:

n 2.4GHz

n 5GHz

─ 2.4GHz
and 5GHz

VLAN
Pooling

This parameter is required when user requires to distribute
clients across multiple subnets. Different modes of VLAN
pooling is supported by cnPilot devices, based on
infrastructure available at deployment site. Modes supported
are as follows:

1. Disabled

This feature is disabled for this WLAN.

2. Radius Based

User is expected to configure WPA2 Enterprise for this
mode to support. During association phase, cnPilot
obtains pool name form RADIUS transaction and based
on present distribution of wireless station across VLANs,
cnPilot selects appropriate VLAN and wireless station
requests an IP address from the VLAN selected by
cnPilot device.

3. Static

For this mode to support, user requires to configure
VLAN Pool details available under Configure > Network
> VLAN pool. During association phase, cnPilot obtains
pool and based on present distribution of wireless
station across VLANs, cnPilot selects appropriate VLAN
and wireless station requests an IPv4/IPv6 address from
the VLAN selected by cnPilot device.

─ Disabled

Max Clients This specifies the maximum number of wireless stations that
can be associated to a WLAN profile. This varies based on
cnPilot device model number. Refer Table 17 for more details.

1-512
(Refer
Table 17)

127

Client
Isolation

This feature needs to be enabled when there is a need for
prohibition of wireless station to station communication either
over the network or on an AP. Three options are available to
configure based on requirement:

─ Disabled
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Parameters Description Range Default

1. Disable

This option when selected disables client isolation
feature. i.e. any wireless station can communicate to
other wireless station.

2. Local

This options when selected enables client isolation
feature. This option prevents wireless station
communications connected to same AP.

3. Network Wide*

This options when selected enables client isolation
feature. It prevents wireless station communications
connected to different AP deployed in same network.

4. Network Wide Static*

This option when configured enables client isolation
feature across network. User has to configure gateway
MAC to access device across subnets.

*Note: When selected, user has provision to add MAC
addresses to the Client isolation MAC List. Maximum 64
MAC addresses can be added.

cnMaestro
Managed
Roaming

By default, cnPilot devices support Layer 2 roaming. This
option enables Layer 3 roaming. It is mandatory that cnPilot
devices are connected to cnMaestro. Layer 3 roaming is valid
only for Guest Access.

─ Disabled

Hide SSID This is the basic security mode of a Wi-Fi device. This
parameter when enabled, will not broadcast SSID.

─ Disabled

Session
Timeout

This field is specific to non-guest wireless stations. When a
wireless station connects, a session timer is triggered. Once
session time expires, wireless station must undergo either re-
authentication or re-association based on state of wireless
station. By default, it is enabled.

60-
604800

28800

Inactivity
Timeout

Inactivity timer triggers whenever there is no communication
between cnPilot device and wireless station associated to
cnPilot device. Once the timer reaches the configured
Inactivity timeout value, APs sends a de-authentication to that
wireless station. By default, it is enabled.

60-
28800

1800

Drop
Multicast
Traffic

When enabled, will drop all multicast flowing in or out of that
WLAN.

─ Disabled

To configure the above parameters, navigate to the Configure > WLAN > Basic tab and provide the
details as given below:
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1. Select the Enable checkbox to enable a particular WLAN.

2. Select the operating parameters from the Mesh drop-down list.

3. Enter the SSID name for this WLAN in the SSID textbox.

4. Enter the default VLAN assigned to the clients on this WLAN in the VLAN textbox.

5. Enable S-VLAN Tag check-box.

6. Select the VLAN encapsulation type for the client traffic on this WLAN from the S-VLAN Type
drop-down list.

7. Select the S-VLAN id for Q-in Q type VLAN encapsulation from the S-VLAN drop-down list.
8. Select Security type from the drop-down list.

9. Enter WPA2 Pre-shared security passphrase or key in the Passphrase textbox.

10. Select the radio type (2.4GHz, 5GHz) on which the WLAN should be supported from the Radios
drop-down list.

11. Select the required VLAN Pooling parameters from the drop-down list.

12. Select Max Clients parameter value from the drop-down list.

13. Select the required Client Isolation parameter from the drop-down list.

14. Enable cnMaestro Managed Roaming checkbox for layer2/layer 3 roaming.

15. Enable Hide SSID checkbox.

16. Enter the session timeout value in the Session Timeout textbox.

17. Enter the inactivity timeout value in the Inactivity timeout textbox.

18. Select Drop Multicast Traffic checkbox to enable dropping multicast traffic.

19. Click Save.

Table 17: WLAN (Max Clients) parameters

Number of Clients 2.4GHz 5GHz Concurrent

e600 and e700 512 512 512

e410/e430 and e510 256 256 256

e400 and e500/e501S/e502S 256 128 256

e425H and e505 100 100 100
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Figure 20: Basic parameter

Q-in-Q VLAN Tagging
A Q-in-Q VLAN Tagging enables segregation of the traffic from different customers or location at the
core end . It allows the administrator to double tag the wireless traffic coming from the user before
tunneling over the GRE. The inner tag is called customer VLAN ID and outer tag is called service provider
VLAN ID. Using the Q-in-Q tunneling feature over GRE, service providers can use a single VLAN (S-VLAN
Id) to support customers with multiple VLANs. Customer VLAN ID (C-VLAN IDs) are preserved and
traffic from different customers is segregated within the service-provider infrastructure even when they
appear to be on the same VLAN.

Note

Q-in-Q feature is supported only for tunnedled WLAN profile using L2GRE.
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Table 18: Configure: WLAN > Advanced parameters

Parameters Description Range Default

WLAN > Advanced

UAPSD When enabled, cnPilot devices support WMM Power
Save / UAPSD.  This is required where applications
such as VOIP Calls, Live Video streaming etc. is in use.
This feature helps to prioritize traffic. Below is the
default traffic priority followed by cnPilot device.

─ Disabled

QBSS When enabled, appends QBSS IE in Management
frames. This IE provides information of channel usage
by AP, so that smart wireless station can decide better
AP for connectivity. Station count, Channel utilization
and Available admission capacity are the information
available in this IE.

─ Disabled

DTIM interval This parameter plays a key role when power save
supported mobile stations are part of infrastructure.
This field when enabled controls the transmission of
Broadcast and Multicast frames. 

1-255 1

Monitored Host

Host This feature is required where there is interrupted
backbone network. cnPilot device monitors the
reachability of hostname/IP configured in this
parameter and modifies the state of WLAN.

─ Disabled

Interval The frequency of monitoring the network health based
on the status of keep-alive mechanism w.r.t
configured monitored host.

60-3600 Sec 300

Attempts The number of packets in the keep-alive mechanism to
determine the status.

1-20 1

DNS Logging
Host

This feature is required when an Administrator
requires to monitor the websites accessed by wireless
stations connected to WLAN profile.

─ Disabled
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Parameters Description Range Default

Connection
Logging
Host

When enabled provides information of all TCP
connections accessed by a wireless station that is
associated to WLAN.

─ Disabled

Band
Steering

This feature when enabled, steers wireless stations to
connect to 5GHz. There are three modes supported by
cnPilot device. The mode can be selected based on
either deployment or wireless station type. Below is
the order of modes, which forces wireless station to
connect to 5GHz band.

l Low

l Normal

l Aggressive

─ Disabled

Proxy ARP Provision to avoid ARP flood in wireless network.
When enabled, AP responds to ARP requests for the
wireless stations connected to that AP. This is for IPv4
infrastructure.

─ Enabled

Proxy ND Provision to avoid ARP flood in wireless network.
When enabled, AP responds to ARP requests for the
wireless stations connected to that AP. This is for IPv6
infrastructure.

─ Disabled

Unicast
DHCP

Provision to transmit DHCP offer and ACK/NACK
packets as Unicast packets to wireless stations.

─ Enabled

Insert DHCP
Option 82

When enabled, DHCP packets generated from wireless
stations that are associated to APs are appended with
Option 82 parameters. Option 82 provides provision
to append Circuit ID and Remote ID. Following
parameters can be selected in both Circuit ID and
Remote ID:

l Hostname

l AP MAC

l BSSID

l SSID

l VLAN ID

l Site ID

l Custom

l All

─ Disabled

Tunnel Mode This option is enabled when user traffic is tunneled to
DMZ network either using L2TP or L2GRE.

─ Disabled
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Parameters Description Range Default

Fast-
Roaming
Protocol

One of the important aspects to support voice
applications on Wi-Fi network (apart from QoS) is
how quickly a client can move its connection from one
AP to another. This should be less than 150 msec to
avoid any call drop. This is easily achievable when
WPA2-PSK security mechanism is in use. However, in
enterprise environments there is a need for more
robust security (the one provided by WPA2-
Enterprise). With WPA2-Enterprise, the client
exchanges multiple frames with AAA server and hence
depending on the location of AAA server the roaming-
time will be above 700 msec.

Select any one of the following:

1. OKC

This roaming method is a proprietary solution
to bring scalability to the roaming problem. This
method avoids the need to authenticate with
AAA server every time a client moves to new
AP.

2. 802.11r

This is the IEEE standard for fast roaming,
introduces a new concept of roaming where the
initial handshake with the new AP is done even
before the client roams to the target AP, which
is called Fast Transition (FT). Two modes of FT
roaming are supported:By default, this is
enabled.

l Over-the-Air:

l Over-the-DS

─ Disabled

Re-
association
Timeout

It’s the number of seconds after which the
reassociation attempt of a client to an AP should
timeout. This is applicable only when FT roaming is
enabled.

1-100 20

RRM
(802.11k)

AP sends the SSID name of the neighbor APs (SSID
configured on multiple APs) to 11k clients.

Following parameters needs to be enabled: 

l Enable OCS

l Enable RRM

l Support for WPA2 authentication method

─ Disabled



Chapter 8: Configuration - Wireless LAN 59

Parameters Description Range Default

PMF
(802.11w)

802.11w, also termed as Protected Management
Frames (PMF) Service, defines encryption for
management frames. Unencrypted management
frames makes wireless connection vulnerable to DoS
attacks as well as they cannot protect important
information exchanged using management frames
from eavesdroppers.

l Optional

l Mandatory

l Disabled

─

SA Query
Retry Time

The legitimate 802.11w client must respond with a
Security Association (SA) Query Response frame
within a pre-defined amount of time (milliseconds)
called the SA Query Retry time.

100-500 100ms

Association
Comeback
Time

This value is included in the Association Response as
an Association Comeback Time information element.
AP will deny association for the configured interval.

1-20 1 Sec

To configure the above parameters, navigate to the Configure > WLAN > Basic tab and provide the
details as given below:

1. Select the UAPSD checkbox to enable UAPSD.

2. Select the QBSS checkbox to enable QBSS.

3. Enter the value in the DTIM interval textbox to configure DTIM interval.

4. Enter IP address or Hostname in Host textbox.

5. Enter Interval time duration in the textbox.

6. Select number of attempts to check the reachability of monitored host in the Attempts drop-down
list.

7. Enter an IP Address or Hostname in the Monitored Host textbox.

8. Enter the FQDN or IP address of the Server where all the client DNS requests will be logged in the
DNS Logging Host server along with customized port number in the textbox. If the port number is
not entered, AP will take default value as 514.

9. Enter the FQDN or IP address of the Server where all wireless client connectivity events/logs will
be displayed in the configured Connection Logging Host server along with customized port
number in the textbox. If the port number is not entered, AP will take default value as 514.

10. Select Band Steering parameter for 5GHz band from the drop-down list.

11. Enable Proxy ARP checkbox to avoid ARP flood in wireless network.

12. Enable Proxy ND checkbox to avoid ARP flood in wireless network.

13. Enable Unicast DHCP checkbox to Convert DHCP-OFFER and DHCP-ACK to unicast before
forwarding to clients.

14. Enable Insert DHCP Option 82 checkbox.

15. Select Option 82 Circuit ID to enable DHCP Option-82 from the drop-down list.

16. Select Option 82 Remote ID to choose the MAC address of the AP from the drop-down list.
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17. Select Tunnel Mode checkbox to enable tunnelling of WLAN traffic over configured tunnel.

18. Enable the required OKC or 802.11r configure roaming protocol in the Fast-Roaming Protocol
checkbox.

19. Enable RRM (802.11k) checkbox.

20. Select PMF (802.11w) parameter from the drop-down list.

a. Enter SQ Query Retry Time in the textbox.

b. Enter Association Comeback Time in the textbox.

21. Click Save.
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Figure 21: Advanced parameter
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Table 19: Configure: WLAN > Radius Server parameters

Parameters Description Range Default

Authentication
Server

Provision to configure RADIUS Authentication server details
such as Hostname/IPv4/IPv6, Shared Secret, Port Number
and Realm. Maximum of three RADIUS server can be
configured.

─ Disabled

Accounting
Server

Provision to configure Accounting server details such as
Hostname/IPv4/IPv6, Shared Secret, Port Number.
Maximum of three RADIUS server can be configured.

─ Disabled

Timeout Wait time period for response from AAA server. 1-30 3

Attempts Parameter to configure number of attempts that a device
should send AAA request to server if no response is
received within configured timeout period.

1-3 1

Accounting
Mode

This field is enabled based on customer requirement.
Accounting packet is transmitted based on mode selected.

1. Start-Stop

Accounting packets are transmitted by AP to AAA
server when a wireless station is connected and then
disconnects.

2. Start-Interim-Stop

Accounting packets are transmitted by AP to AAA
server when a wireless station connects and then at
regular intervals of configured Interim Update
Interval and then when it disconnects.

3. None

Accounting mode will be disable.

─ Disabled

Accounting
Packet

When enabled, Accounting-On is sent for every client when
connected.

─ Disabled

Sync
Accounting
Records

When enabled, will share the accounting records when
wireless stations move across different AP that are Layer 2
connected.

─ Disabled

Server Pool
Mode

User can configure multiple Authorization and Accounting
servers. Based on number of wireless stations, user can
choose either Failover or Load Balance mode.

1. Load Balance

AP communicates with multiple servers and ensures
that authorization and accounting are equally shared
across configured servers.

2. Failover

─ Load
Balance
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Parameters Description Range Default

AP selects the RADIUS server which is up and
running based on the order of configuration.

NAS Identifier This is configurable parameter and is appended in RADIUS
request packet.

1. AP-ETH0-MAC:

NAS identifier attribute will be ETH0 MAC address

2. WLAN-BSSID:

NAS identifier attribute will be WLAN-BSSID

3. Custom:

Any custom value

─ Hostname/

System
Name

Interim Update
Interval

This field is used when RADIUS accounting is enabled, and
mode selected as Start-Interim-Stop.

10-
65535

1800

Dynamic
Authorization

This option is required, where there is a CoA requests from
AAA/RADIUS server.

─ Disabled

Dynamic VLAN When enabled, AP honors the VLAN information provided
in RADIUS transaction. Wireless station requests IP address
from the same VLAN learnt through RADIUS.

─ Enabled

Proxy through
cnMaestro

This option is enabled, whenever cnMaestro is required to
act as proxy server to RADIUS authentication requests
coming from cnPilot devices that are connected to
cnMaestro.

─ Disabled

Called Station ID Following information can be communicated to RADIUS
server:

l AP-MAC

l AP-MAC: SITE-NAME

l AP-MAC: SSID

l AP-MAC: SSID-SITE-NAME

l AP-NAME

l AP-NAME: SITE-NAME

l AP-NAME: SSID

l SITE-NAME

l SSID

l CUSTOM

AP-MAC:
SSID

To configure the above parameters, navigate to the Configure > WLAN tab and select Radius Server tab
and provide the details as given below:
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1. Enter the RADIUS Authentication server details such as Hostname/Shared Secret/Port Number/
Realm in the Authentication Server 1 textbox.

2. Enter the time in seconds of each request attempt in Timeout textbox.

3. Enter the number of attempts before a request is given up in the Attempts textbox.

4. Select the configuring Accounting Mode from the drop-down list.

5. Enable Accounting Packet checkbox.

6. Enable Sync Accounting Records checkbox to enable sync accounting records configuration.

7. Enable Load Balance/Failover in the Server Pool Mode checkbox.

8. Enter the NAS Identifier parameter in the textbox.

9. Enter the Interim Update Interval parameter value in the textbox.

10. Enable Dynamic Authorization checkbox to configure dynamic authorization for wireless clients.

11. Enable Dynamic VLAN checkbox.

12. Enable Proxy through cnMaestro checkbox.

13. Select Called Station ID from the drop-down list.

14. Click Save.

Table 20: NAS IP with AP dual stack

IPv6 preference AP Address Mode NAS ID

Yes DUAL STACK IPv6

No DUAL STACK IPv4

Yes IPv6 only IPv6

No IPv6 only IPv6

Yes IPv4 only IPv4

No IPv4 only IPv4
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Figure 22: Radius Server parameter
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Table 21: Configure: WLAN > Guest Access > Internal Access Point parameters

Parameters Description Range Default

WLAN > Guest Access > Internal Access Point

Enable Enables the Guest Access feature. ─ Disabled

Access Policy There are four types of access types provided for the
user:

1. Clickthrough

This mode allows the users to get access data
without any authentication mechanism. User
can access internet as soon as he is connected
and accepts Terms and Conditions.

2. RADIUS

This mode when selected, user has to provide
username and password, which is then
redirected to RADIUS server for authentication.
If successful, user is provided with data access.

3. LDAP

This mode when selected, user has to provide
username and password, which is then
redirected to LDAP server for authentication. If
successful, user is provided with data access.

4. Local Guest Account

User must configure username and password
on device, which has to be provided in the
redirection page for successful authentication
and data access.

─ Clickthrough

Redirect Mode This option helps the user to configure the HTTP or
HTTPS mode of redirection URL.

1. HTTP

AP sends a HTTP POSTURL to the associated
client, which will be http://<Pre-defined-URL>.

2. HTTPS

AP sends HTTPS POSTURL to the successful
associated client, which will be https://<Pre-
defined-URL>.

─ HTTP

Redirect
Hostname

User can configure a friendly hostname, which is
added in DNS server and is resolvable to cnPilot IP
address. This parameter once configured will be
replaced with IP address in the redirection URL
provided to wireless stations.

─ ─

file:///C:/Users/jab100/Desktop/backup/4.1/User Guide/Flare/pmp-2835_004v000.docx
file:///C:/Users/jab100/Desktop/backup/4.1/User Guide/Flare/pmp-2835_004v000.docx
file:///C:/Users/jab100/Desktop/backup/4.1/User Guide/Flare/pmp-2835_004v000.docx
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Parameters Description Range Default

Title User can configure a Title to the splash page.
Configured text in this parameter will be displayed in
the redirection page. This text is usually Bold.

Up to 255
characters

Welcome To
Cambium
Powered
Hotspot

Contents User can configure the contents of Splash page using
this field. Displays the text configured under the Title
section of redirection page.

Up to 255
characters

Please enter
username and
password to
get Web
Access

Terms Splash page displays the text configured when user
accepts Terms and Agreement.

Up to 255
characters

─

Logo Displays the logo image updated in URL http
(s)://<ipaddress>/logo.png. Either PNG or JPEG
format of logo are supported.

─ ─

Background
Image

Displays the background image updated in URL http
(s)://<ipaddress>/backgroundimage.png. Either PNG
or JPEG format of logo are supported.

─ ─

Success Action Provision to configure redirection URL after
successful login to captive portal services. User can
configure three modes of redirection URL:

1. Internal Logout Page

After successful login, wireless client is
redirected to logout page hosted on AP.

2. Redirect user to External URL

Here users will be redirected to URL which is
configured on device in Redirection URL
configurable parameter.

3. Redirect user to Original URL

Here users will be redirected to URL that is
accessed by user before successful captive
portal authentication.

─ Internal
Logout page

Redirect user to
External URL

Provision to configure re-direction URL after
successful login and an additional information of AP
and wireless station information can be appended in
the URL.

n Prefix Query Strings in Redirect URL

This option is selected by default. Following
information is appended in the redirection URL:

l SSID

─ ─
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Parameters Description Range Default

l AP MAC

l NAS ID

l AP IP

l Client MAC

l Redirection URL

l User can provide either HTTP or HTTPS URL

Redirection user
to Original URL

Users will be redirected to URL that is accessed by
user before successful captive portal authentication.
There is additional parameter Prefix Query Strings in
Redirection URL that is enabled by default and details
given below:

This option is selected by default. Following
information is appended in the redirection URL:

Prefix Query Strings in Redirect URL

l SSID

l AP MAC

l NAS ID

l AP IP

l Client MAC

─ ─

Success
message

Provision to configure text to display upon successful
Guest Access authentication. This is applicable only
when Success Action mode is Internal Logout Page.

─ ─

Redirect l If enabled, only HTTP URLs will be redirected
to Guest Access login page.

l If disabled, both HTTP and HTTPs URLs will be
redirected to Guest Access login page.

─ Enabled

Redirect User
Page

IPv4/IPv6 address configured in this field is used as
logout URL for Guest Access sessions. IPv4/IPv6
address configured should be not reachable to
internet.

─ 1.1.1.1

Proxy
Redirection Port

Proxy port can be configured with which proxy server
is enabled. This allows URL’s accessed with proxy port
to be redirected to login page.

1 - 65535 ─
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Parameters Description Range Default

Session Timeout This is the duration of time, client will be allowed to
access internet if quota persists, after which AP sends
de-authentication. Wireless station has to undergo
Guest Access authentication after session timeout.

60 -
2592000

28800

Inactivity
Timeout

Provision to configure timeout period to disconnect
wireless stations that are associated but no data
traffic. AP starts timer when there is no data received
from a wireless station and disconnects when timer
reaches 0.

60 -
2592000

1800

MAC
Authentication
Fallback

It’s a mechanism in which wireless stations will be
redirected to Guest Access login page after any
supported type of MAC address authentication fails.

─ Disabled

Extend Interface Provision to support Guest Access on Ethernet
interface.

─ Disabled

Whitelist Provision to configure either IPv4/IPv6 or URLs to
bypass traffic, therefor user can access those IPs or
URLs without Guest Access authentication.

─ ─

Captive Portal
bypass User
Agent

Provision to limit the auto-popup to a certain browser
as configured based on User-agent of browsers.

─ ─

To configure the above parameters, navigate to the Configure > WLAN > Guest Access tab and provide
the details as given below:

1. Select Enable checkbox to enable the Guest Access feature.

2. Enable Internal Access Point checkbox.

3. Enable the required access types from the Access Policy checkbox.

4. Enable HTTP or HTTPS from the Redirect Mode checkbox.

5. Enter Redirect Hostname in the textbox.

6. Enter the title to appear in the splash page in the Title textbox.

7. Enter the content to appear in the splash page in the Contents textbox.

8. Enter the terms and conditions to appear in the splash page in the Terms textbox.

9. Enter the logo to be displayed in the Logo textbox.

10. Select the Background Image to be displayed on the splash page in the textbox.

11. Enable configured modes of redirection URL in Success Action checkbox.

12. Enter Success message to appear in the textbox.

13. Enable Redirect checkbox for HTTP packets.

14. Enter configuring IP address in the Redirect User Page textbox.
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15. Enter Port number in the Proxy Redirection Port textbox.

16. Enter the session timeout in seconds in the Session Timeout textbox.

17. Enter the inactivity timeout in seconds in the Inactivity Timeout textbox.

18. Enable MAC Authentication Fallback checkbox if guest-access is used only as fallback for clients
failing MAC-authentication.

19. Enter the name of the interface that is extended for guest access in the Extend Interface textbox.

20. Click Save.

To configure Whitelist parameter:

1. Enter the IP address or the domain name of the permitted domain in the IP Address or Domain
Name textbox.

2. Click Save.

To configure the Captive Portal bypass User Agent parameter:    

1. Select Index parameter value from the drop-down list.

2. Enter User Agent String parameter in the textbox.

3. Select Status Code from the drop-down list.

4. Enter HTML Response in the textbox.

5. Click Save.
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Figure 23: Configure: WLAN > Guest Access > Internal Access Point parameter
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Table 22: Configure: WLAN > Guest Access > External Hotspot parameters

Parameters Description Range Default

WLAN > Guest Access > External Hotspot

Access Policy There are four types of access types provided for the
end user:

1. Clickthrough

This mode allows users to get access data
without any authentication mechanism. User can
access internet as soon as he is connected and
accepts Terms and Conditions.

2. RADIUS

User has to provide username and password,
which is then redirected to RADIUS server for
authentication. If successful, user is provided
with data access.

3. LDAP

User must provide username and password,
which is then redirected to LDAP server for
authentication. If successful, user is provided
with data access.

4. Local Guest Account

User has to configure username and password
on device, which has to be provided in the
redirection page for successful authentication
and data access.

─ Clickthrough

LDAP Server
baseDN

Provision to configure the point from where the server
will search for users.

- ─

LDAP Server
adminDN

Provision to configure the Admin Domain which binds
with LDAP server for successful search of LDAP/AD
server.

- ─

LDAP Server
Admin
Password

Provision to configure Admin password of LDAP/AD
server to search all organizational unit defined in a
Domain component.

- ─

Redirect Mode Provision to configure the HTTP or HTTPS mode of
redirection URL.

1. HTTP

AP sends a HTTP POSTURL to the associated
client, which will be http://<Pre-defined-URL>.

2. HTTPS

─ HTTP

file:///C:/Users/jab100/Desktop/backup/4.1/User Guide/Flare/pmp-2835_004v000.docx


Chapter 8: Configuration - Wireless LAN 73

Parameters Description Range Default

AP sends HTTPS POSTURL to the successful
associated client, which will be https://<Pre-
defined-URL>.

Redirect
Hostname

User can configure a friendly hostname, which is added
in DNS server and is resolvable to cnPilot IP address.
This parameter once configured will be replaced with
IP address in the redirection URL provided to wireless
stations.

─ ─

WISPr Clients
External Server
Login

Provision to enable re-direction of guest access portal
URL obtained through WISPr.

─ Disabled

External Page 
URL

User can configure landing/login page which is posted
to wireless stations that are not Guest Access
authenticated.

─ ─

External Portal
Post Through
cnMaestro

This is required when HTTPS is only supported by
external guest access portal. This option when enabled
minimizes certification. Certificate is required to install
only in cnMaestro On-Premises.

─ Disabled

External Portal
Type

Two modes of portal types are supported by cnPilot
products.

1. Standard

This mode is selected, for all third-party vendors
whose Guest Access services is certified and
integrated with cnPilot products.  

2. XWF

This mode is selected for Facebook Express Wi-
Fi deployment.

─ Standard

XWF Version 1. XWF-v1 is also called as XWF-Lite

2. XWF-v2 is also called as XWF-Full

3. XWF-v3

─ 1

XWF Key This is applicable when XWF portal mode is selected
irrespective of XWF version.

─ ─

XWF Access
Token

XWF Access token in URL encoded format. - -

XWF SSE Server
Timeout

This is applicable when XWF portal mode is selected.
Provision to configure XWF SSE Server Timeout.

5-1800 60

Success Action Provision to configure redirection URL after successful
login to captive portal services. User can configure
three modes of redirection URL:

─ Internal
Logout Page

file:///C:/Users/jab100/Desktop/backup/4.1/User Guide/Flare/pmp-2835_004v000.docx
file:///C:/Users/jab100/Desktop/backup/4.1/User Guide/Flare/pmp-2835_004v000.docx
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Parameters Description Range Default

1. Internal Logout Page

After successful login, Wireless client is
redirected to logout page hosted on AP.

2. Redirect user to External URL

Here users will be redirected to URL which is
configured on device in Redirection URL
configurable parameter.

3. Redirect user to Original URL

Here users will be redirected to URL that is
accessed by user before successful captive
portal authentication.

Redirect user to
External URL

Provision to configure re-direction URL after successful
login and an additional information of AP and wireless
station information can be appended in the URL.

l Prefix Query Strings in Redirect URL

This option is selected by default. Following
information is appended in the redirection URL:

o SSID
o AP MAC
o NAS ID
o AP IP
o Client MAC

l Redirection URL

User can provide either HTTP or HTTPS URL. 

─ ─

Redirection user
to Original URL

Users will be redirected to URL that is accessed by user
before successful captive portal authentication. There
is additional parameter Prefix Query Strings in
Redirection URL that is enabled by default and details
given below:

l Prefix Query Strings in Redirect URL

This option is selected by default. Following
information is appended in the redirection URL:

o SSID
o AP MAC
o NAS ID
o AP IP
o Client MAC

─ ─

Success
message

Provision to configure text to display upon successful
Guest Access authentication. This is applicable only
when Success Action mode is Internal Logout Page.

─ ─
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Parameters Description Range Default

Redirection URL
Query String

Following information is appended in the redirection
URL, if “Prefix Query Strings in Redirect URL” is
enabled.

l Client IP

l RSSI

l AP Location

─ Disabled

Redirect l If enabled, only HTTP URLs will be redirected to
Guest Access login page.

l If disabled, both HTTP and HTTPs URLs will be
redirected to Guest Access login page.

─ Enabled

Redirect User
Page

IP address configured in this field is used as
logout/disconnect/redirect to captive portal URL for
Guest Access sessions. IP address configured should
not be reachable to internet.

─ 1.1.1.1

Proxy
Redirection Port

Proxy port can be configured with which proxy server
is enabled. This allows URL’s accessed with proxy port
to be redirected to login page.

1 - 65535 ─

Session Timeout This is the duration of time, client will be allowed to
access internet if quota persists, after which AP sends
de-authentication. Wireless station has to undergo
Guest Access authentication after session timeout.

60 -
2592000

28800

Inactivity
Timeout

Provision to configure timeout period to disconnect
wireless stations that are associated but no data traffic.
AP starts timer when there is no data received from a
wireless station and disconnects when timer reaches 0.

60 -
2592000

1800

MAC
Authentication
Fallback

It’s a mechanism in which wireless stations will be
redirected to Guest Access login page after any
supported type of MAC address authentication failures.

─ Disabled

Extend Interface Provision to support Guest Access on Ethernet
interface.

─ Disabled

Traffic Class 1 This is exclusively applicable for XWF portal type. This
traffic class includes IP and URLs related to XWF for
successful re-direction, login and payments.

─ ─

Traffic Class 2 This is exclusively applicable for XWF portal type. This
traffic class includes whitelist IP/URLs that can be
accessed without Guest Access authentication.

─ ─
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Parameters Description Range Default

Whitelist Provision to configure either IPs or URLs to bypass
traffic, such that user can access those IPs or URLs
without Guest Access authentication. This parameter is
valid for standard portal type.

─ ─

Captive Portal
bypass User
Agent

Provision to limit the auto-popup to a certain browser
as configured based on User-agent of browsers. This is
valid for standard portal type.

─ ─

To configure the above parameters, navigate to the Configure > WLAN > Guest Access tab and provide
the details as given below:

1. Enable the required access types from the Access Policy checkbox.

2. Enable HTTP or HTTPS from the Redirect Mode checkbox.

3. Enter Redirect Hostname in the textbox.

4. Enable WISPr Clients External Server Login checkbox.

5. Enter External Page URL in the textbox.

6. Enable External Portal Post Through cnMaestro checkbox.

7. Select External Portal Type from the drop-down list.

8. Enable configured modes of redirection URL in Success Action checkbox.

9. Enter Success message to appear in the textbox.

10. Enable the required Redirection URL Query String checkbox.

11. Enable Redirect checkbox for HTTP packets.

12. Enter configuring IP address in the Redirect User Page textbox.

13. Enter Port number in the Proxy Redirection Port textbox.

14. Enter the session timeout in seconds in the Session Timeout textbox.

15. Enter the inactivity timeout in seconds in the Inactivity Timeout textbox.

16. Select the MAC Authentication Fallback checkbox if guest-access is used only as fallback for
clients failing MAC-authentication.

17. Enter the name of the interface that is extended for guest access in the Extend Interface textbox.

18. Click Save.

19. Select Traffic Class 1 and Traffic Class 2 tabs and enter the following:

1. Enter Name in the textbox.

2. Enter Policy in the textbox.

3. Click Save.

20. Select Internet tab and enter Name in the textbox.
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1. Click Save.

To configure Whitelist:

1. Enter the IP address or the domain name of the permitted domain in the IP Address or Domain
Name textbox.

2. Click Save.

To configure Captive Portal bypass User Agent:    

1. Select Index parameter value from the drop-down list.

2. Enter User Agent String parameter in the textbox.

3. Select Status Code from the drop-down list.

4. Enter HTML Response in the textbox.

5. Click Save.
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Figure 24: Configure: WLAN > Guest Access > External Hotspot (Standard) parameter
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Figure 25: Configure: WLAN > Guest Access > External Hotspot (XWF) parameter



Chapter 8: Configuration - Wireless LAN 80

Table 23: Configure: WLAN > Guest Access > cnMaestro parameters

Parameters Description Range Default

WLAN > Guest Access > cnMaestro

Guest Portal 
Name

Provision to configure the name of the Guest Access profile
which is hosted on CnMaestro.

─ ─

Redirect n If enabled, only HTTP URLs will be redirected to
Guest Access login page.

n If disabled, both HTTP and HTTPs URLs will be
redirected to Guest Access login page.

─ Enabled

Redirect User
Page

IP address configured in this field is used as logout URL for
Guest Access sessions. IP address configured should be not
reachable to internet.

─ 1.1.1.1

Proxy
Redirection Port

Proxy port can be configured with which proxy server is
enabled. This allows URL’s accessed with proxy port to be
redirected to login page.

1 - 65535 ─

Inactivity
Timeout

Provision to configure timeout period to disconnect
wireless stations that are associated but no data traffic. AP
starts timer when there is no data received from a wireless
station and disconnects when timer reaches 0.

60 -
2592000

1800

MAC
Authentication
Fallback

It’s a mechanism in which wireless stations will be
redirected to Guest Access login page after any supported
type of MAC address authentication fails.

─ Disabled

Extend Interface Provision to support Guest Access on Ethernet interface. ─ Disabled

Whitelist Provision to configure either IPs or URLs to bypass traffic,
such that user can access those IPs or URLs without Guest
Access authentication.

─ ─

Captive Portal
bypass User
Agent

Provision to limit the auto-popup to a certain browser as
configured based on User-agent of browsers.

─ ─

To configure the above parameters, navigate to the Configure > WLAN > cnMaestro tab and provide the
details as given below:

1. Enter Guest Portal Name which is hosted on cnMaestro in the textbox.

2. Enable Redirect checkbox for HTTP packets.

3. Enter configuring IP address in the Redirect User Page textbox.

4. Enter Port number in the Proxy Redirection Port textbox.

5. Enter the inactivity timeout in seconds in the Inactivity Timeout textbox.

6. Select the MAC Authentication Fallback checkbox if guest-access is used only as fallback for
clients failing MAC-authentication.
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7. Enter the name of the interface that is extended for guest access in the Extend Interface textbox.

8. Click Save.

To configure the Whitelist parameter:

1. Enter the IP address or the domain name of the permitted domain in the IP Address or Domain
Name textbox.

2. Click Save.

To configure the Captive Portal bypass User Agent parameter:    

1. Select Index parameter value from the drop-down list.

2. Enter User Agent String parameter in the textbox.

3. Select Status Code from the drop-down list.

4. Enter HTML Response in the textbox.

5. Click Save.

Figure 26: Configure: WLAN > Guest Access > cnMaestro parameter
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Table 24: Configure: WLAN > Usage Limits parameters

Parameters Description Range Default

Rate Limit
per Client

Provision to limit throughput per client. Default allowed
throughput per client is unlimited. i.e., maximum allowed by
802.11 protocols. The traffic from/to each client on a SSID can
be rate-limited in either direction by configuring Client rate
limit available in usage-limits inside the WLAN Configuration.
This is useful in deployments like public hotspots where the
backhaul is limited and the network administrator would like to
ensure that one client does not monopolize all available
bandwidth.

─ 0
[Unlimited]

Rate Limit
per WLAN

Provision to limit throughout across WLAN irrespective of
number of associated wireless stations to WLAN.  All
upstream/downstream traffic on an SSID (aggregated across
all wireless clients) can be rate-limited in either direction by
configuring usage-limits inside the WLAN Configuration
section of the GUI. This is useful in cases where multiple SSIDs
are being used and say one is for corporate use, and another
for guests. The network administrator can ensure that the
guest VLAN traffic is always throttled, so it will not affect the
corporate WLAN.

─ 0
[Unlimited]

To configure the above parameters, navigate to the Configure > WLAN > Usage Limits tab and provide
the details as given below:

1. Enter Upstream and Downstream parameters in the Rate Limit per Client textbox.

2. Enter Upstream and Downstream parameters in the Rate Limit per WLAN textbox.

3. Click Save.

Figure 27: Configure: WLAN > Usage Limits parameters

Table 25: Configure: WLAN > Scheduled Access parameters

Parameters Description Range Default

Scheduled
Access

Provision to configure the availability of Wi-Fi services for a
selected time duration. cnPilot has capability of configuring the
availability of Wi-Fi services on all days or on specific day (s) of a
week. Time format is in Hours.

00:00
Hrs. -
23:59
Hrs.

Disabled
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To configure the above parameter, navigate to the Configure > WLAN > Scheduled Access tab and
provide the details as given below:

1. Enter the start and end time to enable the Wi-Fi access in the respective textboxes.

2. Click Save.

Figure 28: Configure: WLAN > Scheduled Access parameters

Table 26: Configure: WLAN > Access parameters

Parameters Description Range Default

ACL

Precedence Provision to configure index of ACL rule. Packets
are validated and processed based on precedence
value configured.

1-256 1

Policy Provision to configure whether to allow, deny or
route traffic.

Allow/deny/Route Deny

Direction Provision to apply the ACLs rules configured either
in any direction or specific direction.

─ ─

Type cnPilot devices support three layers of ACLs. A rule
can be configured as below:

n MAC

n IP

This type is for IPv4 based IP ACL.

n IP6

This type is for IPv6 based IP ACL.

n Proto

─ IP
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Parameters Description Range Default

This type is for protocol supported in IPv4.

n Proto6

This type is for protocol supported in IPv6.

Source IP/Mask This option is available when ACL type is
configured to an IPv4/IPv6 address. This field helps
user to configure if rule needs to be applied for a
single IPv4/IPv6 address or range of IPv4/IPv6
addresses.

─ ─

Destination
IP/Mask

This option is available when ACL type is
configured to an IPv4/IPv6 address. This field helps
user to configure if rule needs to be applied for a
single IPv4/IPv6 address or range of IPv4/IPv6
addresses.

─ ─

Source
MAC/Mask

This option is available when ACL type is
configured to a MAC address. This field helps user
to configure if rule needs to be applied for a single
device MAC address or range of MAC addresses.

─ ─

Destination
MAC/Mask

This option is available when ACL type is
configured to MAC address. This field helps user to
configure if rule needs to be applied for a single
device MAC address or range of MAC addresses.

─ ─

Protocol This option is available when user selects ACL type
as proto/proto6. User can select following
protocols:

l TCP

l UDP

l ICMP

l Any

─ TCP

Source Port Provision to apply ACL with combination of
protocol and port. 

─ ─

Destination Port Provision to apply ACL with combination of
protocol and port. 

─ ─

Description To make administrator easy to understand, a text
string can be added for each ACL rule.

─ ─

DNS-ACL

Precedence Provision to configure index of ACL rule. Packets
are validated and processed based on Precedence
value configured.

─ 1
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Parameters Description Range Default

Action Provision to configure whether to allow or deny
traffic.

─ Deny

Domain Provision to configure domain names and rules are
applied based on Action configured.

─ ─

MAC Authentication

MAC
Authentication
Policy

cnPilot supports multiple methods of MAC
authentication. Following are details of each mode:

1. Permit

Wireless station MAC addresses listed will be
allowed to associate to AP.

2. Deny

When user configures a MAC address, those
wireless station shall be denied to associate
and the non-listed MAC address will be
allowed.

3. Radius

For every wireless authentication, cnPilot
sends a radius request and if radius accept is
received, then wireless station is allowed to
associate.

4. cnMaestro

This option is preferable when administrator
prefers centralized MAC authentication
policy. For every wireless authentication, AP
sends query to cnMaestro if it allowed or
disallowed to connect. Based on the
configuration, wireless stations are either
allowed or denied. 

─ Deny

MAC ─ ─

Description ─ ─

To configure the above parameter, navigate to the Configure > WLAN > Access tab and provide the
details as given below:

To configure ACL:

1. Select Precedence from the drop-down list.

2. Select type of Policy from drop-down list.

3. Select Direction from the drop-down list.

4. Select Type from the drop-down list.

5. Enter IP address of source in the Source IP/Mask textbox.

6. Enter IP address of destination in the Destination IP/Mask textbox.
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7. Enter Description in the textbox.

8. Click Save.

To configure DNS ACL:

1. Select Precedence from the drop-down list.

2. Select type of action from Action drop-down list.

3. Enter domain name in the Domain textbox.

4. Click Save.

To configure MAC Authentication:

1. Select MAC Authentication Policy from the drop-down list.

2. Enter MAC in the textbox.

3. Enter Description in the textbox.

4. Click Save.

Table 27: Behavior of IP ACL when dual stack is enabled

IPv4 ACL Rule IPv6 ACL Rule Remark

No rule No rule All IPv4 and IPv6 allowed

IPv4 permit rule No rule All IPv6 packets dropped

No rule IPv6 rule All IPv4 packets dropped

IPv4 permit rule IPv6 permit rule All IPv4 and IPv6 allowed
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Figure 29: Configure: WLAN > Access parameters

Table 28: Configure: WLAN > Passpoint parameters

Parameters Description Range Default

Configuration > Hotspot2.0 / Passpoint

Enable Passpoint (Release 2) enables a secure hotspot network access,
online sign up and Policy Provisioning.

─ Disabled

DGAF Downstream Group Addressed Forwarding, when enabled the
WLAN doesn't transmit any multicast and broadcast packets.

─ Disabled

ANQP
Domain ID

ANQP domain identifier included when the HS 2.0 indication
element is in Beacon and Probe Response frames.

0-
65535

0

Comeback
Delay

Comeback Delay in milliseconds. 100-
2000

0



Chapter 8: Configuration - Wireless LAN 88

Parameters Description Range Default

Access
Network
Type

The configured Access Network Type is advertised to STAs.
Following are the different network types supported:

n Private

n Chargeable Public

n Emergency Services

n Free Public

n Personal Device

n Private with Guest

n Test

n Wildcard

─ Private

ASRA Indicates that the network requires a further step for access. ─ Disabled

Internet The network provides connectivity to the Internet if not specified. ─ Disabled

HESSID Configures the desired specific HESSID network identifier or the
wildcard network identifier.

─ ─

Venue Info Configure venue group and venue type. ─ ─

Roaming
Consortium

The roaming consortium and/or SSP whose security credentials
can be used to authenticate with the AP.

─ ─

ANQP
Elements

Select any one of the following:

l 3GPP Cellular Network Information
l Connection Capability
l Domain Name List
l Icons
l IP Address Type information
l NAI Realm List
l Network Authentication Type
l Operating Class Indication
l Operator Friendly Names
l OSU Provider List
l Venue Name Information
l WAN Metrics

─ ─

To configure the above parameter, navigate to the Configure > WLAN > Passpoint tab and provide the
details as given below:

1. Select Enable checkbox to enable passpoint functionality.

2. Select DGAF checkbox to enable Downstream Group Addressed Forwarding functionality.
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3. Enter the domain identifier value in ANQP Domain ID textbox.

4. Enter Comeback Delay in milliseconds in the textbox.

5. Choose the Access Network Type value from the drop-down list.

6. Enable ASRA checkbox if the network requires additional steps for access.

7. Enable Internet checkbox for the network to provide connectivity to the Internet.

8. Enter the HESSID to configure the desired specific HESSID network identifier or the wildcard
network identifier.

9. Select Venue Info from the drop-down list.

10. To add Roaming Consortium value, enter the value in the textbox and click Add. To delete a
Roaming Consortium value, select from the drop-down list and click Delete.

11. Click Save.

Figure 30: Configure: WLAN > Passpoint parameters
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Radius based ePSKPremium feature

In Pre-shared key (PSK) authentication, a shared secret is used to authenticate the client. Each client will
have the same Pre-shared key to access the network. Cambium has an ePSK feature, an extension of
WPA2 PSK where multiple passphrases can assign to a single SSID. Which allows multiple clients to have
different passphrase to access the network. The Wi-Fi clients can have unique passphrases to be used by
each client using this feature.

The same feature (ePSK) is now extended to RADIUS. The RADIUS server can provide the matching PMK
for a given client, and corresponding standard RADIUS attributes can be enforced as client session
management.

Configuration CLI:

enhanced PSK (ePSK)
By using the ePSK feature, users can configure and support individual PSK keys for different clients. This
feature can be configured under a given WLAN configuration in cnMaestro UI. For on devices, only CLI
support is available.

This feature also supports individual VLAN assignments for a given key which helps to put client traffic on
different VLANs for limiting broadcast traffic.

Note

ePSK scale is a Premium feature where users can configure more than 300 ePSK (up to 1024
ePSK) per WLAN and it is controlled by cnMaestro X.

Cambium Traffic ClassPremium feature

Cambium Traffic Class attributes are supported for wireless guest clients. The device allows guest clients
to communicate destinations (defined using IP/Network address) defined under traffic class names
without completing the guest authentication. The RADIUS server can push traffic class name and data
quota as part of the RADIUS accept packet or CoA update. AP keeps track of guest clients traffic usage
against each traffic class and data utilization information is sent to the accounting server in RADIUS
accounting packets (Account-Interim update and account stop messages).

Traffic class can be defined under the WLAN profile and only three traffic classes are supported via CLI
mode. If APs are managed from cnMaestro, traffic class can be configured in AP Group using User-
Defined Overrides options. When the traffic class quota gets exhausted, user clients are redirected to the
external captive portal server.

Cambium Networks Wi-Fi devices support the following Cambium vendor-specific (VSA 17713) Traffic
Class attributes:
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Table 29: Traffic Class attributes

Name Number Type

Cam-Vlan-Pool-Id 157 string

CAMB-Authorize-Classes 158 tlv

CAMB-Authorize-Class-Name 158.1 string

CAMB-Authorize-Bytes-Left 158.2 integer64

CAMB-Traffic-Classes-Acct 159 tlv

CAMB-Acct-Class-Name 159.1 string

CAMB-Acct-Input-Octets 159.2 integer64

CAMB-Acct-Output-Octets 159.3 integer64

CAMB-Acct-Input-Packets 159.4 integer64

CAMB-Acct-Output-Packets 159.5 integer64

CAMB-Walled-Garden-State 160 integer

CLI configuration:
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Chapter 9: Configuration - Network
This chapter describes the following topics:

l Overview

l Configuring Network parameters

Overview
This chapter gives an overview of cnPilot configurable parameters related to LAN, VLAN, Routes, DHCP
server, Tunnel, ACL and Firewall.

Configuring Network parameters
cnPilot network configuration parameters are segregated into following sections:

l VLAN

l Routes

l Ethernet Ports

l Security

l DHCP

l Tunnel

l PPPoE

l VLAN Pool

IPv4 network parameters

VLAN

Table 30: Configure: Network > VLAN > IPv4 parameters

Parameters Description Range Default

VLAN > IPv4

Edit Provision to select the VLAN interface that user is intended to
view/update configuration.

─ VLAN 1

Address Provision to configure mode of IPv4 address configuration for an
interface selected. Two modes are supported:

1. DHCP

This is the default mode in which cnPilot device tries to
obtain IPv4 address from DHCP server.

2. Static IP

─ DHCP
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Parameters Description Range Default

User must explicitly configure IPv4 address and Netmask for a
VLAN selected.

NAT This option is preferable when you defined local DHCP servers.
This option when selected, traffic from wireless stations are
NAT’ed to the default gateway interface IP.

Disabled

Zeroconf IP Zeroconf IP is recommended to be enabled. This interface is
available only on VLAN1 configuration section. If VLAN 1 is not
allowed in Ethernet interfaces, this IP will not be accessible.

─ Enabled

DHCP Relay
Agent

This option is enabled when DHCP server is hosted on a VLAN
which is not same as client that is requesting for DHCP IP.
Enabling this appends Option 82 in the DHCP packets. Following
information is allowed to configure:

1. DHCP Option 82 Circuit ID

Configurable parameters under this option are as follows:

l Hostname

l APMAC

l BSSID

l SSID

l Custom

2. DHCP Option 82 Remote ID

Configurable parameters under this option are as follows:

l Hostname

l APMAC

l BSSID

l SSID

l Custom

─ Disabled

Request
Option All

This configuration decides the interface on which cnPilot AP
will learn the following: 

l IPv4 default gateway 
l DHCP client options like Option 43 and Option 15

(Controller discovery like controller host name / IPv4
address)

l DNS Servers
l Domain Name

─ Enabled
on VLAN1

To configure the above parameter, navigate to the Configure > Network > VLAN tab and provide the
details as given below:
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To configure VLAN IPv4:

1. Select Edit checkbox to enable VLAN1 functionality.

2. Enable DHCP or Static IP mode of IPv4 address configuration from the Address checkbox.

3. Enable NAT checkbox.

4. Enable Zeroconf IP checkbox.

5. Enter DHCP Relay Agent parameter in the textbox.

6. Select DHCP Option 82 Circuit ID from the drop-down list.

7. Select DHCP Option 82 Remote ID from the drop-down list.

8. Enable Request Option All checkbox.

9. Click Save.

Figure 31: Configure: Network > VLAN > IPv4 parameters

MTU

cnPilot devices honour MTU advertised in DHCP Option 26. Below are the criteria for selecting MTU:

l By default, MTU is updated only if option 26 value is between 1500 – 1600 bytes.

l If user requires MTU less than 1500 bytes as advertised in option 26, enable MTU option as follows:

l E430-6E3A07(config)# interface vlan <VLAN ID>
E430-6E3A07(config-vlan-<VLAN ID>)# ip dhcp mtu
E430-6E3A07(config-vlan-<VLAN ID>)# save
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DHCP Client Options

cnPilot devices learn multiple DHCP options for all VLAN interfaces configured on the device. Based on
configured criteria, values of these options are used by the system. Below table lists the different DHCP
options.

Table 31: DHCP Options

Options Description Usage Reference
CLI

Option 1 The subnet mask option specifies the
client's subnet mask as per RFC 950.

Based on state of “Request
Option All”, device chooses
subnet mask from respective
VLAN interface.

show ip
route

Option 3 This option specifies a list of IP addresses
for routers on the client's subnet.

Based on state of “Request
Option All”, device chooses
route learnt from respective
VLAN interface. Only first route
is honored

show ip
route

Option 6 The domain name server option specifies
a list of Domain Name System (STD 13,
RFC 1035) name servers available to the
client. Servers SHOULD be listed in order
of preference.

Based on state of “Request
Option All”, device chooses
subnet mask from respective
VLAN interface. Top two DNS
servers are honored by cnPilot
device.

show ip
name-
server

Option 15 This option specifies the domain name
that client should use when resolving
hostnames via the Domain Name System.

More details are provided in
DHCP Option 15/24.

show ip
dhcp-client
info

Option 26 This option specifies MTU size in a
network.

More details are provided in
MTU.

show ip
dhcp-client
info

Option 28 This option specifies the broadcast
address that client should use

Broadcast address learnt for all
VLAN interfaces are used
respectively as per standards

show ip
dhcp-client-
info

Option 43 This option is used to help the AP in
obtaining cnMaestro IP address from the
DHCP server while DHCP request to get
an IP address is sent to the DHCP server.

More details are provided in IPv4
DHCP option 43

show ip
dhcp-client
info

Option 51 This option is used in a client request to
allow the client to request a lease time
for the IP address. In a server reply, a
DHCP server uses this option to specify
the lease time it is willing to offer.

cnPilot renew leases for all VLAN
interfaces configured based on
lease time that has been learned
from DHCP server.

show ip
dhcp-client
info

cnPilot/cnPilot_E_Series/4.2/UG/09 Configuration - Network/cnMaestro Onboarding.htm
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Options Description Usage Reference
CLI

Option 54 DHCP clients use the contents of the
'server identifier' field as the destination
address for any DHCP messages unicast
to the DHCP server.

cnPilot learns DHCP server IP for
all VLAN interfaces configured.

show ip
dhcp-client
info

Option 60 This option is used by DHCP clients to
optionally identify the vendor type and
configuration of a DHCP client.

For cnPilot device, value is
updated as Cambium-WiFi-AP.

show ip
dhcp-client
info

Routing & DNS

Table 32: Configure: Network > VLAN > Routing & DNS > IPv4 parameters

Parameters Description Range Default

Default
Gateway

Provision to configure default gateway. If this is provided, cnPilot
device installs this gateway as this is the highest priority.

─ ─

DNS Server Provision to configure Static DNS server on cnPilot device.
Maximum of two DNS servers can be configured.

─ ─

Domain
Name

Provision to configure Domain Name. If this is provided, cnPilot
device installs this Domain Name as this is highest priority.

─ ─

DNS Proxy cnPilot device can acts as DNS proxy server when this parameter
is enabled.

─ Disabled

To configure the above parameter, navigate to the Configure > Network > VLAN > Routing & DNS tab
and provide the details as given below:

1. Enter Default Gateway IPv4 address in the textbox.

2. Enter Domain Name in the textbox.

3. Enter primary domain server name in the DNS Server 1 textbox.

4. Enter secondary domain server name in the DNS Server 2 textbox.

5. Enable DNS Proxy checkbox.

6. Click Save
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Figure 32: Routing & DNS > IPv4 parameters

Routes

Table 33: Configure: Network > Routes> IPv4 parameters

Parameters Description Range Default

Gateway
Source
Precendence

Provision to prioritize default gateway and DNS servers when
cnPilot device has learnt from multiple ways. Default order is
Static, DHCP and PPPoE.

─ Static

Add Multiple
Route Entries

User has provision to configure static Routes. Parameters that are
required to configure static Routes are as follows:

l Destination IP

l Mask

l Gateway

─ ─

Port
Forwarding

This feature is required when wireless stations are behind NAT.
User can access the services hosted on wireless stations using
this feature. Following configurable parameters are required to
gain the access of services hosted on wireless stations which are
behind:

l Port

l IP Address

l Type

─ ─

To configure the above parameter, navigate to the Configure > Network > Routes tab and provide the
details as given below:

To configure Gateway Source Precedence:
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1. Select STATIC, DHCPC or PPPoE from the Gateway Source Precedence checkbox.

2. Click Save.

To configure Add Multiple Route Entries:

1. Enter Destination IP address in the textbox.

2. Enter Mask IPv4 address in the textbox.

3. Enter Gateway IPv4 address in the textbox.

4. Click Save.

To configure Port Forwarding:

1. Enter Port in the textbox.

2. Enter IP Address in the textbox.

3. Select Type from the drop-down list.

4. Click Save.
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Figure 33: Routes > IPv4 parameters
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IPv6 network parameters

VLAN

Table 34: Configure: Network > VLAN > IPv6 parameters

Parameters Description Range Default

Address Provision to configure mode of IPv6 address configuration for
an interface selected. Five modes are supported:

l Disabled

l AutoConfig

l Static

l Stateless DHCPv6

l Stateful DHCpv6

─ AutoConfig

Request
Option All

This configuration decides the interface on which cnPilot AP
will learn the following: 

l IPv6 default gateway 

l DHCP client options like Option 52 and Option 24
(Controller discovery like controller host name / IPv6
address)

l DNS Servers

l Domain Name

─ Enabled on
VLAN1

To configure the above parameter, navigate to the Configure > Network > VLAN tab and provide the
details as given below:

To configure VLAN IPv6:

1. Select required IPv6 address configuration from the Address drop-down list.

2. Enable Request Option All checkbox.

3. Click Save.
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Figure 34: Configure: Network > VLAN > IPv6 parameters

Routing & DNS

Table 35: Configure: Network > VLAN > Routing & DNS > IPv6 parameters

Parameters Description Range Default

Default
Gateway

Provision to configure default gateway. If this is provided, cnPilot
device installs this gateway as this is the highest priority.

─ ─

DNS Server Provision to configure Static DNS server on cnPilot device.
Maximum of two DNS servers can be configured.

─ ─

Domain
Name

Provision to configure Domain Name. If this is provided, cnPilot
device installs this Domain Name as this is highest priority.

─ ─

IPv6
Preference

When enabled, IPv6 is preferred over IPv4 bases on DNS
response.

─ Disabled

To configure the above parameter, navigate to the Configure > Network > Routing & DNS tab and
provide the details as given below:

1. Enter Default Gateway IPv6 address in the textbox.

2. Enter primary domain server name in the DNS Server 1 textbox.

3. Enter secondary domain server name in the DNS Server 2 textbox.

4. Enter Domain Name in the textbox.

5. Enable IPv6 Preference checkbox.

6. Click Save.
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Figure 35: Routing & DNS > IPv6 parameters

Routes

Table 36: Configure: Network > Routes> IPv6 parameters

Parameters Description Range Default

Gateway
Source
Precendence

Provision to prioritize default gateway and DNS servers when
cnPilot device has learnt from multiple ways. Default order is
Static and AUTO-CONFIG/DHCPC.

─ Static

Add Multiple
Route Entries

User has provision to configure static Routes. Parameters that are
required to configure static Routes are as follows:

l Destination IP/prefix

l Gateway

─ ─

To configure the above parameter, navigate to the Configure > Network > Routes tab and provide the
details as given below:

To configure Gateway Source Precedence:

1. Select STATIC or AUTO-CONFIG/DHCPC from the Gateway Source Precedence checkbox.

2. Click Save.

To configure Add Multiple Route Entries:

1. Enter Destination IP/prefix address in the textbox.

2. Enter Gateway IPv6 address in the textbox.

3. Click Save.



Chapter 9: Configuration - Network 103

Figure 36: Figure 39 Routes > IPv6 parameters
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General network parameters
Table 37: Configure: Network > VLAN > General parameters

Parameters Description Range Default

Management
Access

Provision to restrict the access of device in all modes CLI
(Telnet, SSH), GUI (HTTP, HTTPs) and SNMP. User can
configure restriction of device access as follows:

n Block

n Allow from Wired

n Allow from both wired and wireless 

─ Allow from
both Wired
and Wireless

Select Management Access to configure restriction of device from the drop-down list.

Figure 37: Configure: Network > VLAN > General parameters

Ethernet Ports
Table 38: Configure: Network > Ethernet Ports parameters

Parameters Description Range Default

Ethernet cnPilot devices Ethernet port is provisioned to
operate in following modes:

1. Access Single VLAN

Single VLAN traffic is allowed in this mode.

2. Trunk Multiple VLANs

Multiple VLANs are supported in this mode.

3. Tunnel Mode

Provision to enable L2GRE tunnel. It is
applicable only for Ethernet 2/3/4 ports of the
cnPilot devices based on model number.

- Access
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Parameters Description Range Default

Port Speed Provision to configure ethernet link speed.

l Auto

l 10 Mbps

l 100 Mbps

l 1000 Mbps

- Auto

Port Duplex Provision to configure ethernet link duplex settings. Half Duplex/

Full Duplex

Full Duplex

MAC Authentication

MAC
Authentication

Provision to configure MAC Authentication. - -

MAC Auth
Failed

Enabling this will allow traffic to pass on native VLAN
when MAC Auth is rejected by RADIUS server.

- -

MAC
Authentication
Policy

Provision to set MAC ACL policy from external
RADIUS server.

l Delimiter: Only colon (:) and hyphen (-) are
accepted

l Upper-Case: MAC address sent in upper case
only

- -

Radius Server

Authentication
Server

Provision to configure RADIUS Authentication server
details such as Hostname/IPv4/IPv6, Shared Secret,
Port Number and Realm. Maximum of three RADIUS
server can be configured.

- Disabled

Accounting
Server

Provision to configure Accounting server details such
as Hostname/IPv4/IPv6, Shared Secret, Port Number.
Maximum of three RADIUS server can be configured.

- Disabled

Timeout Wait time period for response from AAA server. 1-30 3

Attempts Parameter to configure number of attempts that a
device should send AAA request to server if no
response is received within configured timeout
period.

1-3 1

Accounting
Mode

This field is enabled based on customer requirement.
Accounting packet is transmitted based on mode
selected.

1. Start-Stop

- None
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Parameters Description Range Default

Accounting packets are transmitted by
AP to AAA server when a wireless
station is connected and then
disconnects.

2. Start-Interim-Stop

Accounting packets are transmitted by
AP to AAA server when a wireless
station connects and then at regular
intervals of configured Interim Update
Interval and then when it disconnects.

3. None

Accounting mode will be disable.

Server Pool
Mode

User can configure multiple Authorization and
Accounting servers. Based on number of wireless
stations, user can choose either Failover or Load
Balance mode.

1. Load Balance

AP communicates with multiple servers and
ensures that authorization and accounting are
equally shared across configured servers.

2. Failover

AP selects the RADIUS server which is up and
running based on the order of configuration.

- Load
Balance

NAS Identifier This is configurable parameter and is appended in
RADIUS request packet.

1. AP-ETH0-MAC

NAS identifier attribute will be ETH0 MAC
address

2. AP-HOSTNAME

NAS identifier attribute will be AP hostname

3. Custom:

Any custom value

- Hostname/
System
Name

NAS IP NAS-IP attribute for use in RADIUS request packets.
Default is set to device IP and option to configure
custom IP address with the option Custom.

- AP-IP

Called Station ID Following information can be communicated to
RADIUS server:
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Parameters Description Range Default

l AP-MAC
l AP-MAC: SITE-NAME
l AP-NAME
l AP-NAME: SITE-NAME
l SITE-NAME
l CUSTOM

Interim Update
Interval

This field is used when RADIUS accounting is
enabled, and mode selected as Start-Interim-Stop.

10-65535 1800

Dynamic
Authorization

This option is required, where there is a CoA requests
from AAA/RADIUS server.

─ Disabled

ACL

Precedence Provision to configure index of ACL rule. Packets are
validated and processed based on precedence value
configured.

1-256 1

Policy Provision to configure whether to permit or deny
traffic.

Deny/Permit Deny

Direction Provision to apply the ACLs rules configured either in
any direction or specific direction.

─ In

Type cnPilot devices support three layers of ACLs. A rule
can be configured as below:

l IP

l IPv6

l MAC

l Proto

l Protov6

─ IP

Source IP/Mask This option is available when ACL type is configured
to an IP address. This field helps user to configure if
rule needs to be applied for a single IP address or
range of IP addresses.

─ ─

Destination
IP/Mask

This option is available when ACL type is configured
to an IP address. This field helps user to configure if
rule needs to be applied for a single IP address or
range of IP addresses.

─ ─

Source
MAC/Mask

This option is available when ACL type is configured
to a MAC address. This field helps user to configure if
rule needs to be applied for a single device MAC
address or range of MAC addresses.

─ ─
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Parameters Description Range Default

Destination
MAC/Mask

This option is available when ACL type is configured
to MAC address. This field helps user to configure if
rule needs to be applied for a single device MAC
address or range of MAC addresses.

─ ─

Protocol This option is available when user selects ACL type as
proto. User can select following protocols:

l TCP

l UDP

l ICMP

l Any

─ TCP

Source Port Provision to apply ACL with combination of protocol
and port. 

─ ─

Destination Port Provision to apply ACL with combination of protocol
and port. 

─ ─

Description To make administrator easy to understand, a text
string can be added for each ACL rule.

─ ─

To configure the above parameter, navigate to the Configure > Network > Ethernet Ports tab and provide
the details as given below:

1. Select Access Single VLAN or Trunk Multiple VLANs from the ETH1 drop-down list.

2. Enter Access Mode in the textbox.

3. Select Port Speed from the drop-down list.

4. Select Port Duplex from the drop-down list.

5. Click Save.

To Configure MAC Authentication:

1. Enable MAC Authentication checkbox

2. Click Save.

To configure Radius Server:

1. Enter the RADIUS Authentication server details such as Hostname/Shared Secret/Port Number/
Realm in the Authentication Server 1 textbox.

2. Enter the time in seconds of each request attempt in Timeout textbox. 3. Enter the number of
attempts before a request is given up in the Attempts textbox.

3. Enter the number of attempts before a request is given up in the Attempts textbox.

4. Select the configuring Accounting Mode from the drop-down list.

5. Enable Load Balance/Failover in the Server Pool Mode checkbox.

6. Enter the Interim Update Interval parameter value in the textbox. 7. Enable Dynamic Authorization
checkbox to configure dynamic authorization for wireless clients.

7. Enable Dynamic Authorization checkbox to configure dynamic authorization for wireless clients

8. Click Save.
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To configure ACL:

1. Select Precedence from the drop-down list.

2. Select type of Policy from the drop-down list.

3. Select Direction from the drop-down list.

4. Select Type from the drop-down list.

5. Enter IP address of source in the Source IP/Mask textbox.

6. Enter IP address of destination in the Destination IP/Mask textbox.

7. Enter Description in the textbox.

8. Click Save.
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Figure 38: Configure: Network > Ethernet Ports parameters
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Security
Table 39: Configure: Network > Security parameters

Parameters Description Range Default

DoS
Protection

cnPilot devices has inbuilt capability of detecting DoS attacks on
wired network. Following are the attacks that are detected by
cnPilot devices:

l IP Spoof

l Smurf Attack

l IP Spoof Log

l ICMP Fragment

─ Disabled

Rogue AP

Detection cnPilot devices in association with cnMaestro has capability of
detecting Rogue APs. On enabling this all neighbor information is
shared to cnMaestro and reports Rogue APs in the networks.

─ Disabled

To configure the above parameter, navigate to the Configure > Network > Security tab and provide the
details as given below:

1. Select any of the following from DoS Protection checkbox

l IP Spoof
l Smurf Attack
l IP Spoof Log

l ICMP Fragment

2. Enable Detection checkbox.

3. Click Save.

Figure 39: Configure: Network > Security parameters
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DHCP
Table 40: Configure: Network > DHCP parameters

Parameters Description Range Default

Edit Provision to select DHCP Pool if multiple Pools are defined on
cnPilot device.

─ ─

Address
Range

User can configure start and end addresses for a DHCP Pool
selected from the drop-down box.

─ ─

Default
Router

Provision to configure next hop for a DHCP pool selected from
drop-down box.

─ ─

Domain
Name

Provision to configure domain name for a DHCP pool selected from
drop-down box.

─ ─

DNS
Address

Provision to configure DNS server for a DHCP pool selected from
drop-down box.

─ ─

Network Provision to configure Network ID for a DHCP pool selected from
drop-down box.

─ ─

Lease Provision to configure lease for a DHCP pool selected from drop-
down box.

─ ─

Add Bind List

For every DHCP pool configured, user can bind MAC and IP from
the address pool defined, so that wireless station gets same IP
address every time they connect. Following parameters are
required to bind IP address:

l MAC Address

l IP Address

─ ─

To configure the above parameter, navigate to the Configure > Network > DHCP tab and provide the
details as given below:

1. Select DHCP pool from the Edit drop-down list.

2. Enter start and end IP addresses for a DHCP Pool selected from the Address Range textbox.

3. Enter Default Router IP address in the textbox.

4. Enter Domain Name for a DHCP pool selected in the textbox.

5. Enter DNS Address for a DHCP pool selected in the textbox.

6. Enter Network ID for a DHCP pool selected in the textbox.

7. Enter Lease for a DHCP pool selected in the textbox.

8. Click Save.

To configure Add Bind List:
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1. Enter MAC Address for a DHCP pool selected in the textbox.

2. Enter IP Address for a DHCP pool selected in the textbox.

3. Click Save.

Figure 40: Configure: Network > DHCP parameters

Tunnel
Table 41: Configure: Network > Tunnel parameters

Parameters Description Range Default

Tunnel
Encapsulation

Provision to enable tunnel type. Following tunnel types are
supported by cnPilot devices:

l L2TP

l L2GRE

l OFF

─ OFF

L2TP
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Parameters Description Range Default

Remote Host Configure L2TP end point. Either IP or hostname of endpoint is
supported.

─ ─

Authentication
Info

Provision to configure credentials required for L2TP
authentication.

─ ─

Auth Type Provision to select the PPP authentication method. Following
are the options available:

l DEFAULT

l CHAP

l MS-CHAP

l MS-CHAP v2

l PAP

─ Default

TCP MSS Provision to configure TCP Maximum Segment Size. 422-
1410

1400

PMTU Discovery Provision to enable to discover PMTU in network. ─ Enabled

L2GRE

Remote Host Configure L2GRE end point. Either IPv4/IPv6 address or
hostname of endpoint is supported.

─ ─

DSCP User can configure priority of GRE packets. ─ 0

TCP MSS Provision to configure TCP MSS value. 472-
1460

1402

PMTU Discovery Provision to enable to discover PMTU in network. ─ Enabled

MTU Maximum Transmission Unit. 850-
1460

1460

Cambium GRE It’s a proprietary GRE protocol designed using RFC 8086 to
establish tunnel between cnMaestro c4000 Controller and
cnPilot devices.

- Disabled

GRE in UDP GRE protocol designed to establish tunnel between any third-
party vendor which complies RFC 8086.

- Disabled

To configure the above parameter, navigate to the Configure > Network > Tunnel tab and provide the
details as given below:

1. Select Tunnel type from the Tunnel Encapsulation drop-down list.

To configure L2TP:

2. Enter IP address or domain name in the Remote Host textbox.

3. Enter credentials required for L2TP authentication in the Authentication Info textbox.

4. Select authentication type from the Auth Type drop-down list.
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5. Enter TCP Maximum Segment Size in the TCP MSS textbox.

6. Enable PMTU Discovery checkbox.

7. Enter Maximum Transmission Unit in the MTU textbox.

8. Click Save.

To configure L2GRE:

9. Enter IP address or domain name in the Remote Host textbox.

10. Enter DSCP in the textbox.

11. Enter TCP Maximum Segment Size in the TCP MSS textbox.

12. Enable PMTU Discovery checkbox.

13. Enter Maximum Transmission Unit in the MTU textbox.

14. Enable Cambium GRE checkbox.

15. Enable GRE in UDP checkbox.

16. Click Save.
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Figure 41: Configure: Network > Tunnel parameters

PPPoE
Table 42: Configure: Network > PPPoE parameters

Parameters Description Range Default

Enable Provision to enable PPPoE client. ─ Disable

VLAN User can configure VLAN ID where PPPoE client should
obtain IP address.

─ ─

Service Name Configure PPPoE service name ─ ─

Authentication
Info

Provision to configure credentials required for PPPoE
authentication.

─ ─

MTU Maximum Transmission Unit. 500-
1492

1430
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Parameters Description Range Default

TCP MSS
Clamping

Configure PPPoE end point. Either IP or hostname of
endpoint is supported.

─ Enabled

Management
Access

If enabled, user can access device either using UI or SSH with
PPPoE IP.

─ Disabled

To configure the above parameter, navigate to the Configure > Network > PPPoE tab and provide the
details as given below:

1. Select Enable checkbox to enable PPPoE functionality.

2. Enter the VLAN ID assigned to the PPPoE in the VLAN textbox.

3. Enter Service Name in the textbox.

4. Enter the username and password for the device in the Authentication Info textbox.

5. Enter the MTU value PPPoE connection in the MTU textbox.

6. Enable the TCP MSS clamping for the PPPoE connection.

7. Enable Management Access.

8. Click Save.

Figure 42: Configure: Network > PPPoE parameters
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VLAN Pool
Table 43: Configure: Network > VLAN Pool parameters

Parameters Description Range Default

Enable Provision to enable PPPoE client. ─ Disable

VLAN User can configure VLAN ID where PPPoE client should obtain
IP address.

─ ─

Service Name Configure PPPoE service name ─ ─

Authentication
Info

Provision to configure credentials required for PPPoE
authentication.

─ ─

MTU Maximum Transmission Unit. 500-
1492

1430

TCP MSS
Clamping

Configure PPPoE end point. Either IP or hostname of endpoint
is supported.

─ Enabled

Management
Access

If enabled, user can access device either using UI or SSH with
PPPoE IP.

─ Enabled

To configure the above parameter, navigate to the Configure > Network > VLAN Pool tab and provide
the details as given below:

1. Enter the name of the VLAN pool in the VLAN Pool Name textbox.

2. Enter the VLAN ID in the VLAN ID List textbox.

3. Click Save.

Figure 43: Configure: Network > VLAN Pool parameters
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WWAN
Note

This feature is supported in cnPilot e600 platform only.

Table 44: Configure: Network > WWAN

Parameters Description Range Default

WWAN Provision to enable wireless WAN using a USB cellular
dongle for internet access.

─ ─

Failover Only Failover only can be configured in two modes:

l Checked:

Ethernet will be the primary connection and WWAN
will be backup.

l Unchecked. 

3G/4G (WWAN) will be the only working
connection.

Note: Cellular link can be configured as backup only to
Ethernet connection.

Checked/

Unchecked

─

APN Provision to configure network provider APN address. ─ ─

Authentication Provision to configure credentials required for WWAN
authentication.

─ ─

Monitor Host Running a check in the background that constantly
monitors a user configured IP address (Ex: 8.8.8.8) for
reachability through ping.

IPv4 address ─

To configure the above parameter, navigate to the Configure > Network > WWAN tab and provide the
details as given below:

1. 1. Enable WWAN checkbox to enable this functionality.

2. Check/Uncheck Failover Only to enable/disable.

3. Enter the APN address in the textbox.

4. Enter the Authentication credentials.

5. Enter any IPv4 address to monitor.

6. Click Save.
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Figure 44: Configure: Network > WWAN parameters
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Chapter 10: Configuration - Services
This chapter describes the following topics:

l Overview

l Configuring Services

Overview
This chapter gives an overview of cnPilot configurable parameters related to LDAP, NAT Logging,
Location API, Speed Test and DHCP Option 82. 

Configuring Services
This section provides information on how to configure the following services on cnPilot AP.

l LDAP

l APIs

l Location API

l Speed Test

l DHCP Option 82

LDAP
Table 45 lists the fields that are displayed in the Configuration > Services > LDAP tab:

Table 45: Configure: Services > LDAP parameters

Parameters Description Range Default

Server Host Provision to configure IP/Hostname of LDAP server. ─ ─

Server Port Provision to configure custom port number for LDAP services. ─ ─

To configure the above parameter, navigate to the Configure > Services > LDAP tab and provide the
details as given below:

1. Enter the IP address of the LDAP server in the Server Host textbox.

2. Enter the Port address of the LDAP server in the Server Port textbox.

3. Click Save.
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Figure 45: Configure: Services > LDAP parameters

APIs
cnPilot devices does support APIs w.r.t to Wi-Fi client presence, NAT information and BT client presence.

NAT Logging
NAT logging is same as the internet access log that is generated when NAT is enabled on AP. Each
internet access log PDU consists of one or more internet access log data in TLV format. The packet
format for the internet access log PDU is defined as below:

Table 46: PDU type code: 0x82

Type Mandatory Length Default Value

0x01 N 32 Bytes Includes IPv4 internet access log data structure.

Type 0x01 TLV includes the internet access log data structure as below:

Table 47: NAT Lo`gging Packet Structure

Length Description

4 Bytes NAT records UNIX time stamp which generates time in seconds from 1970-01-01 (00:00:00
GMT until now).

6 Bytes The MAC address of the client.

1 Bytes Reserved for future use.

1 Bytes The protocol type. The supported protocol types are:

l 0x06 TCP

l 0x11 UDP

2 Bytes The VLAN ID where the client is connected. If there is no VLAN ID, the value will be 0.

4 Bytes The client internal or the private IP address.

2 Bytes The internal port of the client.

4 Bytes The Internet IP address which is translated by NAT.

2 Bytes The Internet port which is translated by NAT.

4 Bytes The IP address of the visited server.

2 Bytes The port address of the visited server.

Table 48 lists the fields that are displayed in Configuration > Services > NAT Logging tab:
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Table 48: Configure: Services > NAT Logging parameters

Parameters Description Range Default

Enable Provision to enable/disable NAT logging services. ─ ─

Server IP Provision to configure IP/Hostname of NAT logging server. ─ ─

Server Port Provision to configure custom port number for NAT Logging
services.

─ ─

Interval Provision to configure frequency of logging. 5-3600 ─

To configure the above parameter, navigate to the Configure > Services > NAT Logging tab and provide
the details as given below:

1. Select the Enable checkbox to enable NAT Logging.

2. Enter the IP address of the server for NAT Logging in the Server IP textbox.

3. Enter the IP address of the server port for NAT Logging in the Server Port textbox.

4. Enter the interval for NAT Logging in the Interval textbox.

5. Click Save.

Figure 46: Configure: Services > NAT Logging parameters

Location API
Location API is a method to send the discovered (Probed) clients list to a specified server address. The
reports are sent as HTTP Post to the HTTP server every interval. The discovered client entries are deleted
from the list if the entry is aged out. The client aging timeout is 2 times of location API interval
configured. If there are no new probe requests from the client within 2xlocation API interval time, then
the client entry will be removed from the list.

Table 49 lists the fields that are displayed in Configuration > Services > Location API tab:

Table 49: Configure: Services > Location API parameters

Parameters Description Range Default

Enable Provision to enable/disable Location API services. ─ ─

Server Provision to configure HTTP/HTTPs server to send report with
the pot number.

0-
65535

─
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Parameters Description Range Default

Interval Provision to configure custom frequency of information to be
shared to server.

2-3600 ─

MAC
Anonymization

Provision to detect fake clients and avoid populating it in
Location API client list.

─ ─

To configure the above parameter, navigate to the Configure > Services > Location API tab and provide
the details as given below:

1. Select the Enable checkbox to enable Location API.

2. Enter the HTTP/HTTPs server and port number in the Server textbox.

3. Enter the interval for Location API in the Interval textbox.

4. Enable MAC Anonymization checkbox.

5. Click Save.

Figure 47: Configure: Services > Location API parameters

Note

For further details about this feature and sample reference output, go to
https://support.cambiumnetworks.com/files/cnpilot-tech-ref/ and download
Wireless client Presence and Locationing API document.

BT Location API

Bluetooth Scanning

cnPilot Aps with an integrated Bluetooth Low Energy (BLE) radio can detect and locate nearby
Bluetooth Low Energy devices. This data is then provided via API to third-party applications. Examples of
such devices include smartwatches, battery-based beacons, Apple iBeacons, fitness monitors, and
remote sensors.

Organization can create use cases for indoor wayfinding and mapping, asset tracking, and more.

Table 50 lists the fields that are required for configuring BT Location API.

https://support.cambiumnetworks.com/files/cnpilot-tech-ref/
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Table 50: Configuring BT Location API parameters

Parameters Description Range Default

Location-bt-api
server

Provision to configure details of destined API server. - -

Location-bt-api
interval

Provision to configure the interval at which the BT
information is updated to destined API server.

2-3600 2

Ignore-
anonymized-bt-
mac

Ignore client BT addresses that are anonymized. - -

Sending Report

After enabling BLE Scanning on AP it will start processing:

1. Convert the scanned data to a JSON array

2. Send that data in one single HTTP/HTTPS POST

In the CLI

To configuring the BT Location-API:

To disable the BT Location-API:

BT Location API data elements

Table 51: BT Location API data elements

Parameters Description

apMac MAC address of the observing AP.

API Version API Version applied for particular data format.

AP Name Host name of the observing AP.

Timestamp Observation time in seconds seen by AP.

BT MAC BLE device MAC seen by AP.

UUID BLE device UUID seen by AP.

RSSI BLE device RSSI as seen by AP.
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HTTP POST Body Format:

{

u’ap_mac’: ‘00-04-56-A5-5A-EC’,

‘version’: ‘2.2’,

‘ap_name’: ‘E600-A55AEC’,

‘ble_discoverd_clients’:{Array of 0-250 devices}

}

Bluetooth API Data Format

{

bt_rssi’: u’ -80 dBm ‘,

bt_mac’: 14-8F-21-FD-37-18’, u

‘bt_uuids’: Garmin International, Inc. (0xfe1f)\n’,

‘bt_timestamp’: u’ 1.811127’

}

Speed Test
Wifiperf is a speed test service available on cnPilot devices. This tool is interoperable with open source
zapwireless tool (https://code.google.com/archive/p/zapwireless/)

The wifiperf speed test can be triggered by using zapwireless tool between two cnPilot Aps or between
cnPilot AP and with other third-party devices (or PC) that is having zapwireless endpoint running.

Refer https://code.google.com/archive/p/zapwireless/ to download the zapwireless tool to generate
zapwireless endpoint for third party device (or PC) and zap CLI to perform the test.

In this case, wifiperf endpoint should be enabled in cnPillot AP through UI shown below.

Below table lists the fields that are displayed in the Configuration > Services > Speed Test tab:

Table 52: Configure: Services > Speed Test parameters

Parameters Description Range Default

wifiperf Provision to enable wifiperf functionality. ─ Disabled

To configure the above parameter, navigate to the Configure > Services > Speed Test tab. Select Wifiperf
checkbox to enable this functionality.

Figure 48: Configure: Services > Speed Test parameters

https://code.google.com/archive/p/zapwireless/
https://code.google.com/archive/p/zapwireless/
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DHCP Option 82
Global parameter to configure DHCP Option 82 parameters that will be appended to DHCP packets when
a device is connected either from wireless or wired to a cnPilot device. This parameter is given first
precedence and overwrites any configuration defined in VLAN or WLAN profiles.

Table 53 lists the fields that are displayed in the Configuration > Services > DHCP Option 82 tab:

Table 53: Configure: Services > DHCP Option 82 parameters

Parameters Description Range Default

Enable Provision to enable/disable DHCP Option 82 as global services. ─ ─

Option 82
Circuit ID

When enabled, DHCP packets generated from wireless stations
that are associated to APs are appended with Option 82
parameters. Option 82 provides provision to append Circuit ID and
Remote ID. Following parameters can be selected in both Circuit ID
and Remote ID:

n None

n All

n Hostname

n APMAC

n SSID

n VLAN ID

n SITEID

n Custom

─ None

Option 82
Remote ID

When enabled, DHCP packets generated from wireless stations
that are associated to APs are appended with Option 82
parameters. Option 82 provides provision to append Circuit ID and
Remote ID. Following parameters can be selected in both Circuit ID
and Remote ID:

n None

n Hostname

n APMAC

n SSID

n VLAN ID

n SITEID

n Custom

n All

─ None
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Parameters Description Range Default

VLAN ID User can configure VLAN IDs where DHCP Option 82 must be
enabled.

1-4094 ─

To configure the above parameter, navigate to the Configure > Services tab and select DHCP Option 82
tab and provide the details as given below:

1. Select the Enable checkbox to enable DHCP Option 82.

2. Select Option 82 Circuit ID to enable DHCP Option-82 circuit ID information from the drop-down
list.

3. Select Option 82 Remote ID to enable DHCP Option-82 remote ID information from the drop-
down list.

4. Enter VLAN ID parameter to configure VLAN to have DHCP Option 82.

5. Click Save.

Figure 49: Configure: Services > DHCP Option 82 parameters
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Chapter 11: Operations
This chapter describes the following topics:

l Overview

l Firmware update

l System

l Configuration

Overview
This chapter gives an overview of cnPilot administrative functionalities such as Firmware update, System
and Configuration.

Firmware update
The running software on the cnPilot Enterprise AP can be upgraded to newer firmware. When upgrading
from the UI the user can upload the firmware file from the browser. The same process can be followed to
downgrade the AP to a previous firmware version if required. Configuration is maintained across the
firmware upgrade process.

Note

Once a firmware upgrade has been initiated, the AP should not be rebooted or
power cycled until the process completes, as this might leave the AP inoperable.

Table 54lists the fields that are displayed in the Operations > Firmware update tab:

Table 54: Configure: Operations > Firmware update parameters

Parameters Description Range Default

Choose File Provisions to select upgrade file. ─ ─

Upgrade Firmware Provision to initiate upgrade once file is selected. ─ ─

To configure the above parameter, navigate to Operations > Firmware update tab and provide the details
as given below:

1. Click Choose File and select the downloaded image file to upgrade the firmware manually.

2. Click Upgrade Firmware and select the downloaded image file to upgrade the firmware
automatically.

You can view the status of upgrade in the Upgrade Status field.
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Table 55: Configure: Operations > Firmware update parameters

System
This section provides multiple troubleshooting tools provided by cnPilot Enterprises.

Table 56 lists the fields that are displayed in the Operations > System tab:

Table 56: Configure: Operations > System parameters

Parameters Description Range Default

Reboot User will be prompted with Reboot pop-up requesting for reboot. If
Yes, device will go for reboot.

─ ─

Download
Tech
Support

User will be prompted with permission to download tech-support
from AP. If yes, file will be saved in your default download path
configured on your system.

─ ─

Disconnect
All Clients

All clients connected to both the radios will be terminated by
sending de-authentication packet to each client connected to
radios.

─ ─

Flash LEDs LEDs on the device will toggle for configured time period. 1-120 10

Factory
Default

A pop-up window appears requesting confirmation for factory
defaults. If yes, device will delete all configuration to factory reset
and reboots.

─ ─

To configure the above parameter, navigate to Operations > System tab and provide the details as given
below:

1. Click Reboot for rebooting the device.

2. Click Download Tech Support to generate a techsupport from the device and save it locally.

3. Click Disconnect All Clients to disconnect all wireless clients.

4. Select Flash LEDs value from the drop-down list to flash LEDs for the given duration of time.

5. Click Factory Default to delete all configuration on the device.



Chapter 11: Operations 131

Figure 50: Configure: Operations > System parameters

Configuration
The device configuration can either be exported from the device as a text file or imported into the device
from a previous backup. Ensure that when a configuration file is imported onto the device, a reboot is
necessary to activate that new configuration.

Table 57 lists the fields that are displayed in the Operations > Configuration tab:

Table 57: Configure: Operations > Configuration parameters

Parameters Description Range Default

Export Provision to export configuration of device to default download
path configured on system.

─ ─

Import Provision to import configuration of device. ─ ─

To configure the above parameter, navigate to Operations > Configuration tab and provide the details as
given below:

1. Click Export to export device configuration and save locally to the device.

2. Click Import to import device configuration to the device.

Figure 51: Configure: Operations > Configuration parameters
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Chapter 12: Troubleshoot
This section provides detailed information about troubleshooting methods supported by cnPilot
enterprise devices. Troubleshooting methods supported by cnPilot devices are categorized as below:

l Logging

o Events
o Debug Logs

l Radio Frequency

o Wi-Fi Analyzer
o Spectrum Analyzer
o Unconnected Clients

l Packet Capture

l Performance

o Wi-Fi Perf Speed Test
o Connectivity

Logging
cnPilot devices supports multi-level logging, which will ease to debug issues.

Events
cnPilot devices generates events that are necessary for troubleshooting across various modules. Below is
the list of modules, cnPilot device generates events for troubleshooting.

l Wireless station

o Connectivity

l Configuration updates

l LDAP

o Authentication

l RADIUS

o Authentication
o Accounting
o CoA

l Mesh

l Roaming

o Enhanced roaming

l Auto-RF

o Channel change
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l Tunnel state

l Reboot

l Guest Access

l Autopilot

Events are available at Troubleshoot > Logs > Events.

Figure 52: Troubleshoot > Logs > Events

Debug Logs
cnPilot provisions enhanced debugging of each module as events generated by system and scope of
debugging is limited. Debug logs can be triggered when user click Start Logs and can be terminated
when clicked on Stop Logs. By default, debug logs auto terminate after 1 minute when clicked on Start
Logs.   

Debug logs are available at Troubleshoot > Logs > Debug Logs.

Figure 53: Troubleshoot > Logs > Debug Logs
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Radio Frequency

Wi-Fi Analyzer
This tool provisions customer to scan the channels supported as per regulatory domain and provides
information related to AP’s presence in each channel. Wi-Fi analyzer graphs are available in two modes:

l Interference

This tool shares more information of each channel as below:

l Noise

l Interference measured in RSSI

l List of top 64 neighbor APs

l Number of APs

This tool shares more information of each channel as below:

l Noise

l Number of neighbor APs

l List of top 64 neighbor APs

Channel analyzer is available at Troubleshoot > Wi-Fi Analyzer > Interference Mode.

Figure 54: Figure 58 Troubleshoot > Wi-Fi Analyzer > Interference Mode

Channel analyzer is available at Troubleshoot > Wi-Fi Analyzer > Number of APs Mode:
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Figure 55: Troubleshoot > Wi-Fi Analyzer > Number of APs Mode

Spectrum analyzer
Due to heavy commercialization of Wi-Fi devices and wide range of non-Wi-Fi devices operating in the
ISM band, interference in the ISM bands is unavoidable and imminent. The Wi-Fi performance can quickly
degrade with the presence of these wide range of devices in the vicinity. The Wi-Fi network deployment
is in need of more robust tools for RF spectrum analysis for determining potential Wi-Fi (and non-Wi-Fi)
interferers for efficient planning of the network deployment.

Given the wide range deployment of high capacity Wi-Fi networks, it is inevitable that the devices come
ready with automatic interference detection and mitigation. The spectral scan feature on cnPilot is the
first step towards achieving the same.

Spectral analyzer is triggered on demand. Following options are required to trigger spectrum analyzer:

l Band

This feature is available on both 2.4GHz and 5GHz. At an instance, any one band can be selected

l Continuous scan

If user is looking for continuous scan until stopped, this field has to be enabled.

l Scanning

Option to start and stop the scan process.

Spectrum analyzer is available at Troubleshoot > Spectrum Analyzer.
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Figure 56: Troubleshoot > Spectrum Analyzer

Unconnected clients
Unconnected clients provides a list of clients that could not connect properly due to various reasons with
the Aps. Currently the following failures are tracked:

l Invalid pre-shared key

l EAP authentication failure

l Denied due to MAC ACL

l Client disconnected by enhanced-roaming
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Figure 57: Unconnected clients

Packet capture
Allows the administrator to capture all packets on a specified interface. A decode of the packet
indicating the network addresses, protocol types etc is displayed. The administrator can filter the packets
being captured by specifying a particular MAC address, IP address, port number etc. The number of
packets that are captured can also be capped, so the console or system is not overwhelmed. Packets
captured on the ETH interfaces are packets that are being transmitted or received on the physical
interface of the device.

cnPilot device allows packet capture on following interfaces:

l WLAN

l Ethernet

l VLAN

l SSID

Multiple options of filtering are provided and is available Troubleshoot > Packet Capture page:
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Figure 58: Troubleshoot > Packet Capture page

Performance

Wi-Fi Perf speed test
The Wi-Fi Perf Speed Test feature helps to measure the bandwidth from AP to an end point. You can
measure both TCP and UDP with variable payloads. To configure this feature:

1. Navigate to Troubleshoot > Wi-Fi Perf Speed Test page in the UI.

2. Provide the following details:

l Select the Duration from the Duration drop-down list.
l Select the Protocol as UDP or TCP.
l Enter the length of the payload in the Payload Length textbox.
l Enter the IP of the payload length in the Wi-FiPerf Endpoint textbox.
l Select Downlink or Uplink Radio button.

3. Click on Start Test.
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Figure 59: Figure 63 Troubleshoot > Wi-Fi Perf Speed Test

Speedtest on Access Point
Speedtest can be used to measure speed across the WAN to Cambium hosted servers. The CLI output
displays uplink and downlink speed in Mbps. You can also host your own server in your data center and
measure bandwidth to it using ETSI option and specifying the URL. The server software can be obtained
from the LibreSpeed project https://github.com/librespeed/speedtest.

Configuration:

Syntax:

Example 1:

Example 2:
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Note

Cambium hosted server is chosen automatically

Connectivity

IPv4

This tool helps to check the accessibility of remote hosts from cnPilot device. Three types of tools are
supported under this category:

l Ping

l DNS Lookup

l Traceroute

Table 58: Troubleshoot: Connectivity

Parameters Description Range Default

Verbose  Provision to display the output of traceroute. - On

Traceroute
Result

Displays the output of traceroute command. - -

Traceroute

Trace Method  Provision to configure payload mechanism to check the
reachability of destined IPv4Hostname.

- ICMP
Echo

Ping Result Displays the ICMP results. - -

Ping

Number of
Packets 

Provide number of request packets that are required to be
transmitted to validate the reachability of destined Host.

1-10 3

IP Address or
Hostname 

Provide IPv4 address or Hostname to validate the reachability
of the destined Host.

- -

IP Address or
Hostname 

Provide IPv4 address or Hostname to validate the reachability
of the destined Host.

- -

Host Name Provide Hostname whose IP must be resolved. - -

Fragmentation Provision to allow or deny fragment packets. - Off

DNS Test Result Displays the IP’s that are associated with configured Hostname. - -

DNS Lookup

Display TTL Provision to customize TTL display. - On

Buffer Size Configure ICMP packet size. 1-65507 56

To configure the above parameter, navigate to the Troubleshoot > Connectivity tab and provide the
details as given below:

To configure Ping:
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1. Select Test type from the drop-down list.

2. Enter IP address or Hostname in the textbox.

3. Enter the Number of packets in the textbox.

4. Select Buffer Size value from the drop-down list.

5. Start Ping.

To configure DNS Lookup:

1. Enter the Hostname in the textbox.

2. Click DNS Test.

To configure Traceroute:

1. Enter IP address or Hostname in the textbox.

2. Click Fragmentation to ON/Off.

3. Select Trace Method to either ICMP Echo/UDP.

4. Click Display TTL to ON/Off.

5. Click Verbose to ON/Off.

6. Click Start Traceroute.
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Figure 60: Troubleshoot > Connectivity > Ping

Figure 61: Troubleshoot > Connectivity > DNS Lookup
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Figure 62: Troubleshoot: Connectivity > Traceroute

IPv6

This tool helps to check the accessibility of remote hosts from cnPilot device. Three types of tools are
supported under this category:

l Ping6

l DNS Lookup6

l Traceroute6

Table 59: Troubleshoot: Connectivity

Parameters Description Range Default

Ping6

IP Address or
Hostname 

Provide IPv6 address or Hostname to validate the reachability
of the destined Host.

- -

Number of
Packets 

Provide number of request packets that are required to be
transmitted to validate the reachability of destined Host.

1-10 3

Buffer Size Configure ICMP packet size. 1-65507 56

Ping Result Displays the ICMP results. - -

DNS Lookup6

Host Name Provide Hostname whose IPv6 must be resolved. - -

DNS Test Result Displays the IP’s that are associated with configured Hostname. - -

Traceroute6
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Parameters Description Range Default

IP Address or
Hostname 

Provide IPv6 address or Hostname to validate the reachability
of the destined Host.

- -

Fragmentation Provision to allow or deny fragment packets. - Off

Trace Method  Provision to configure payload mechanism to check the
reachability of destined IPv6/Hostname.

- ICMP
Echo

Display TTL Provision to customize TTL display. - On

Verbose  Provision to display the output of traceroute. - On

Traceroute
Result

Displays the output of traceroute command. - -

To configure the above parameter, navigate to the Troubleshoot > Connectivity tab and provide the
details as given below:

To configure Ping6:

1. Select Test type from the drop-down list.

2. Enter IP address or Hostname in the textbox.

3. Enter the Number of packets in the textbox.

4. Select Buffer Size value from the drop-down list.

5. Start Ping6.

To configure DNS Lookup6:

1. Enter the Hostname in the textbox.

2. Click DNS Test.

To configure Traceroute6:

1. Enter IP address or Hostname in the textbox.

2. Click Fragmentation to ON/Off.

3. Select Trace Method to either ICMP Echo/UDP.

4. Click Display TTL to ON/Off.

5. Click Verbose to ON/Off.

6. Click Start Traceroute.
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Figure 63: Troubleshoot > Connectivity > Ping6

Figure 64: Troubleshoot > Connectivity > DNS Lookup6
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Figure 65: Troubleshoot: Connectivity > Traceroute6
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Chapter 13: Management Access
This chapter describes different methods of authenticating users to access device UI. Following are the
authentication methods supported by cnPilot devices:

l Local authentication

l SSH-Key authentication

l RADIUS authentication

Local authentication
This is the default authentication mode enabled on device. Only one username is supported which is
“admin”. Default password for “admin” username is “admin”. User has provision to configure/update
password. 

Device configuration
Configure/update default password of admin user shows how to configure/update default password of
admin user.

1. Under Management, enter Admin Password.

2. Click Save.

Figure 66: Configure/update default password of admin user

SSH-Key authentication
SSH keys are also used to connect remote machines securely. They are based on the SSH cryptographic
network protocol, which is responsible for the encryption of the information stream between two
machines. Ultimately, using SSH keys user can connect to remote devices without even entering a
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password and much more securely too. SSH works based on “public-key cryptography”. For simplicity,
let us consider that SSH keys come in pairs. There is a private key, that is safely stored to the home
machine of the user and a public key, which is stored to any remote machine (AP) the user wants to
connect. So, whenever a user initiates an SSH connection with a remote machine, SSH first checks if the
user has a private key that matches any of the public keys in the remote machine and if not, it prompts
the user for password.

Device configuration
SSH Key based access method can be configured on device using standalone AP or from cnMaestro.
Navigate to System > Management and configure the following:

1. Enable SSH checkbox.

2. Provide Public key generated from steps described in SSH Key Generation section.

Figure 67: System > Management

SSH Key Generation

Windows

PUTTY tool can be used to generate both Public and Private Key. Below is a sample demonstration of
configuring cnPilot device and logging using SSH Key via UI.

1. Generate a key pair in PUTTY Key Generator (Figure 68) and save private and public key as shown
in Figure 69.

Figure 68: Generating public/private Key
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2. Save the Public key and Private key once key pair is generated as shown in Public and Private Key.

Figure 69: Public and Private Key

3. Save the Public key generated in step above as described in Device configuration section.

4. Login to device using Private key generated above with username as “admin”.

Linux

If using a Linux PC and SSH from the Linux host, then you can generate the keys with the following steps:

1. Generate key pair executing below command on Linux console as shown in Figure 70.
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Figure 70: Public Key location path

2. The Public key is now located in PATH mentioned in Figure 70.

n PATH = “Enter the file to which to save the key”

3. The private key (identification) is now saved in PATH as mentioned in Figure 71.

n PATH = “Your identification has saved in <>”

Figure 71: Private Key saved path

4. Save the Public key generated in step above as described in Device configuration section.

5. Login to device using Private key generated above with username as “admin”.

RADIUS authentication
Device management access using RADIUS authentication allows multiple users to access using unique
credentials and is secured.

Device configuration
Management access using RADIUS authentication method can be configured on device using standalone
AP or from cnMaestro. Navigate to System > Management and configure the following:

1. Enable RADIUS Mgmt Auth checkbox.

2. Configure RADIUS IPv4/IPv6/Hostname and shared secret in RADIUS Server and RADIUS Secret
parameters respectively.

3. Click Save.
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Figure 72: System > Management: RADIUS Server and RADIUS Secret parameters

4. Figure 73: Login to device using appropriate credentials as shown in UI Login page.

Figure 74: UI Login page
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Chapter 14: Mesh
cnPilot Enterprise series Wi-Fi Aps support wireless mesh allowing the user to easily extend the range of
their network and to cover areas where a cable run might be hard to do. Mesh support was added in
software version 2.0.

cnPilot devices support mesh connections between radios. Mesh links can form between radios which are
operating in the same band. Given the larger set of available channels and typically cleaner RF
environment Cambium recommend using the 5GHz radio for mesh backhaul.

For a stable mesh link to be established, cnPilot mesh operates in three modes of operation:

1. Mesh Base (MB)

cnPilot device that operates in MB mode is the key to Mesh topology. MB is usually connected to
the wired network. The radio setup for MB will select a channel and start transmitting beacons as
soon as the AP comes up.

2. Mesh Client (MC)

cnPilot device that operates in MC mode, scans all available channels supported as per regulatory
domain and establishes a link with MB.

3. Mesh Recovery (MR)

This mode when enabled helps to maintain mesh link if there is a disruption in backhaul link
established with MB and MC. Mesh link disruption can cause due to PSK mismatch or due to
asynchronous configurations on MB and MC. This mode needs to be exclusively enabled on MB
device.

This mode can also help in Zero Touch Configuration of cnPilot device. 

Mesh configurable parameters
Table 60 lists the configurable parameters that are exclusive to mesh:

Table 60: Configure: WLAN > Mesh parameters

Parameters Description Range Default

Enable Option to enable a WLAN profile. Once enabled, a Beacon is
broadcasted with SSID and respective configured parameters in
a WLAN profile.

─ ─

Mesh This parameter is required when a WDS connection is
established with cnPilot devices. Four options are available
under this parameter:

1. Base

A WLAN profile configured with mesh-base will operate
like a normal AP. Its radio will beacon on startup so its
SSID can be seen by radios configured as mesh-clients. 

2. Client

─ Off
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Parameters Description Range Default

A WLAN profile configured with mesh-client will scan all
available channels on startup, looking for a mesh-based
AP to connect.

3. Recovery

A WLAN profile configured as mesh-recovery will
broadcast pre-configured SSID upon detection of mesh
link failure after a successful connection. This needs to be
exclusively configured on mesh-base device. Mesh-client
will auto scan for mesh-recovery SSID upon failure of
mesh link. 

4. Off

Mesh support disable on WLAN profile.

SSID SSID is the unique network name to which MC connects and
establishes mesh link.

─ ─

VLAN Management VLAN to access all devices in mesh topology. 1-4094 1

Security This parameter determines key values that is encrypted based on
selected algorithm. Following security methods are supported
by cnPilot devices:

1. Open

This method is preferred when Layer 2 authentication is
built in the network. With this configured on cnPilot
device, any mesh link can be established.

2. WPA2-Pre-Shared Keys

This mode is supported with AES encryption.

3. WPA2 Enterprise

This security type uses 802.1x authentication to associate
mesh devices. This is a centralized system of
authentication method.  

─ Open

Passphrase String that is a key value to generate keys based on security
method configured.

─ 12345678

Radios Each SSID can be configured to be transmitted as per the
deployment requirement. For a mesh WLAN profile, options
available to configure band:

n 2.4GHz

n 5GHz

─ 2.4GHz
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Parameters Description Range Default

Max Clients This specifies the maximum number of mesh clients that can be
associated to a mesh WLAN profile. This varies based on cnPilot
device model number. Refer Table 16 for more details.

1-512
(Refer
Table
16)

128

Client
Isolation

This feature needs to be enabled when there is a need for
prohibition of inter mesh devices communication either over the
network or on an AP. Three options are available to configure
based on requirement:

1. Disable

This option when selected disables client isolation feature.
i.e. Inter Mesh client communication is allowed.

2. Local

This options when selected enables client isolation
feature. This option prevents inter mesh client
communications connected to same device.

3. Network Wide

This option when selected enables network wide client
isolation feature. It prevents mesh client communications
connected to different AP deployed in same network.

─ Disabled

Hide SSID This is the basic security mode of a Wi-Fi device. This parameter
when enabled, will not broadcast SSID.

─ Disabled

Mesh Vlan
Tagging

Enable the VLAN tagging over mesh link. This is applicable only
for Cambium mesh topology.

─ Enabled

Mesh Auto
Detect
Backhaul

1. Single Hop

MC is configured on MB with same WLAN parameters.
When enabled, this feature triggers when a MB losses
Ethernet connectivity. MB profile will get disabled and MC
profile will get enable and establishes mesh link with
nearest MB. For MB profile to get auto disabled, uncheck
Mesh Multi Hop. 

2. Multi Hop

MC is configured on MB with same WLAN parameters.
When enabled, this feature triggers when a MB losses
Ethernet connectivity. MB profile and MC profile will get
enable and establishes mesh link with nearest MB.

─ Disabled

Drop
Multicast
Traffic

When enabled, will drop all multicast flowing in or out of that
WLAN.

─ Disabled

Insert DHCP
Option 82

Enabling this option appends Option 82 in the DHCP packets.
Following information is allowed to configure:

Disabled

../../../../../../../../../Desktop/backup/4.1/User Guide/Flare/pmp-2835_004v000.docx#_Ref4608849
../../../../../../../../../Desktop/backup/4.1/User Guide/Flare/pmp-2835_004v000.docx#_Ref4608849
../../../../../../../../../Desktop/backup/4.1/User Guide/Flare/pmp-2835_004v000.docx#_Ref4608849
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Parameters Description Range Default

1. DHCP Option 82 Circuit ID

Configurable parameters under this option are as follows:

l Hostname
l APMAC
l Site ID
l BSSID
l SSID
l Custom

2. DHCP Option 82 Remote ID

Configurable parameters under this option are as follows:

l Hostname
l APMAC
l Site ID
l BSSID
l SSID
l Custom

Tunnel Mode This option is enabled when user traffic is tunneled to central
network either using L2TP or L2GRE.

─ Disabled

Mesh
Monitored
Host

This parameter is exclusive to MC device. Configure IP or
Hostname to check the link status.

─ ─

Mesh
Monitor
Duration

Configure the interval at which the ping is sent for the configured
mesh monitored host.

5-60
Min

30

Mesh
Recovery
Interval

Configure the interval for the consecutive ping loss seen after
which the mesh link is considered to be down and a reconnect is
attempted. One can configure the duration and interval both to
be the same at which case the first ping loss itself will result in
triggering the reconnect.

5-30
Min

30

To configure the above parameters, navigate to the Configure > WLAN > Basic tab and provide the
details as given below:

1. Select the Enable checkbox to enable the operations of this WLAN.

2. Select the operating parameters Base/Client/Recovery from the Mesh drop-down list.

3. Enter a name that uniquely identifies a wireless network in the SSID textbox.

4. Enter the VLAN parameter value in the textbox.

5. Select Security type from the drop-down list.

6. Enter WPA2 Pre-shared security passphrase or key in the Passphrase textbox.
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7. Select the radio type (2.4GHz, 5GHz) on which the WLAN should be supported from the Radios
drop-down list.

8. Select Max Clients parameter value from the drop-down list.

9. Select the required Client Isolation parameter from the drop-down list.

10. Enable Hide SSID checkbox.

11. Enable Mesh Vlan Tagging checkbox.

12. Enable Mesh Auto Detect Backhaul checkbox.

13. Enable Drop Multicast Traffic checkbox.

14. Enable Insert DHCP Option 82 checkbox.

15. Select Tunnel Mode checkbox to enable tunnelling of WLAN traffic over configured tunnel.

16. Enter the IP or hostname name in the Mesh Monitored Host textbox.

17. Select the Mesh monitor duration time from the drop-down list.

18. Select the Mesh recovery interval time from the drop-down list.

19. Click Save.
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Figure 75: Base parameters

Figure 76: Client parameters
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Mesh link
This section briefs about configuration of device to get mesh link established with different deployment
scenarios.

Order of Mesh profile configuration
If a device is configured as mesh base/client/recovery, recommended order of WLAN configuration
should be as follows:

l WLAN profile 1: Mesh client
l WLAN profile 2: Mesh base

l WLAN profile 3: Mesh recovery

VLAN 1 as management interface
Follow the below steps to establish mesh link with VLAN 1 as management interface:

1. On MB, configure MB and MR. Follow the below steps to configure MB:

l WLAN profile

Figure 77: Mesh Base configuration with native VLAN 1

2. Management VLAN interface
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Figure 78: Mesh Base configuration with management VLAN 1

3. Ethernet interface

Figure 79: Mesh Base Ethernet configuration with Access VLAN 1

2. Configure MC as below:

WLAN profile
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Figure 80: Mesh Client configuration with VLAN 1

2. Management interface

Figure 81: Mesh Client configuration with Management VLAN 1

3. Ethernet interface
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Figure 82: Mesh Client Ethernet configuration with Access VLAN 1

3. Configure MR on MB device as follows on any WLAN profile:

a. WLAN profile

Figure 83: Mesh Recovery

Non-VLAN 1 as management interface
Follow the below steps to establish mesh link with Non-VLAN 1 as management interface:

1. On MB, configure MB and MR. Following are the steps to configure MB:

a. WLAN profile    
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Figure 84: Mesh Base configuration with non-VLAN 1

2. Management VLAN interface

Figure 85: Mesh Base configuration with Management non-VLAN 1

3. Ethernet interface
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Figure 86: Mesh Base Ethernet configuration with Access non-VLAN 1

2. Configure MC as below:

a. WLAN profile

Figure 87: Mesh Client configuration with non-VLAN 1

2. Management interface
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Figure 88: Mesh Client configuration with Management non-VLAN 1

3. Ethernet interface

Figure 89: Mesh Client Ethernet configuration with Access non-VLAN 1

3. Configure MR on MB device on any WLAN profile as follows:

a. WLAN profile
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Figure 90: Mesh Recovery
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Chapter 15: Autopilot
Autopilot is a feature on Cambium Enterprise Wi-Fi APs that allows one AP to be a controller of other
APs in a network to manage:

l Configuration and Onboarding

l Manage Autopilot

l Dashboard

l Insight

Configuration and Onboarding
This section provides required information to:

l Configure member AP to Autopilot master

l Configuring WLAN in default WLAN Group

l Configuring WLANs with user created WLAN Group

l WLAN group override

l Configuring WPA2-Enterprise WLAN

l Onboard member APs to Autopilot master

l Connect clients to the WLANs and check statistics

Configure member AP to Autopilot master
To configure member APs to a Master:

1. Open a web browser and browse the IP address of an AP in the network and access the AP’s UI
page.

Note

The AP needs to be upgraded with autopilot firmware.

2. Go to Configure > System > Management > Autopilot and select the AP as Master.
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Figure 91: Management _Autopilot

3. Click Save.

4. Refresh the web page and AP brings up the Autopilot UI.

The configured Master AP can perform the following:

l Act as a controller and manage other member APs

l Configure approved APs

l Upgrade firmware

l Display combined statistics and events

Cambium Enterprise AP can be configured the following ways:

l Configuring an AP with Internal DHCP server

l Configuring an AP with External DHCP Server

Configuring an AP with Internal DHCP server

Network Topology

The initial network for installments with external NAT device and VLAN segregation (having two VLANs
for the network) is shown in Autopilot.
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Figure 92: Configuring an AP with Internal DHCP server

Configure an AP with default WLAN group

To configure an AP with default WLAN group:

1. Connect all the APs to the native VLAN; for example, VLAN 1 as shown above.

2. Configure all the ports of the switch as trunk with the native VLAN 1 where,

1. Allowed VLAN: 10, 20

2. Native VLAN: 1

To configure the Master AP:

1. Go to CONFIGURE > System and configure Country Code and NTP Servers.

Figure 93: Configure > Systems
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Figure 94: Configure > Ethernet Ports

2. Go to CONFIGURE > MASTER AP CONFIG > Networks and configure the Static IP Address and the
DHCP Server for VLAN 1 (native VLAN).

3. Enable DHCP Server and provide range of IP addresses. For example, when starting address range
is give as 10.10.10.20 to 10.10.10.200, IP addresses can be assigned from 10.10.10.20 to 10.10.10.200
range.

Figure 95: Configure > Networks
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4. DHCP pool is used to provide IP addresses to all devices on VLAN 1. Add L3 interface of VLAN 10
and 20 under CONFIGURE > Networks.

a. Enable NAT in this L3 interface.
b. Enable DHCP server for this VLAN L3 interface.
c. Default gateway needs to be Static IP Address of the L3 interface.Networks > VLAN 10

5. Add L3 interface of VLAN 20 and enable DHCP server and NAT as shown in Networks_VLAN 20.
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Figure 96: Networks_VLAN 20

Configuring an AP with External DHCP Server

Network Topology

Initial network installments with external DHCP server and NAT box. The complete network is connected
to VLAN 1.
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Figure 97: Configuring an AP with External DHCP server

All the member APs are connected to ports of Switch. All the ports are mapped to VLAN 1.

To configure Master AP:

1. Configure country code, ntp server in master AP under System.

Figure 98: Configure > Systems

2. Configure static IP on Master.
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Figure 99: Configure > IP Settings

3. Refresh the page after saving with newly configured Ip address. In this example, open URL in
browser http://10.10.10.25.

Configuring WLAN in default WLAN Group
To configure WLAN in default WLAN group:

1. Add a Wireless LAN.

Figure 100: Configure > Wireless LANs

2. Enter SSID and password in respective fields.

3. Configure VLAN as 10 and click Save.

http://10.10.10.25/
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Figure 101: Wireless LANs > VLAN 10

4. Add another WLAN with VLAN 20. Enter SSID and password as required.

5. Configure VLAN as 20 and click Save.

Figure 102: Wireless LANs > VLAN 20

6. Check the configured WLANs.
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Figure 103: Wireless LANs > VLAN 10 and 20

7. Connect member APs to the Switch. The connected member APs receive IP from IP address from
Master AP on VLAN 1. Once the member APs connect to the Master AP and they are approved, the
configured WLANs are pushed to all the approved member APs and Master AP.

Figure 104: Dashboard

Configuring WLANs with user created WLAN Group
User can group one or multiple WLANs under a WLAN group and push the configuration to specific APs.
WLAN group is used to push specific WLANs to specific selected APs.

1. Create a WLAN group.



Chapter 15: Autopilot 176

Figure 105: Create a WLAN group

2. Configure a new WLAN Group.

Figure 106: Configure a new WLAN Group

3. Configure WLAN under the newly created WLAN Group.
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Figure 107: Configure WLAN under the newly created WLAN Group

WLAN group override
This section is to describe how user can select device and configure user configured WLAN-group. By
selecting device and overriding their WLAN-group, specific WLANs can be pushed to selected devices.

1. Select the device and click Edit button.

Figure 108: Access Point settings

2. Choose the WLAN-group you had configured from the drop-down list and click Save button. This
will push the WLANs configured under group1 to the selected AP.
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Figure 109: Access Point settings _WLAN Group

Configuring WPA2-Enterprise WLAN
Follow the below steps to create a WLAN with Enterprise security under user created WLAN Group.

Figure 110: Access Point settings > user created WLAN Group

1. Enter details in the WLAN page.

2. Select Security as WPA2-Enterprise from the drop-down list.

3. Keep VLAN as 1.

4. Do not press Save button before configuring Radius configurations for authentication.
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Figure 111: Wireless LANs > Security

5. Configure Radius Server details for Authentication and for Accounting if applicable.
Authentication server details has to be filled before saving the WLAN configuration.

Figure 112: Wireless LANs > Radius Server



Chapter 15: Autopilot 180

Onboard member APs to Autopilot master

To onboard other member APs to Autopilot Master:

1. Access the Autopilot Master AP via web browser.

2. Login with the below credentials:

n Username: admin

n Password: admin

Figure 113: Login page

3. Go to the DASHBOARD tab of the Master AP which displays the list of member APs those have
discovered the Master AP.

Note

The member AP needs to be upgraded with autopilot firmware.

4. Click APPROVE to approve and manage the desired member AP or click APPROVE ALL to
approve and manage all the listed APs.
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Figure 114: Dashboard > Overview

5. The approved member APs are listed under DASHBOARD > ACCESS POINTS tab.

Figure 115: Dashboard > Access points

Connect clients to the WLANs and check statistics
1. Go to DASHBOARD > WIRELESS CLIENTS.

2. Connect the listed clients to the configured WLANs and check statistics.
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Figure 116: Dashboard > Wireless clients

Manage Autopilot
The Manage tab of Autopilot UI manages firmware upgrades, configuration file updates, and technical
assistance of the master and member APs. Data is distributed in the following sub-sections:

l Firmware

l System

l Tools

Figure 117: Manage > Firmware

Firmware
This section supports uploading required firmware to master AP, and from master AP to the member
APs.

To configure firmware:

1. Go to Manage > Firmware tab.

2. Click the Browse button to browse the firmware file.
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Figure 118: Manage > Upload Firmware

3. Select the required firmware file and click Open. For example, firmware file: E400_E50X-3.4.2-
b27.img.

Figure 119: To open required Firmware

4. Click Upload Firmware button and wait for upload.

Figure 120: Upload firmware on Master AP

5. By clicking on Upgrade All Devices button, the firmware can be upgraded on all APs
simultaneously or can be upgraded on each AP separately by clicking on Install button provided
for every AP on the list.
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Figure 121: To upgrade firmware in all devices

Once step 5 is done, the following statuses during the Firmware upgrade can be seen in Firmware
upgraded sequence.

Figure 122: Firmware upgraded sequence

6. Different statuses of the firmware upgrade can be seen in Firmware upgraded status.
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Figure 123: Firmware upgraded status

Note

In case of any error/failure in upgrade status such as Firmware verification failed is shown in
status column:

1. APs can be rebooted individually by using Reboot option.

2. All the APs can be rebooted simultaneously using Reboot All Devices option.

3. The loaded firmware can be deleted from the master AP using Delete Firmware option.

System
This section provides the following options:
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l Reboot All: This option is used to reboot all the APs including the master AP simultaneously.

l Disable Autopilot: This button is used to disable Autopilot and the entire network of master AP.

Figure 124: System

l Import Configuration: This button is used to load any essential configuration and configure
Autopilot. Configuration files are stored in .json format.

l Export configuration: This button is used to export any new or essential configuration from
Autopilot setup and store in .json format for future use.

Figure 125: Import/Export Configuration

Access Point Management
This section provides the following options:

l LED: This button triggers the LED light on the AP (Hardware) for easy identification.

l Reboot: This button is used to individually reboot APs in Autopilot network.

l Default: This button is used to set the APs to their default configuration.

l Delete: This button is used to delete member APs from the Autopilot network.
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Figure 126: Access Point management

Tools
This section supports downloading technical support file for troubleshooting and viewing User Interfaces
of APs.

Figure 127: Troubleshoot

Dashboard
The Dashboard of Autopilot UI provides excellent monitoring capability of the complete setup.

Various graphs and statistics of events, performance, and system information of clients and application is
evidently made available to the user. It comprises of following components through which the data is
available for monitoring.
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Figure 128: Dashboard

Overview
The Dashboard tab comprises of data and various graphs as follows:

l Site information

l Discovered devices

l Events

l Clients

l Throughput

l Top Aps

l Top clients
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l Clients by Band/Radio type

l Channel distribution

l Clients by WLANs

l Clients by device type

Site information

This section provides the information of number of configured APs, online APs, and number of clients
provided.

Figure 129: Site information

Discovered devices

This table lists all the discovered devices with their names, IP addresses, and actions performed over
them. Every device discovered and displayed here should be APPROVED for it to be connected to APs
network and ready for configuration.

Figure 130: Discovered devices

Events

This section continuously streams all the events occurring on the network of AP both graphically and
digitally. Graphical spikes can be helpful in representing the network to know how the network is
behaving. Any configuration error is also displayed as an event with the reasons mentioned due to which
the application of respective configuration failed. For example, check the highlighted event in the below
figure.
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Figure 131: Events

Clients

This section graphically streams information about the number of clients connected to specific frequency
(2.4 Hz or 5 Hz) and total number of clients at a given time on the present day.

Figure 132: Clients

Throughput

This section graphically represents the TX, RX of each client and total Throughput of all clients against
each channel. User can hover over the graph and get more granular details.
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Figure 133: Throughput

Top Aps

This section graphically displays the top five APs connected to Autopilot’s network along with numbers
of clients and traffic in respective frequencies (2.4 Hz or 5 Hz).

Figure 134: Top APs

Top clients

This section graphically represents the top five clients connected to APs with highest traffic flow.
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Figure 135: Top clients

Clients by Band/Radio type

This section provides pie chart representation of the radio types of clients. This shows pie chart based on
the percentage of 2.4 GHz and 5 GHz clients connected to Autopilot network. Another pie chart is
plotted based on types of clients such as 802.11a, 802.11b/g/n, 802.11ac.

Figure 136: Clients by Band/Radio

Channel distribution

This section plots and displays the channel distribution between master and member APs as shown
below. This helps to know which channels are being used and how many APs are using the channels.
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Figure 137: Channel distribution

Clients by WLANs

This section provides a pie chart representation of all the Clients and WLANs. This helps to instantly know
the load on the WLANs.

Figure 138: Clients by WLANs

Clients by device type

This section provides a pie chart representation of device type (Respective Platforms) of the Clients. This
classifies the clients based on type such as Android, Windows clients, Linux, Ipad, Iphone clients, and so
on.

Figure 139: Clients by device type

Access Points
This tab contains details such as Performance, System details, Client details, and so on of all the APs
connected to Autopilot. Under Access Point tab, there are four tabs which are as follows:

Overview

This tab provides information such as Name, MAC address, IP Address, Model, number of Clients, Power,
Channels, and State of radio of all the APs’.
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Performance

This tab displays MAC, IP, Link speed, Total TX (Transmit from APS), and Total RX (Received to APS).
For example, if AP transmits data at the speed of 10mbps, then its TX is equal to 10mbps.

Figure 140: Access Points_Performance

System

This tab displays name, IP address, model, firmware, backup, CPU usage, memory, uptime, and synced
configurations of all APs. This helps to know the performance of the APs. Config synched option lets a
user to know whether the configuration of an AP is synched with the configuration done on Master. If
there is any config sync issue, a red x is displayed as shown in Access Points_System.

Figure 141: Access Points_System

RF stats

This tab displays the number of 2.4G Clients, 5G Clients, TX to 2.4G clients, TX to 5G clients, RX from 2.4G
clients, RX from 5G clients. Tx statistic signifies the downlink data speed to the client and Rx signifies
uplink data speed from the client.
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Figure 142: Access Points_RF Status

Wireless clients
This tab represents details of wireless clients such as vendor type, WLANs, VLANs, RF Stats, and so on.

Overview

The details in this tab include Name, MAC, IP, Vendor type of clients, Usernames (WPA2 enterprise and
guest access), Device type (Platform) of Clients, list of WLANs to which clients are connected, and VLAN
information of respective WLANs.

Figure 143: Dashboard > Wireless clients

RF Stats

This tab includes details such as frequency type, radio type, signal, Signal to Noise (SNR), physical rate,
TX and RX of clients along with names, MAC, and IP addresses of clients.

Note

Less the number in signal better is the signal. For example, -20 is better signal
than -70. Similarly, more the SNR better is the signal quality.
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Figure 144: Wireless clients > RF status

Wireless LANs
This tab provides details of all the configured WLANs as follows:

l GROUP: Name of the group under which the WLAN is created. WLAN group is used to club single
or multiple WLANs and then push the WLAN configurations to selected APs.

l SSID: SSID of the WLAN.

l SECURITY: Security of the WLAN which can be WPA2-PSK, WPA2-Enterprise, or Open.

l Tx: The actual data speed of downlink data. AP to clients.

l Rx: The actual data speed of uplink data. Clients to AP.

Figure 145: Dashboard > Wireless LANs

Insight
Insight option of Autopilot UI provides accurate insights on an AP anomalies which are distributed on the
sub tabs as follows:

l Pulse

l Timeview
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l Events

On the top left corner of the page the master and the member APs can be selected from the drop-down
list. Site default gives overall details.

Figure 146: Insight > Pulse

Pulse
This tab provides the detailed information of the following:

l High CPU usage: On clicking, this option leads to TIMEVIEW page of Insight tab and tracks the
CPU usage of all APs graphically.

l No WLANs mapped: This option leads to APs page of Dashboard tab and tracks number of APs
without wireless LANs configured.

l No Gigabit ethernet: This option leads to APs page of Dashboard tab and tracks APs which do not
auto negotiate Gigabit network speed.

l Client overload: This option leads to AP page of Dashboard and gives the number of clients
connected to every AP and also points the AP connected by highest number of clients.

l High memory usage: Tracks the memory usage of all APs and the highest memory usage and leads
to TIMEVIEW page of the Insight tab, when clicked upon.

l No clients: Tracks the APs which do not have any clients connected to them along with their
details like IP Address, Mac Address, and Model etc. On clicking leads to APs page on Dashboard.

l Less uptime: Lists all the APs which were activated within the last 30 minutes along with their
details and leads to Overview page on Dashboard.

l Mismatched firmware: Provides information related to mismatch of software with respect to
Master device.

Note

In current version not all of these options are supported.
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Timeview
This tab provides the graphical interpretation of CPU usage, Memory Usage, Clients, Overall Throughput,
and Throughput by frequencies and Events. Also, the maximum (Graphical Peaks) and minimum values of
all the mentioned components can be tracked accurately.

Figure 147: Insight > Timeview

Events
This tab provides the list of all the latest events of master and member APs. Events can be filtered for
specific APs based on their event name, content, Mac or IP address. All the old events can be cleared to
start afresh.
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Figure 148: Insight > Unfiltered Events

Figure 149: Insight > Filtered Events
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Chapter 16: Guest Access Portal-
INTERNAL
Introduction
Guest Access Portal services offers a simple way to provide secure access to internet for users and
devices using a standard web browser. Guest access portal allows enterprises to offer authenticated
access to the network by capturing and re-directing a web browsers session to a captive portal login
page where the user must enter valid credentials to be granted access to the network.

Modes of Captive Portal Services supported by cnPilot devices:

l Internal Access: Captive Portal server is hosted on access point and is local to access point.

l External Access: cnPilot is integrated with multiple third-party Captive Portal services vendor.
Based on the vendor, device needs to be configured.  More details on this Guest Access Portal
method is described in Chapter 17.

l cnMaestro: Captive Portal services are hosted on cnMaestro where various features like Social
login, Voucher login, SMS login and Paid login is supported. More details on this Guest Access
Portal method is described in Chapter 18.

Here in this chapter we will brief about Internal Captive Portal services supported by cnPilot Access
Points. Below figure displays the basic topology of testing Internal Captive Portal Service.

Figure 150: Topology
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Configurable Parameters
Chapter 16 displays multiple configurable parameters supported for Internal Guest Access hosted on AP.

Access Policy – Clickthrough
Figure 151: Internal Access Point parameter
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Access policy
l Click through

When this policy is selected, user will get a login page to accept “Terms and Conditions” to get
access to network. No additional authentication is required.

l RADIUS

When this policy is selected, user will be prompted for credentials, which is authenticated by
Radius server. Radius server details can be configured on device at Configure > WLAN > RADIUS.

l LDAP

When this policy is selected, user will be prompted for credentials, which is authenticated by
LDAP/AD server. LDAP server details can be configured on device at Configure > WLAN > Guest
Access > LDAP.

l Local Guest Account

When this policy is selected, username and password is configured on device and it can be used as
credentials for all wireless users connected to this WLAN profile to gain internet access.

Splash page

Title

You can configure the contents of splash page using this field. Contents should not exceed more than
255 characters.

Contents

You can configure the contents of splash page using this field. Contents should not exceed more than
255 characters.

Terms and conditions

Terms and conditions to be displayed on the splash page can be configured using this field. Terms and
conditions should not exceed more than 255 characters.

Logo

Displays the logo image updated in URL http(s)://<ipaddress>/<logo.png>. Either PNG or JPEG format
of logo are supported.

Background image

Displays the background image updated in URL http(s)://<ipaddress>/background>/<image.png>.
Either PNG or JPEG format of logo are supported.

Redirect Parameters

Redirect hostname

User can configure a friendly hostname, which is added in DNS server and is resolvable to cnPilot IP
address. This parameter once configured will be replaced with IP address in the redirection URL provided
to wireless stations.
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Success action

Provision to configure redirection URL after successful login to captive portal services. User can
configure three modes of redirection URL:

l Internal logout Page

After successful login, Wireless client is redirected to logout page hosted on AP.

l Redirect users to external URL

Here users will be redirected to URL which we configured on device as below:

l Redirect users to Original URL

Here users will be redirected to URL that is accessed by user before successful captive portal
authentication.

Figure 152: Success action

Redirect

By default, captive portal redirection is trigger when user access either HTTP or HTTPs WWW. If enabled,
redirection to Captive Portal Splash Page is triggered when a HTTP WWW is accessed by end user.

Figure 153: Redirect

Redirect Mode

There are two redirect modes available:

l HTTP Mode

When enabled, AP sends a HTTP POSTURL to the client.

l HTTP(s) Mode

When enabled, AP sends HTTPS POST URL to the client

Proxy redirection port

Proxy redirection port can be configured with which proxy server is enabled. This allows URL’s accessed
with proxy port to be redirected to login page.

Redirect user page

IP address configured in this field is used as logout URL for Guest Access sessions. IP address configured
should be not reachable to internet.
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Figure 154: Redirect user page

Logout re-direction URLs are as follows:

l http(s)://<Redirect user Page>/logout

Success Message
This we can configure so that we can display success message on the splash page after successful
authentication

Figure 155: Success Message

Timeout

Session

This is the duration of time which wireless client will be allowed internet after guest access
authentication.

Figure 156: Session timeout

Inactivity

This is the duration of time after which wireless client will be requested for re-login.

Figure 157: Inactivity timeout

MAC Authentication fallback
It is a fall back mechanism in which wireless clients will be redirected to Guest access login Page after
Radius based Mac authentication failure. This means When AP detects RADIUS authentication has failed
for a wireless client, AP will send a HTTTP Post redirection URL to the client for guest access
authentication
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Figure 158: MAC Authentication fallback

Extended interface
Provision to support Guest Access on Ethernet interface.

Figure 159: Extended interface

Whitelist
Provision to configure either Ips or URLs to bypass traffic, therefor user can access those Ips or URLs
without Guest Access authentication.

Captive portal bypass user agent
Provision to limit the auto-popup to a certain browser as configured based on User-agent of browsers.

Figure 160: Captive portal bypass user agent
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Configuration examples
This section briefs about configuring different methods of Internal Guest Access captive portal services
hosted on AP.

Access Policy – Clickthrough

Configuration
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Authentication – Redirected Splash Page

Successful Login – Redirected Splash Page
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Access Policy – Radius

Configuration



Chapter 16: Guest Access Portal- INTERNAL 209



Chapter 16: Guest Access Portal- INTERNAL 210

Authentication – Redirected Splash Page

Successful Login Redirected Splash Page
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Access Policy – LDAP

Configuration
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Authentication – Redirected Splash Page
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Successful Login – Redirected Splash Page
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Access Policy – Local Guest Account

Configuration
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Authentication – Redirected Splash Page

Successful Login – Redirected Splash Page
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Chapter 17: Guest Access Portal-
EXTERNAL
Introduction
Guest access WLAN is designed specifically for BYOD (Bring your own device) setup, where large
organizations have both staff and guests running on same WLAN or similar WLANs. Cambium Networks
provides different options to the customers to achieve this based on where the captive portal page is
hosted and who will be validating and performing authentication process.

External Hotspot is a smart Guest Access provision supported by cnPilot devices. This method of Guest
Access provides a flexibility of integrating an external 3rd party Web/Cloud hosted captive portal, fully
customized. More details on third party vendors who are integrated and certified with Cambium are listed
in the URL https://www.cambiumnetworks.com/wifi_partners/.

Configurable Parameters
Figure 161 displays multiple configurable parameters supported for External Guest Access hosted on AP.

https://nam05.safelinks.protection.outlook.com/?url=https%3A%2F%2Fwww.cambiumnetworks.com%2Fwifi_partners%2F&data=02%7C01%7Cjayesh.b%40cambiumnetworks.com%7C854a347f18ed4d9c823008d6f87db716%7C0e263e36340946228ac818d993e76eb6%7C0%7C0%7C636969616161490542&sdata=B2H5XzWLWQgdssVA8ruRLIyqfET1hqpFtlTWeh2Q9Hk%3D&reserved=0


Chapter 17: Guest Access Portal- EXTERNAL 217

Figure 161: Guest Access_External Access Point parameter
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Access policy
l Click through

When this policy is selected, user will get a login page to accept “Terms and Conditions” to get
access to network. No additional authentication is required.

l RADIUS

When this policy is selected, user will be prompted for credentials, which is authenticated by
Radius server. Radius server details can be configured on device at Configure > WLAN > RADIUS.

l LDAP

When this policy is selected, user will be prompted for credentials, which is authenticated by
LDAP/AD server. LDAP server details can be configured on device at Configure > WLAN > Guest
Access > LDAP.

l Local Guest Account

When this policy is selected, username and password is configured on device and it can be used as
credentials for all wireless users connected to this WLAN profile to gain internet access.

WISPr

WISPr Clients External Server Login

Provision to enable re-direction of guest access portal URL obtained through WISPr.

External Portal Post Through cnMaestro
This is required when HTTPS is only supported by external guest access portal. This option when enabled
minimizes certification. Certificate is required to install only in cnMaestro On-Premises.

External Portal Type
Two modes of portal types are supported by cnPilot products.

Standard

This mode is selected, for all third-party vendors whose Guest Access services is certified and integrated
with cnPilot products.  

XWF

This mode is selected for Facebook Express Wi-Fi deployment.

Redirect Parameters

Redirect hostname

User can configure a friendly hostname, which is added in DNS server and is resolvable to cnPilot IP
address. This parameter once configured will be replaced with IP address in the redirection URL provided
to wireless stations.

Note

This can be used to mask the IP address of the AP with some string.
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Success action

Provision to configure redirection URL after successful login to captive portal services. User can
configure three modes of redirection URL:

l Internal logout Page

After successful login, Wireless client is redirected to logout page hosted on AP.

l Redirect users to external URL

Here users will be redirected to URL which we configured on device as below:

l Redirect users to Original URL

Here users will be redirected to URL that is accessed by user before successful captive portal
authentication.

Figure 162: Success action

Redirect

By default, captive portal redirection is trigger when user access either HTTP or HTTPs WWW. If enabled,
redirection to Captive Portal Splash Page is triggered when a HTTP WWW is accessed by end user.

Figure 163: Redirect

Redirect Mode

There are two redirect modes available:

l HTTP Mode

When enabled, AP sends a HTTP POSTURL to the client.

l HTTP(s) Mode

When enabled, AP sends HTTPS POST URL to the client

Proxy redirection port

Proxy redirection port can be configured with which proxy server is enabled. This allows URL’s accessed
with proxy port to be redirected to login page.

Redirect user page

IP address configured in this field is used as logout URL for Guest Access sessions. IP address configured
should be not reachable to internet.
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Figure 164: Redirect user page

Logout re-direction URLs are as follows:

l http(s)://<Redirect user Page>/logout

Redirection URL Query String

Following information is appended in the redirection URL, if “Prefix Query Strings in Redirect URL” is
enabled.

l Client IP

l RSSI

l AP Location

Success Message
This we can configure so that we can display success message on the splash page after successful
authentication

Figure 165: Success Message

Timeout

Session

This is the duration of time which wireless client will be allowed internet after guest access
authentication.

Figure 166: Session timeout

Inactivity

This is the duration of time after which wireless client will be requested for re-login.
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Figure 167: Inactivity timeout

MAC Authentication fallback
It is a fall back mechanism in which wireless clients will be redirected to Guest access login Page after
Radius based Mac authentication failure. This means When AP detects RADIUS authentication has failed
for a wireless client, AP will send a HTTTP Post w.r.t redirection URL to the client for guest access
authentication

Figure 168: MAC Authentication fallback

Extended interface
Provision to support Guest Access on Ethernet interface.

Figure 169: Extended interface

Whitelist
Provision to configure either Ips or URLs to bypass traffic, therefor user can access those Ips or URLs
without Guest Access authentication.

Captive portal bypass user agent
Provision to limit the auto-popup to a certain browser as configured based on User-agent of browsers.



Chapter 17: Guest Access Portal- EXTERNAL 222

Figure 170: Captive portal bypass user agent

Configuration examples
This section briefs about configuring different methods of External Guest Access captive portal services
hosted on AP.
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Access Policy – Clickthrough

Configuration
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Authentication – Redirected Splash Page

Successful Login – Redirected Splash Page
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Chapter 18: Guest Access – cnMaestro
Cambium supports end-to-end Guest Access Portal services with combination of cnPilot and cnMaestro.
cnMaestro supports various types of authentication mechanism for wireless clients to obtain Internet
access. Following is an overview of types of Guest Access Portal services supported in cnMaestro:

a. Free

l Authentication Mechanisms

o Social Login

n Google

n Twitter

n Facebook

n Office365

o SMS Authentication

n SMS Country

n SMS Gupchup

n Twilio

n Victory Link SMS

n Fast SMS

b. Paid

l Paypal Payment Gateway

l Ippay Gateway

l Quickpay Gateway

l Orange Gateway

l mPesa Gateway

l Voucher

This section describes how to configure Guest Access using cnMaestro.
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Configurable Parameters
For Guest Access to be operational, both cnPilot and cnMaestro has to be configured for Guest Access
Portal services. Below are the configurable parameters:

cnPilot
Figure 171 displays multiple configurable parameters supported for cnMaestro Guest Access hosted on
AP.

Figure 171: Guest Access_cnMaestro parameter
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cnMaestro
Table 61 lists configurable parameters that are available under Services > Guest Access Portal tab:

Table 61: Guest Access_Basic parameters

Parameters Description Range Default

Services > Guest Access Portal > <GAP Profile> Basic

Name Provision to configure the name of the Guest Access Portal
services

─ ─

Description Provision to add brief details as per customer requirement - ─

Client Login
Event
Logging

Enabling this will provision cnMaestro to record all the client
events and their details. Client details available when this is
enabled are as follows:

l Client MAC

l Portal

l WLAN

l Access Point

l Voucher Code

l Login Time

l Access Type

l Email

l Mobile Number

─ Disabled
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Figure 172: Guest Access_Basic parameters

Table 62: Configure: Services > Guest Access > Access > Free parameters

Parameters Description Range Default

Services > Guest Access Portal > <GAP Profile> Access > Free

Enable Free
Access

Provision to enable free internet access.  ─ Disabled

Enable Logout
Functionality
for the guest
client

Provision to provide user Internet access for complete
session duration within renewal frequency. Internet access
timer is calculated based on real time user has used. User can
logout multiple times within renewal frequency.

─ Disabled

Bypass
Captive Portal
Detection

Provision to disable Captive Network Assistant (I).  ─ Disabled

Services > Guest Access Portal > <GAP Profile> Access > Free > Client Session

Session
Duration

The duration for which the client is provided internet access. 1-2628000 ─

Renewable
Frequency

Once the session duration for the client expires, the client
needs to wait for the period specified by renewal frequency
before logging in again to obtain internet access.

1-2628000 ─

Services > Guest Access Portal > <GAP Profile> Access > Free > Client Rate Limit

Downlink Provision to limit downlink speed from Access Point to
wireless client when client is authenticated to gain internet
access.

─ ─
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Parameters Description Range Default

Uplink Provision to limit uplink speed from wireless client to Access
Point when client is authenticated to gain internet access.

─ ─

Services > Guest Access Portal > <GAP Profile> Access > Free > Client Quota Limit

Quota Type Provision to limit the bandwidth of wireless client. Two
categories are supported based on Data quantity:

l Directional

l Downlink

l Uplink

l Total

─ None

Services > Guest Access Portal > <GAP Profile> Access > Free > Social Login

Guest Portal
Hostname / IP

Provision to configure the hostname that is share with
supported social login website APIs. More details on
supported social logins are provided in Social Login.

For each type of Social login required, respective
configuration parameters needs to be configured. These
parameters vary based on Social Login.

- Disabled

Services > Guest Access Portal > <GAP Profile> Access > Free > SMS Authentication

Enable Provision to enable SMS Authentication - Disabled

SMS Gateway
Provider

Provision to configure SMS gateway. More details on
supported SMS gateway are provided in SMS Authentication.

For each type of Gateway vendors, configuration parameters
vary and needs to be configured as per requirement.

- -

Services > Guest Access Portal > <GAP Profile> Access > Free > Add Whitelist

IP Address /
Domain Name

Provision to allow internet traffic, when user is not
authenticated.

- -
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Figure 173: Access _Free parameters



Chapter 18: Guest Access – cnMaestro 231

Table 63: Configure: Services > Guest Access > Access > Free > SMS

Parameter Description SMS Gateway Provider

Fast
SMS

SMS
Country

SMS
Gupshup

Twilio Victory
Link SMS

SMS
API

Generic
SMS API

Enable It indicates to
enable the SMS
Authentication
feature.

X X

Username Indicates the
username of the
vendor.

X X X

Sender
ID/Name

It is the name or
number which
flashes on the
recipients
mobile phone
when they
receive SMS.
This is optional
not mandatory.

X X

API Key It’s a token
which is
provided by
vendors.

X X X X X X

Account
Type

It shows type of
accounts such
as International,
OTP,
Promotional and
Transaction.

X X X X X X

OTP
Template

The template
with which SMS
has to be sent.

X

Password It indicates the
password.

X X X X

Country
Code

It enables to
select country
code based on
deployments.

X X X X

Auth Token It acts as a
password.

X X X X X

Account SID It acts as a
username.

X X X X X X
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Parameter Description SMS Gateway Provider

From It enables
to select
the
country
code.

X X X XXX

Language It indicates the
Language.

X X X X X X

Fast Delivery X X X X

Template
Name

X X X X X

SMS
Gateway
Provider
Name

X X X X X X

HTTP
Request
Type

X X X X X X

HTTP
Request
Header Key

X X X X X X

HTTP
Request
Header Key
Value

X X X X X X

API URL X X X X X X

API URL
Information

X X X X X X

Message
Parameter
Name

X X X X X X

Mobile
Number
Parameter
Name

X X X X X X

Table 64: Configure: Services > Guest Access > Access > Paid parameters

Parameters Description Range Default

Services > Guest Access Portal > <GAP Profile> Access > Paid
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Parameters Description Range Default

Enable Paid
Access

Provision to enable payment gateway services - Disabled

Services > Guest Access Portal > Access > Paid > Paypal Payment Gateway

Enable Provision to enable Paypal payment gateway services - Disabled

Configuration
Parameters

For successful Paypal transactions, following parameters needs
to be configured:

l Auto Return URL

l PDT Identity token

l IPN

- -

Services > Guest Access Portal > Access > Paid > Ippay Gateway

Enable Provision to enable Ippay payment gateway services - Disabled

Configuration
Parameters

For successful Ippay transactions, following parameters needs
to be configured:

l Callback URL

l Gateway URL

l Merchant ID

l Customer ID

l Terminal ID

l Password

- -

Services > Guest Access Portal > Access > Paid > QuickPay Gateway

Enable Provision to enable Quickpay gateway services - Disabled

Configuration
Parameters

For successful Ippay transactions, following parameters needs
to be configured:

l Callback URL

l Merchant ID

l Merchant Key

l Payment Window Agreement ID

l Payment Window API Key

- -

Services > Guest Access Portal > Access > Paid > Orange Money

Enable Provision to enable Orang Money gateway services - Disabled
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Parameters Description Range Default

Configuration
Parameters

For successful Orange Money transactions, following
parameters needs to be configured:

l Callback URL

l Merchant Key

l Consumer Key

l Language

l Currency

l Reference

l Return URL

l Payment URL

- -

Services > Guest Access Portal > Access > Paid > mPesa Money

Enable Provision to enable Orang Money gateway services - Disabled

Configuration
Parameters

For successful Orange Money transactions, following
parameters needs to be configured:

l Consumer Key

l Consumer Secret

l Short Code

l Validation URL

l Confirmation URL

- -

Services > Guest Access Portal > Access > Paid > Plan Details

Plan Name Configure Internet Plan with name - -

Plan Cost Cost of Internet plan. This field supports to configure various
currency types and user can select appropriate currency as per
location.

- USD

Session
Duration

Period in which user is provisioned with Internet access.
Following attributes are supported:

l Minutes

l Hours

l Days

- Minutes

Uplink Rate
Limit

Configurable wireless rate limit for the traffic flowing from user
to Access Point.

- -
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Parameters Description Range Default

Downlink Rate
Limit

Configurable wireless rate limit for the traffic flowing from
Access Point to User.

- -

Quota Type Configurable parameter to limit the amount of Internet data
transfer. User data can be limited using either of the following
options:

1. None

There is no limit on Quota. User can use internet for
whole duration configured.

2. Directional

n Uplink Quota

n Downlink Quota

3. Total

Provision to limit Quota which includes total of downlink
and uplink traffic.

- None

Device Limit Number of devices User can connect with current plan. For
unlimited client sessions, user has provision to enable unlimited
checkbox.

- 1
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Figure 174: Access_Paid parameters
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Table 65: Access_Vouchers parameters

Parameters Description Range Default

Services > Guest Access Portal > <GAP Profile> Access > Vouchers

Enable
Voucher
Access

Provision to support Voucher based Guest Access Services - Disabled

Plans Provision to add custom user plans. Following are the parameters
that are user configurable:

1. Plan Details

l Name: Configure user-friendly name to plan.
l Session Duration: Duration of time user can access

Internet. Duration can be specified in terms of Minutes,
Hours and Days.

l Voucher Expiry: Expiry details of voucher, which can be
configured for Minutes, Days and Hours. Once voucher
expires, user will not be granted internet.

l Rate Limit:
o Downlink Rate Limit: User can be restricted with

downlink speed. If not configured, unlimited speed
is provided to user.

o Uplink Rate Limit: User can be restricted with uplink
speed. If not configured, unlimited speed is provided
to user.

l Quota Type: Configurable parameter to limit the amount of
Internet data transfer. User data can be limited using either
of the following options:

o None: There is no limit on Quota. User can use
internet for whole duration configured.

o Directional

n Uplink Quota
n Downlink Quota

o Total: Provision to limit Quota which includes total
of downlink and uplink traffic.

l Voucher Device Limit: Number of devices allowed to
connect using same voucher code. User has provision to
configure unlimited. This will allow user to use same
voucher for unlimited clients.

l Bind Voucher to Device: Provision to bind single device to
voucher.

2. Voucher Design

l Title Color
l Message Color

- -
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Parameters Description Range Default

l Code Color
l Background Color
l Background Image
l Title
l Message
l Access Code Message

Card
Preview

User can preview the format of Voucher access token that has
been configured in Plans section, which shall be distributed to
customers.

- -

Export User can export Vouchers created for a plan and can provide to
customers on demand. Both PDF and CSV formats are supported.

- -

Add
Vouchers

User can add more Vouchers if required in the plan selected. - -

Delete User can delete vouchers based on requirement:

n Delete Selected:

This option provisions user to delete only selected
vouchers.

n Delete Expired:

This option provisions user to delete all expired vouchers.

- -
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Figure 175: Access _Vouchers parameters

Table 66: Configure: Services > Guest Access > Splash parameters

Parameters Description Range Default

Services > Guest Access Portal > Splash > Logo

Logo User has provision to select Logo and selected
background color that will be appeared in Splash page.

- -

Services > Guest Access Portal > Splash > Background

Background l Background Image

Provision to select background image.

l Opacity

Transparency of background image.

l Repeat Background

When enabled, background image will be
repeated

l Background Placement

Flexibility to place image at selective
locations in splash page.

- -

Services > Guest Access Portal > Splash > Text Design
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Parameters Description Range Default

Text Design Flexibility to change text design that is displayed in
splash page.

- -

Services > Guest Access Portal > Splash > Content

Page Title Text to appear as the title of the page. - -

Message Text to appear as the welcome text. You can choose the
font style and size for the welcome text.

- -

Login Title Text to appear for login. - Access Internet

Accept
Terms
Message

Text to appear as the accept terms message. - Please accept
Terms and
Conditions before
signing in!

Terms &
Conditions
Title

Text to appear as the title for the terms and the
conditions.

- -

Terms &
Conditions

Provision to add list of terms and conditions that needs
to be shared with end user before accepting.

- -

Login
Success
Message

Message to appear after successful login. - Congratulations,
your login is
successful

Login Failure
Message

Message to appear after login failure. - Login Failure

Server Error
Message

Text to appear if there is an error while contacting server. - Error Contacting
Server

Please Wait
Message

Message to appear when contacting server. - Please Wait

Terms Agree
Button

Prefix message that appends to Terms and Conditions
Agree option in splash page.

- I Agree with the

Terms Cancel
Button

Message that appears to Terms and Conditions Cancel
option in splash page.

- Cancel

Login Button Enter the text that should appear on the button to submit
in splash page.

- Login

Select Plans
Label

User defined text to guide user to select plans. - Select a Plan

Footer Enter the text to appear as the footer of the page. You
can choose the font style and size for the footer.

- -

On Success
Redirect to
URL

Provision to configure URL that appears on successful
Guest Access authentication.

- -
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Parameters Description Range Default

Services > Guest Access Portal > Splash > Advanced

Customer
CSS Design

Provision to upload custom Splash page in CSS format. - -

Download
Sample CSS

User can download sample CSS files supported. - -

Services > Guest Access Portal > Splash > Custom Fields

Name Provision to configure user friendly name to customers. -

Type Five options are provided, so that they can appear in
splash page.

n String

n Number

n Email

n Phone

n Date

- String

Mandatory If above selected types needs to be entered by customer,
enable this field else it is optional to users.

- Disabled

Services > Guest Access Portal > Splash > WiFi4EU

Enable Provision to enable WiFi4EU configuration. - Disabled

Network
UUID

The provided wifi4eu NetworkIdentifier should be of type
string and should correspond to the unique identifier
(UUID) of the WiFi4EU network installation as indicated
in the installation report.

- -

Captive
Portal URL

URL of the captive portal page where in the snippet will
be integrated. The EC will verify the compliance of this
page with the WiFi4EU requirements.

- -

Metrics
Snippet
Script URL

A WiFi4EU supplier can test if the snippet is correctly
installed and if its portal is compliant by enabling the
snippet self-test modus.

- -

Language Provision to set to the correct language code in which
the content of the portal page is served. The language
code should be one of the 24 predefined language codes
(1).

- -

Enable Self-
test Modus

Provision to enable self-validation of the portal. - -

Show Logo Provision to display WiFi4EU logo. - -
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Figure 176: Splash parameters

Table 67: Configure: Services > Guest Access > Sessions parameters

Parameters Description Range Default

Services > Guest Access Portal > <GAP Profile> Access > Sessions > Client Session

Client MAC Provides the MAC address of wireless client whose session is
valid.

- -

Access Point Provides BSSID of radio to which wireless client is associated. - -

Access Type Provides type of Guest Access Portal services enabled on
wireless client. Following are the types:

l Free

l Type of Social Login

l SMS

l Type of Payment Gateway

l Vouchers

WLAN Displays SSID of WLAN to which wireless client is associated. - -

Remaining
Time

The time left for the client to access the internet. It depends
upon the session duration configured in the Access Portal.

- -
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Parameters Description Range Default

Voucher Displays Voucher code that has been used by wireless client
for internet access.

- -

Disconnect Provision to disconnect wireless client on demand. - -

Services > Guest Access Portal > <GAP Profile> Access > Sessions > Client Login Events

Client MAC Provides the MAC address of wireless client whose session is
valid.

Portal Displays Guest Access Portal associated with wireless client.

WLAN Displays SSID of WLAN to which wireless client is associated.

Access Point Provides BSSID of radio to which wireless client is associated.

Voucher
Code

Displays Voucher code that has been used by wireless client
for internet access.

Login Time Displays time stamp of wireless client after a successful.

Access Type Provides type of Guest Access Portal services enabled on
wireless client. Following are the types:

l Free

l Type of Social Login

l SMS

l Type of Payment Gateway

l Vouchers

Email Displays email address as provided by user during guest
access portal authentication.

Mobile
Number

Displays mobile number as provided by user during guest
access portal authentication.

Services > Guest Access Portal > <GAP Profile> Access > Sessions > Client Paid Transactions

Client MAC Provides the MAC address of wireless client whose session is
valid.

Portal Displays Guest Access Portal associated with wireless client.

Plan Displays plan name activated for user.

Access Point Provides BSSID of radio to which wireless client is associated.

Voucher
Code

Displays Voucher code that has been used by wireless client
for internet access.

Start Time Displays timestamp when wireless client is successfully
authenticated using Guest Access portal services.
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Parameters Description Range Default

End Time Displays valid session time based on configuration in Plan. This
value is always equal to (Start Time + Duration).

Transaction
ID

Displays random value generated during payment process
and can be used as reference for any debugging.

Figure 177: Sessions parameters
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Configuration examples
Prerequisites:

n Create Guest Access Portal

l Login to cnMaestro > Navigate to Services > Guest Access Portal > Add Portal.

l Enter Portal Name, Description, enable Client Login Event Logging and click on Save.

Free

Configuration

1. Configure Guest Access portal enabled in pre-requisites for free internet access with pre-defined
self-registration parameters.
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2. Map the above profile to a WLAN profile and sync the configuration.
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Authentication – Redirected Splash Page
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Successful Login – Redirected Splash Page

Free – Custom fields

Configuration

1. Configure Guest Access portal enabled in pre-requisites for free with self-registration parameters.
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2. Map the above profile to a WLAN profile and sync the configuration.
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Authentication – Redirected Splash Page
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Successful Login – Redirected Splash Page
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Free – Social Login

Configuration

1. Configure Guest Access portal enabled in pre-requisites for free internet access with social login.
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2. Map the above profile to a WLAN profile and sync the configuration.
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Authentication – Redirected Splash Page

Successful Login – Redirected Splash Page
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Free – SMS Authentication

Configuration

1. Configure Guest Access portal enabled in pre-requisites for free internet access with SMA
authentication.
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2. Map the above profile to a WLAN profile and sync the configuration.

Authentication – Redirected Splash Page
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Successful Login – Redirected Splash Page

Paid – Payment Gateway

Configuration

1. Configure Guest Access portal enabled in pre-requisites for free internet access with paid payment
gateway.
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2. Map the above profile to a WLAN profile and sync the configuration.
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Authentication – Redirected Splash Page

PayPal payment page
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Vouchers

Configuration

1. Configure Guest Access portal enabled in pre-requisites for free internet access with Vouchers.

2. Map the above profile to a WLAN profile and sync the configuration.
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Authentication – Redirected Splash Page

Successful Login – Redirected Splash Page
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WiFi4EU

Configuration

1. Configure Guest Access portal enabled in pre-requisites for WIFI4EU compatibility.

2. Map the above profile to a WLAN profile and sync the configuration.
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Authentication – Redirected Splash Page

Successful Login – Redirected Splash Page
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Chapter 19: Policy Based VLAN
Assignment (PBA)
Introduction
The PBA is intended to support zero-touch detection and configuration for connected Cambium devices
(cnPilot AP's). New Cambium vendor specific LLDP TLVs are introduced starting with cnMatrix Release
2.1.0 to support “pushing” PBA policy data from Cambium devices (e.g., cnPilot) to cnMatrix. The new
PBA TLVs are implemented as an extension to the LLDP standard, using its flexible extension mechanism.
From a functional perspective, cnMatrix, acting as the upstream device, includes the PBA Authentication
TLV in the regularly generated LLDPDUs for a port. The downstream device (e.g., cnPilot) receives the
PBA Authentication TLV and, if policy action data (e.g., VLANs, native VLAN) is present to be pushed to
cnMatrix, a PBA device settings TLV is constructed and added to the LLDPDU for the port.

Table 68 lists the fields that are required for configuring PBA:

Table 68: Configuring PBA parameters

Parameters Description Range Default

lldp-pba New PBA TLVs will be shared with cnMatrix switch. - Enabled

lldp-pba-
auth-key

The shared private key used during PBA TLV authentication can
be updated or reset from its default value (by using the ‘no’
option).

- Enabled

Note

lldp-pba-auth-key is by default enabled; key value cannot be shared due to security
concerns.

Configuration:

Syntax:

Example:
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Note

PBA will not be functioning if more than 20 VLANs are configured on the AP.

To disable PBA:



Chapter 20: Device Recovery Methods 266

Chapter 20: Device Recovery Methods
Factory reset via ‘RESET’ button
Table 69: Factory reset via RESET button

cnPilot Access
Point

Procedure LED Indication

e400 Press and hold Reset button for 15
seconds

Both LEDs will be OFF and turned onto
Amber

e410 Press and hold Reset button for 25
seconds

LED will be OFF and turned onto Amber

e600 Press and hold Reset button for 20
seconds

LED will be OFF and turned onto Amber

e430 Press and hold Reset button for 25
seconds

LED will be OFF and turned onto Amber

e700 Press and hold Reset button for 25
seconds

Both LEDs will be OFF and turned onto
Amber

E500 Press and hold Reset button for 25
seconds

Both LEDs will be OFF and turned onto
Amber

E501S Press and hold Reset button for 25
seconds

Both LEDs will be OFF and turned onto
Amber

e502S Press and hold Reset button for 25
seconds

Both LEDs will be OFF and turned onto
Amber

e425H Press and hold Reset button for 20
seconds

LED will be OFF and turned onto Amber

e505 Press and hold Reset button for 20
seconds

LED will be OFF and turned onto Amber

e510 Press and hold Reset button for 20
seconds

Both LEDs will be OFF and turned onto
Amber
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Factory reset via power cycle
Table 70: Factory reset via power cycle

cnPilot Access
Point

Procedure

E400 Not Applicable

e410 Not Applicable

e600 Not Applicable

e430 Not Applicable

e700 Not Applicable

E500 Follow power ON and OFF for 5 times with interval of 7 Sec (ON) and 5 Sec
(OFF)

E501S Follow power ON and OFF for 5 times with interval of 7 Sec (ON) and 5 Sec
(OFF)

e502S Follow power ON and OFF for 5 times with interval of 7 Sec (ON) and 5 Sec
(OFF)

e425H Not Applicable

e505 Not Applicable

e510 Not Applicable

To disable factory reset when above power sequence occurs, run the following CLI command:

E500-Factory_Reset(config)# no service powercycle-factory-default

E500-Factory_Reset(config)# save

Boot partition change via power cycle
Table 71: Boot partition change via power cycle

cnPilot Access Point Procedure

E400 Follow power ON and off for 9 times with interval of 7 Sec (ON) and 5 Sec (OFF)

e410 Follow power ON and off for 9 times with interval of 15 Sec (ON) and 5 Sec
(OFF)

e600 Follow power ON and off for 9 times with interval of 7 Sec (ON) and 5 Sec (OFF)

e430 Follow power ON and off for 9 times with interval of 15 Sec (ON) and 5 Sec
(OFF)

e700 Follow power ON and off for 9 times with interval of 15 Sec (ON) and 5 Sec
(OFF)

E500 Follow power ON and off for 9 times with interval of 7 Sec (ON) and 5 Sec (OFF)
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cnPilot Access Point Procedure

E501S Follow power ON and off for 9 times with interval of 7 Sec (ON) and 5 Sec (OFF)

e502S Follow power ON and off for 9 times with interval of 7 Sec (ON) and 5 Sec (OFF)

e425H Follow power ON and off for 9 times with interval of 9 Sec (ON) and 5 Sec (OFF)

e505 Follow power ON and off for 9 times with interval of 9 Sec (ON) and 5 Sec (OFF)

e510 Follow power ON and off for 9 times with interval of 15 Sec (ON) and 5 Sec
(OFF)
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Glossary    
Term Definition

AP Access Point Module. One module that distributes network or Internet services to
subscriber modules.

API Application Program Interface

ARP Address Resolution Protocol. A protocol defined in RFC 826 to allow a network element
to correlate a host IP address to the Ethernet address of the host.

BHM Backhaul Timing Master (BHM)- a module that is used in a point to point link. This
module controls the air protocol and configurations for the link.

BHS Backhaul Timing Slave (BHS)- a module that is used in a point to point link. This module
accepts configuration and timing from the master module.

BT Bluetooth

DFS See Dynamic Frequency Selection

DHCP Dynamic Host Configuration Protocol defined in RFC 2131. Protocol that enables a
device to be assigned a new IP address and TCP/IP parameters, including a default
gateway, whenever the device reboots. Thus, DHCP reduces configuration time,
conserves IP addresses, and allows modules to be moved to a different network within
the system.

Ethernet
Protocol

Any of several IEEE standards that define the contents of frames that are transferred
from one network element to another through Ethernet connections.

FCC Federal Communications Commission of the U.S.A.

GPS Global Positioning System. A network of satellites that provides absolute time to
networks on earth, which use the time signal to synchronize transmission and reception
cycles (to avoid interference) and to provide reference for troubleshooting activities.

UI User interface.

HTTP Hypertext Transfer Protocol, used to make the Internet resources available on the
World Wide Web.

HTTPS Hypertext Transfer Protocol Secure

HT High Throughput

IP Address 32-bit binary number that identifies a network element by both network and host. See
also Subnet Mask.

IPv4 Traditional version of Internet Protocol, which defines 32-bit fields for data transmission.

LUID Logical Unit ID. The final octet of the 4-octet IP address of the module.

MAC
Address

Media Access Control address. The hardware address that the factory assigns to the
module for identification in the Data Link layer interface of the Open Systems
Interconnection system. This address serves as an electronic serial number.
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Term Definition

Maximum
Information
Rate (MIR)

The cap applied to the bandwidth of an SM or specified group of SMs. In the Cambium
implementation, this is controlled by the Sustained Uplink Data Rate, Uplink Burst
Allocation, Sustained Downlink Data Rate, and Downlink Burst Allocation parameters.

MIB Management Information Base. Space that allows a program (agent) in the network to
relay information to a network monitor about the status of defined variables (objects).

MIR See Maximum Information Rate.

PPPoE Point to Point Protocol over Ethernet. Supported on SMs for operators who use PPPoE
in other parts of their network operators who want to deploy PPPoE to realize per-
subscriber authentication, metrics, and usage control.

Proxy Server Network computer that isolates another from the Internet. The proxy server
communicates for the other computer, and sends replies to only the appropriate
computer, which has an IP address that is not unique or not registered.

SLA Service Level Agreement

VLAN Virtual local area network. An association of devices through software that contains
broadcast traffic, as routers would, but in the switch-level protocol.

VPN Virtual private network for communication over a public network. One typical use is to
connect remote employees, who are at home or in a different city, to their corporate
network over the Internet. Any of several VPN implementation schemes is possible. SMs
support L2TP over IPSec (Level 2 Tunneling Protocol over IP Security) VPNs and PPTP
(Point to Point Tunneling Protocol) VPNs, regardless of whether the Network Address
Translation (NAT) feature enabled.

VHT Very High Throughput
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